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Signal Generator Models and Features

The PSG Family comprises two series, the PSG-A and PSG-L. The PSG-A Series provides 

analog modulation in addition to continuous wave (CW) signals. The PSG-L Series provides 

CW signals only. Table 1-1 lists the PSG-A and PSG-L Series model numbers and their 

frequency ranges.

PSG-L Series Features

The PSG-L Series includes the following features:

• CW output from 250 kHz to 20 GHz (E8241A) or 40 GHz (E8244A)

• list and step sweep of frequency and amplitude, with multiple trigger sources

• external diode detector leveling

• user flatness correction

• automatic leveling control (ALC) on and off modes; power calibration in ALC-off mode is 

available, even without power search

• 10 MHz reference oscillator with external output

• GPIB, RS-232, and 10 base-T LAN input/output interfaces

• a millimeter head interface that is compatible with Agilent 83550 Series millimeter heads 

(for frequency extension up to 110 GHz)

Table 1-1 Signal Generator Model Numbers

PSG-A Series PSG-L Series Frequency Range

E8251A E8241A 250 kHz to 20 GHz

E8254A E8244A 250 kHz to 40 GHz
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PSG-A Series Features

The PSG-A Series provides all the functionality of the PSG-L and adds the following features:

• closed-loop AM

• dc-synthesized FM to 10 MHz rates; deviation depends on the carrier frequency

• phase modulation

• pulse modulation

• a dual function generator that includes the following features:

— 50Ω low frequency output, 0 to 3 Vp

— selectable waveforms: sine, square, positive ramp, negative ramp, triangle, gaussian 

noise, uniform noise, swept-sine, and dual-sine

— variable frequency modulation rates

— variable triggering in list and step sweep modes: auto, external, single, or remote

• a pulse generator that includes the following features:

— external pulse

— internal square wave

— selectable internal pulse modes: free-run, triggered (with delay), doublet, and gated; 

triggered (with delay), doublet, and gated require an external trigger source

— adjustable pulse width

— adjustable pulse period

— adjustable pulse delay

• external modulation inputs for AM, FM, and ΦM

• simultaneous modulation configurations
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Options

Table 1-2 and Table 1-3 show the available hardware and accessory options for both the 

PSG-A and PSG-L Series signal generators.

Table 1-2 Signal Generator Hardware Options

Option Description

1E1 add output step attenuator

1EA add high RF output power

1ED add Type-N RF output connector (20 GHz models only)

UNJ add improved close-in phase noise

W50 add 5-year warranty

Table 1-3 Signal Generator Accessory Options

Option Description

ABA PSG Documentation Set (English Language)

CD1 CD-ROM Documentation (PDFs of Options ABA & OBW)

0BW add assembly-level service manual

1CM add rack mount kit

1CN add front handle kit

1CP add rack mount kit with handles

UK6 commercial calibration certificate with test data
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Front Panel

Figure 1-1 shows the PSG-A signal generator front panel. This interface enables you to define, 

monitor, and manage input and output characteristics. Although Figure 1-1 shows the PSG-A 

Series front panel, descriptions are valid for both PSG Series.

The PSG-L Series front panel has fewer connectors and menu hardkeys. Connector 

descriptions that do not apply to the PSG-L Series front panel are specified as “PSG-A only”.

Figure 1-1 Front Panel Diagram (PSG-A Series shown)

11. EXT 1 INPUT 

12. EXT 2 INPUT 

10. Help 

8. Trigger Key 

13. LF OUTPUT 

15. ALC INPUT 

1. Display 

27. Hold 

2. Softkeys 

3. Knob 

4. Amplitude Key 

5. Frequency Key 

6. Save Key 

9. Menu Keys 

24. Incr Set Key 

7. Recall Key 

18. RF OUTPUT 
17. Numeric Keypad 

26. Arrow Keys 

28. Return Key 
29. Display Contrast Decrease Key 
30. Display Contrast Increase Key 
31. Local Key 

23. Standby LED 

32. Preset Key 

22. Power Switch 

14. Mod On/Off 

16. RF On/Off 

21. Line Power LED 

19. PULSE SYNC OUT 
20. PULSE VIDEO OUT 

25. PULSE/TRIGGER GATE INPUT 
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1. Display

The LCD screen provides information on the current function. Information can include status 

indicators, frequency and amplitude settings, and error messages. Labels for the softkeys are 

located on the right-hand side of the display. For further description of the front panel 

display, refer to “Front Panel Display” on page  11.

2. Softkeys

These softkeys activate the function indicated by the corresponding label on the display. 

Corresponding menu labels appear directly to the left of each key.

3. Knob

Rotating the knob increases or decreases a numeric value or changes a highlighted digit or 

character. You can also use the knob to step through lists or select items in a row.

4. Amplitude Key

Pressing this hardkey makes amplitude the active function. You can change the RF output 

amplitude or use the menus to configure amplitude attributes such as power search, user 

flatness, and leveling mode.

5. Frequency Key

Pressing this hardkey makes frequency the active function. You can change the RF output 

frequency or use the menus to configure frequency attributes such as frequency multiplier, 

offset, and reference.

6. Save Key

This hardkey accesses a menu of choices enabling you to save data in the instrument state 

register. The instrument state register is a section of memory divided into 10 sequences 

(numbered 0 through 9) each containing 100 registers (numbered 00 through 99). It is used to 

store and recall frequency, amplitude, and, for PSG-A Series signal generators, modulation 

settings. It provides a quick alternative to reconfiguring the signal generator via the front 

panel or SCPI commands when switching between different signal configurations. Once an 

instrument state has been saved, all of the frequency, amplitude, and modulation settings can 

be recalled with the Recall hardkey.
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7. Recall Key

This hardkey restores any instrument state that you previously saved in a memory register.

8. Trigger Key

This hardkey initiates an immediate trigger event, for a function such as a list or step sweep. 

The trigger mode must be set to Trigger Key prior to initiating a trigger event with this 

hardkey.

9. Menu Keys

These hardkeys access softkey menus enabling configuration of list and step sweeps, utility 

functions, the LF output, and various analog modulation types.

10. Help Key

Press this hardkey to view a short description of any hardkey or softkey. There are two help 

modes available on the signal generator, single and continuous; single mode is the factory 

preset condition.

• In single mode, when you press the Help key, help text is provided for the next key you 

press without activating the key’s function. Any key pressed afterward exits the help mode 

and its function is activated.

• In continuous mode, when you press the Help key, help text is provided for each 

subsequent key press until you press the Help key again or change to single mode. In 

addition, each key is active, meaning that the key function is executed (except for the 

Preset key).

Toggle between single and continuous mode by pressing Utility > Instrument Info/Help Mode > 
Help Mode Single Cont.

11. EXT 1 INPUT (PSG-A only)

This BNC input connector accepts a ±1 Vp signal for AM, FM, and ΦM. For all these 

modulations, ±1 Vp produces the indicated deviation or depth. When ac-coupled inputs are 

selected for AM, FM, or ΦM and the peak input voltage differs from 1 Vp by more than 3%, the 

HI/LO annunciators light on the display. The input impedance is selectable as either 50Ω or 

600Ω and the damage levels are 5 Vrms and 10 Vp.
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12. EXT 2 INPUT (PSG-A only)

This BNC input connector accepts a ±1 Vp signal for AM, FM, ΦM, and pulse modulation. 

With AM, FM, or ΦM, ±1 Vp produces the indicated deviation or depth. With pulse 

modulation, +1 V is on and 0 V is off. 

When ac-coupled inputs are selected for AM, FM, or ΦM and the peak input voltage differs 

from 1 Vp by more than 3%, the HI/LO annunciators light on the display. The input 

impedance is selectable as either 50Ω or 600Ω and damage levels are 5 Vrms and 10 Vp.

13. LF OUTPUT (PSG-A only)

This BNC connector is the output for modulation signals generated by the low frequency (LF) 

source function generator. This output is capable of driving 3 Vp (nominal) into a 50Ω load.

14. Mod On/Off Key (PSG-A only)

This hardkey toggles the operating state of all modulation signals. Although you can set up 

and enable various modulation states, the RF carrier is not modulated until Mod On/Off is set 

to On. An annunciator is always present in the display to indicate whether modulation is 

turned on or off.

15. ALC INPUT

This connector is used for negative external detector leveling. This connector accepts an input 

of −0.2 mV to −0.5 V. The nominal input impedance is 120 kΩ and the damage level is ±15 V.

16. RF On/Off Key

This hardkey toggles the operating state of the RF signal present at the RF OUTPUT 

connector. An annunciator is always visible in the display to indicate whether the RF is 

turned on or off.

17. Numeric Keypad

The numeric keypad consists of the 0 through 9 hardkeys, a decimal point hardkey, and a 

backspace hardkey ( ). The backspace hardkey enables you to backspace or specify a 

negative value. When specifying a negative numeric value, the negative sign must be entered 

prior to entering the numeric value.
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18. RF OUTPUT

This connector is the output for RF signals. The nominal output impedance is 50Ω. The 

damage levels are 0 Vdc, 0.5 watts nominal.

19. PULSE SYNC OUT (PSG-A only)

This connector outputs a sychronizing TTL-compatible signal that is nominally 50 ns wide 

during internal and triggered pulse modulation. The nominal source impedance is 50Ω. 

20. PULSE VIDEO OUT (PSG-A only)

This connector outputs a TTL-level compatible signal that follows the RF output envelope in 

all pulse modes. The nominal source impedance is 50Ω.

21. Line Power LED

This green LED indicates when the signal generator power switch is set to the on position.

22. Power Switch

This switch activates full power to the signal generator when set to the on position, and 

deactivates all signal generator functions when in standby mode. In standby mode, the signal 

generator remains connected to the line power and power is supplied to some internal circuits.

23. Standby LED

This yellow LED indicates when the signal generator power switch is set to the standby 

condition.

24. Incr Set Key

This hardkey enables you to set the increment value of the current active function. When this 

hardkey is pressed, the increment value of the current active function will appear in the 

active entry area of the display. Use the numeric keypad, arrow hardkeys, or the knob to 

adjust the increment value.
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25. PULSE/TRIGGER GATE INPUT (PSG-A only)

This connector accepts an externally supplied TTL-compatible signal for use as a pulse or 

trigger input. The damage levels are ±5 Vrms and 10 Vp. The nominal input impedance is 50Ω.

26. Arrow Keys

The up and down arrow hardkeys are used to increase or decrease a numeric value, step 

through displayed lists, or to select items in a row of a displayed list. Individual digits or 

characters may be highlighted using the left and right arrow hardkeys. Once an individual 

digit or character is highlighted, its value can be changed using the up and down arrow 

hardkeys.

27. Hold Key

This hardkey blanks the softkey label area and text areas on the display. Softkeys, arrow 

hardkeys, the knob, the numeric keypad, and the Incr Set hardkey have no effect once this 

hardkey is pressed.

28. Return Key

This hardkey will return you one level back from your current softkey menu level to the 

previous softkey menu level. It enables you to step back through the menus until you reach 

the first menu you selected.

29. Display Contrast Decrease Key

This hardkey, when pressed or held, causes the display background to darken.

30. Display Contrast Increase Key

This hardkey, when pressed or held, causes the display background to lighten.

31. Local Key

This hardkey is used to deactivate remote operation and return the signal generator to front 

panel control.

32. Preset Key

This hardkey is used to set the signal generator to a known state (factory or user-defined).
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Front Panel Display

Figure 1-2 shows the front panel display. The LCD screen will display data fields, 

annotations, key press results, softkey labels, error messages, and annunciators that 

represent various active functions of the signal generator. Descriptions are provided for each 

feature of this interface.

Figure 1-2 Front Panel Display Diagram

3. Annunciators 4. Amplitude Area 1. Active Entry Area 

5. Error Message Area 7. Softkey Label Area 6. Text Area 

2. Frequency Area 
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1. Active Entry Area

The current active function is shown in this area. For example, if frequency is the active 

function, the current frequency setting will be displayed here. If the current active function 

has an increment value associated with it, that value is also displayed. 

2. Frequency Area

The current frequency setting is shown in this portion of the display. Indicators are also 

displayed in this area when the frequency offset or multiplier is used, the frequency reference 

mode is turned on, a source module is enabled, or an external frequency is used.

3. Annunciators

The display annunciators show the status of some of the signal generator functions, and 

indicate any error conditions. An annunciator position may be used by more than one 

function. This does not create a problem, because only one function that shares an 

annunciator position can be active at a time.

ΦM  This annunciator appears when phase modulation is turned on. If frequency 

modulation is turned on, the FM annunciator will replace ΦM.

ALC OFF  This annunciator appears when the ALC circuit is disabled. A second 

annunciator, UNLEVEL, will appear in the same position if the ALC is 

enabled and is unable to maintain the output level.

AM  This annunciator appears when amplitude modulation is turned on.

ARMED  This annunciator appears when a sweep has been initiated and the signal 

generator is waiting for the sweep trigger event.

ATTEN HOLD  This annunciator appears when the attenuator hold function is turned on. 

When this function is on, the attenuator is held at its current setting. 

ERR  This annunciator appears when an error message is placed in the error 

queue. This annunciator will not turn off until you have either viewed all of 

the error messages or cleared the error queue. You can access error 

messages by pressing Utility > Error Info.

EXT  This annunciator appears when external leveling is turned on.

EXT1 LO/HI  This annunciator is displayed as either EXT1 LO or EXT1 HI. This 

annunciator appears whenever the ac-coupled signal to the EXT 1 INPUT is 

less than 0.97 Vp or greater than 1.03 Vp.
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EXT2 LO/HI  This annunciator is displayed as either EXT2 LO or EXT2 HI. This 

annunciator appears whenever the ac-coupled signal to the EXT 2 INPUT is 

less than 0.97 Vp or greater than 1.03 Vp.

EXT REF  This annunciator appears when an external frequency reference is applied.

FM  This annunciator appears when frequency modulation is turned on. If phase 

modulation is turned on, the ΦM annunciator will replace FM.

L  This annunciator appears when the signal generator is in listener mode and 

is receiving information or commands over the GPIB interface.

MOD ON/OFF  This annunciator indicates if the RF carrier is modulated (MOD ON), or if the 

modulation is off (MOD OFF). Either condition of this annunciator is always 

visible in the display.

OVEN COLD  This annunciator appears when the temperature of the internal oven 

reference oscillator has dropped below an acceptable level. When this 

annunciator is on, frequency accuracy is degraded. This condition should 

occur only if the signal generator is disconnected from line power. The 

annunciator is timed, and automatically turns off after a specified period.

PULSE  This annunciator appears when pulse modulation is turned on.

R  This annunciator appears when the signal generator is in remote GPIB 

operation.

RF ON/OFF  This annunciator indicates when the RF signal is present (RF ON) at the RF 

OUTPUT, or if the RF signal is not present (RF OFF) at the RF OUTPUT. 

Either condition of this annunciator is always visible in the display.

S  This annunciator appears when the signal generator has generated a 

service request (SRQ) over the GPIB interface.

SWEEP  This annunciator appears when the signal generator is sweeping in list or 

step mode.

T  This annunciator appears when the signal generator is in talker mode and 

is transmitting information over the GPIB interface.

UNLEVEL  This annunciator appears when the signal generator is unable to maintain 

the correct output level. The UNLEVEL annunciator is not necessarily an 

indication of instrument failure. Unleveled conditions can occur during 

normal operation. A second annunciator, ALC OFF, will appear in the same 

position when the ALC circuit is disabled.

UNLOCK  This annunciator appears when any of the phase locked loops are unable to 

maintain phase lock. You can determine which loop is unlocked by 

examining the error messages.
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4. Amplitude Area

The current output power level setting is shown in this portion of the display. Indicators are 

also displayed in this area when amplitude offset is used, amplitude reference mode is turned 

on, external leveling mode is enabled, a source module is enabled, and when user flatness is 

enabled.

5. Error Message Area

Abbreviated error messages are reported in this space. When multiple error messages occur, 

only the most recent message remains displayed. Reported error messages with details can be 

viewed by pressing Utility > Error Info.

6. Text Area

This area of the display is used to show status information about the signal generator such as 

the modulation status, sweep lists, and file catalogs. This area also enables you to perform 

functions such as managing information, entering information, and displaying or deleting 

files.

7. Softkey Label Area

The labels in this area define the function of the softkeys located immediately to the right of 

the label. The softkey label will change depending upon the function selected.
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Rear Panel

Figure 1-3 shows the signal generator rear panel. The signal generator rear panel provides 

input, output, and remote interface connections. Descriptions are provided for each 

characteristic of the rear panel.

Figure 1-3 Rear Panel Diagram

1. AC Power Receptacle

The line voltage is connected here. The power cord receptacle accepts a three-pronged power 

cable that is shipped with the signal generator.

2. GPIB

The GPIB interface allows listen and talk capability with compatible IEEE 488.2 devices.

3. AUXILIARY INTERFACE 

2. GPIB 

7. SWEEP OUT 

9. TRIGGER OUT 

4. 10 MHz IN 

6. 10 MHz OUT 

10. TRIGGER IN 

8. SOURCE MODULE 

11. SOURCE SETTLED OUTPUT 

5. LAN 

1. AC Power Receptacle 
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3. AUXILIARY INTERFACE

This male DB-9 connector is an RS-232 serial port that can be used for controlling the signal 

generator remotely.

4. 10 MHz IN

This BNC connector accepts an external timebase reference input signal level of 

greater than −3 dBm. The reference must be 1, 2, 2.5, 5, or 10 MHz, within ±1 ppm. The signal 

generator detects when a valid reference signal is present at this connector and automatically 

switches from internal to external reference operation. The nominal input impedance is 50Ω.

For Option UNJ, this BNC connector accepts a signal with a nominal input level of 5 ±5 dBm. 

The external frequency reference must be 10 MHz, within ±1 ppm. The nominal input 

impedance is 50Ω with a damage level of ≥ 10 dBm.

5. LAN

The LAN interface allows ethernet local area network communication through a 10 base-T 

LAN cable. The yellow LED on the interface illuminates when data transmission 

(transfer/receive) is present. The green LED illuminates when there is a delay in data 

transmission or no data transmission is present.

6. 10 MHz OUT

This BNC connector outputs a nominal signal level of > +4 dBm and has an output impedance 

of 50Ω. The accuracy is determined by the timebase used, whether internal or external.

7. SWEEP OUT

This BNC connector provides a voltage range of 0 to +10 V. When the signal generator is in 

list or step sweep mode, the SWEEP OUT signal ranges from 0 V at the beginning of the 

sweep to +10 V at the end of the sweep regardless of the sweep width. In CW mode this 

connector has no output. The output impedance is less than 1Ω and can drive a 2 kΩ load.

8. SOURCE MODULE

Use this interface for connecting to compatible Agilent 83550 Series mm-wave source 

modules.
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9. TRIGGER OUT

This BNC connector outputs a TTL signal that is high at the start of a dwell sequence or when 

waiting for a point trigger in manual sweep mode. The signal is low when the dwell is over, or 

when a point trigger is received. The low-frequency (LF) sweep trigger output can be a high or 

low 4 µs pulse.

10. TRIGGER IN

This BNC connector accepts a TTL signal used for point-to-point triggering in manual sweep 

mode or a low-frequency (LF) sweep in external sweep mode. Triggering can occur on either 

the positive or negative edge of the TTL signal start. The damage level is ≤ −4 V or ≥ +10 V.

11. SOURCE SETTLED OUTPUT

This BNC connector provides an open-collector output indicating when the signal generator 

has settled to a new frequency or power level. A high pulse indicates that the source has 

settled.
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Configuring the RF Output

This section will show you how to create continuous wave and swept RF outputs.

Configuring a Continuous Wave RF Output

Using these procedures, you will learn how to set the following parameters:

• RF output frequency

• frequency reference and frequency offset

• RF output amplitude

• amplitude reference and amplitude offset

Setting the RF Output Frequency

1. Press Preset.

This returns the signal generator to the factory-defined instrument state.

NOTE You can change the preset conditions to a user-defined instrument state. 

However, for the purpose of these examples, use the factory-defined preset state 

(the Preset Normal User softkey in the Utility menu must be set to Normal).

2. Observe the FREQUENCY area of the display (in the upper left-hand corner).

The value displayed is the maximum specified frequency of your signal generator.

3. Press RF On/Off.

The RF On/Off hardkey must be pressed before the RF signal is available at the 

RF OUTPUT connector. The display annunciator changes from RF OFF to RF ON. The 

maximum specified frequency is now being output at the RF OUTPUT connector (at the 

signal generator’s minimum power level).

4. Press Frequency > 700 > MHz.

The new 700 MHz RF frequency is now displayed in the FREQUENCY area of the display and 

also in the active entry area.
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5. Press Frequency > Incr Set > 1 > MHz.

This changes the frequency increment value to 1 MHz.

6. Press the up arrow key.

Each press of the up arrow key increases the frequency by the increment value last set 

with the Incr Set hardkey. The increment value is displayed in the active entry area.

7. The down arrow works like the up arrow. Practice stepping the frequency up and down in 1 

MHz increments.

You can also adjust the RF output frequency using the knob. As long as frequency is the 

active function (the frequency is displayed in the active entry area), the knob will increase 

and decrease the RF output frequency.

8. Use the knob to adjust the frequency back to 700 MHz.

Setting the Frequency Reference and Frequency Offset

The following procedure sets the RF output frequency as a reference frequency to which all 

other frequency parameters are relative. The frequency initially shown on the display will be 

0.00 Hz (the frequency output by the hardware minus the reference frequency). Although the 

display changes, the frequency output does not change. Any subsequent frequency changes 

are shown as incremental or decremental to 0 Hz.

1. Press Preset.

2. Press Frequency > 700 > MHz.

3. Press Freq Ref Set.

This activates the frequency reference mode and sets the current output frequency 

(700 MHz) as the reference value. The frequency displayed is 0.00 Hz (the frequency 

output by the hardware, 700 MHz, minus the reference value, 700 MHz). The REF indicator 

is activated and the Freq Ref Off On softkey has toggled to On.

4. Press RF On/Off.

The display annunciator has changed from RF OFF to RF ON. The RF frequency at the 

RF OUTPUT connector is 700 MHz.

5. Press Frequency > Incr Set > 1 > MHz.

This changes the frequency increment value to 1 MHz.
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6. Press the up arrow key.

This increments the output frequency by 1 MHz. The frequency display changes to show 

1 MHz (the frequency output by the hardware, 700 MHz + 1 MHz, minus the reference 

frequency, 700 MHz) and the output frequency changes to 701 MHz.

7. Press Freq Offset > 1 > MHz.

This enters a 1 MHz offset. The frequency display shows 2.000 000 00 MHz (the 

frequency output by the hardware, 701 MHz, minus the reference frequency, 700 MHz, 

plus the offset, 1 MHz). The OFFS indicator is activated. The frequency at the RF OUTPUT 

connector is still 701 MHz.

Setting the RF Output Amplitude

1. Press Preset.

2. Observe the AMPLITUDE area of the display (in the upper middle of the display). The 

display reads the signal generator’s minimum power level. This is the normal preset RF 

output amplitude.

3. Press RF On/Off.

The display annunciator changes from RF OFF to RF ON. The RF signal is now being output 

at the minimum power level at the RF OUTPUT connector.

4. Press Amplitude > −20 > dBm.

This changes the amplitude to −20 dBm. The new −20 dBm RF output power is now 

displayed in the AMPLITUDE area of the display and also in the active entry area.

Amplitude is still the active function until you press another front panel function key. You 

can also change the amplitude using the up and down arrow keys and the knob.

5. Practice changing the amplitude using the arrow keys and the knob.
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Setting the Amplitude Reference and Amplitude Offset

The following procedure sets the RF output power as an amplitude reference to which all 

other amplitude parameters are relative. The amplitude initially shown on the display will be 

0 dB (the power output by the hardware minus the reference power). Although the display 

changes, the output power does not change. Any subsequent power changes are shown as 

incremental or decremental to 0 dB. 

1. Press Preset.

2. Press Amplitude > −20 > dBm.

3. Press More (1 of 2) > Ampl Ref Set.

This activates the amplitude reference mode and sets the current output power (−20 dBm) 

as the reference value. The AMPLITUDE area displays 0.00 dB (the power output by the 

hardware, −20 dBm, minus the reference value, −20 dBm). The REF indicator is activated 

and the Ampl Ref Off On softkey has toggled to On.

4. Press RF On/Off.

The display annunciator has changed from RF OFF to RF ON. The power at the 

RF OUTPUT connector is −20 dBm. 

5. Press Incr Set > 10 > dB.

This changes the amplitude increment value to 10 dB.

6. Use the up arrow key to increase the output power by 10 dB.

The AMPLITUDE area displays 10.00 dB (the power output by the hardware, 

−20 dBm plus 10 dBm, minus the reference power, −20 dBm) and the output power 

changes to −10 dBm.

7. Press Ampl Offset > 10 > dB.

This enters a 10 dB offset. The AMPLITUDE area displays 20.00 dB (the power output by 

the hardware, −10 dBm; minus the reference power, −20 dBm; plus the offset, 10 dB). The 

OFFS indicator is activated. The power at the RF OUTPUT connector is still −10 dBm.
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Configuring a Swept RF Output

The signal generator has two sweep types, step and list. 

NOTE List sweep data cannot be saved within an instrument state, but can be saved 

to the memory catalog. For instructions on saving list sweep data, see “Storing 

Files” on page 45. 

During swept RF output, the FREQUENCY and AMPLITUDE areas of the signal 

generator’s display are deactivated, depending on what is being swept.

Following an explanation of the differences between step sweep and list sweep, you will learn 

two ways to configure the signal generator’s RF output to sweep a defined set of frequency, 

amplitude, and dwell time points. You will create a step sweep and then you will use these 

points as the basis for a new list sweep.

Step Sweep

Step sweep allows you to enter RF output start and stop frequencies and amplitudes, a 

number of equally spaced points (steps) to dwell upon, and the amount of dwell time at each 

point. 

When a step sweep is activated, the signal generator will sweep the RF output based on the 

values entered for the parameters listed above. The frequency, amplitude, or frequency and 

amplitude of the RF output will sweep from the start amplitude/frequency to the stop 

amplitude/frequency, dwelling at equally spaced intervals defined by the # Points softkey 

value for the configured step dwell time.

Step sweep provides a linear progression through the start-to-stop frequency and/or 

amplitude values. You can toggle the direction of the sweep up or down. When the Sweep 
Direction Down Up softkey is set to Up, values are swept from the start frequency/amplitude to 

the stop frequency/amplitude. Set to Down, values are swept from the stop 

frequency/amplitude to the start frequency/amplitude.
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List Sweep

List sweep allows you to create a list of arbitrary frequency, amplitude, and dwell time values 

and sweep the RF output based on the entries in the List Mode Values table. 

Unlike a step sweep that contains linear ascending/descending frequency and amplitude 

values spaced at equal intervals throughout the sweep, list sweep frequencies and amplitudes 

can be entered at unequal intervals and nonlinear ascending/descending or random order. 

For convenience, the List Mode Values table can be copied from a previously configured step 

sweep. Each step sweep point’s associated frequency, amplitude and dwell time values are 

entered into a row in the List Mode Values table, as the following example illustrates.

Configuring and Activating a Single Step Sweep

In this procedure, you will create a step sweep with nine, equally spaced points and the 

following parameters:

• frequency range from 500 MHz to 600 MHz

• amplitude from −20 dBm to 0 dBm

• dwell time 500 ms at each point

1. Press Preset.

2. Press Sweep/List.

This opens a menu of sweep softkeys.

3. Press Sweep Repeat Single Cont.

This toggles the sweep repeat from continuous to single.

4. Press Configure Step Sweep.

5. Press Freq Start > 500 > MHz.

This changes the start frequency of the step sweep to 500 MHz.

6. Press Freq Stop > 600 > MHz.

This changes the stop frequency of the step sweep to 600 MHz.

7. Press Ampl Start > −20 > dBm.

This changes the amplitude level for the start of the step sweep.

8. Press Ampl Stop > 0 > dBm.

This changes the amplitude level for the end of the step sweep.
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9. Press # Points > 9 > Enter.

This sets the number of sweep points to nine.

10.Press Step Dwell > 500 > msec.

This sets the dwell time at each point to 500 milliseconds.

11. Press Return > Sweep > Freq & Ampl.

This sets the step sweep to sweep both frequency and amplitude data. Selecting this 

softkey returns you to the previous menu and turns on the sweep function.

12.Press RF On/Off.

The display annunciator changes from RF OFF to RF ON.

13.Press Single Sweep.

A single sweep of the frequencies and amplitudes configured in the step sweep is executed 

and available at the RF OUTPUT connector. On the display, the SWEEP annunciator 

appears for the duration of the sweep and a progress bar shows the progression of the 

sweep. The Single Sweep softkey can also be used to abort a sweep in progress.

Activating Continuous Step Sweep

Press Sweep Repeat Single Cont.

This toggles the sweep from single to continuous. A continuous repetition of the frequencies 

and amplitudes configured in the step sweep are now available at the RF OUTPUT connector. 

The SWEEP annunciator appears, indicating that the signal generator is sweeping, and 

progression of the sweep is shown by a progress bar. 

Configuring a List Sweep Using Step Sweep Data

In this procedure, you will leverage the step sweep points and change the sweep information 

by editing several points in the List Mode Values table editor. For information on using table 

editors, see “Using Table Editors” on page 49.

1. Press Sweep Repeat Single Cont.

This toggles the sweep repeat from continuous to single. The SWEEP annunciator is turned 

off. The sweep will not occur until it is triggered.

2. Press Sweep Type List Step.

This toggles the sweep type from step to list.
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3. Press Configure List Sweep.

This opens another menu displaying softkeys that you will use to create the sweep points. 

The display shows the current list data. (When no list has been previously created, the 

default list contains one point set to the signal generator’s maximum frequency, minimum 

amplitude, and a dwell time of 2 ms.)

4. Press More (1 of 2) > Load List From Step Sweep > Confirm Load From Step Sweep. 

The points you defined in the step sweep are automatically loaded into the list.

Editing List Sweep Points

1. Press Return > Sweep > Off.

Turning the sweep off allows you to edit the list sweep points without generating errors. If 

sweep remains on during editing, errors occur whenever one or two point parameters 

(frequency, power, and dwell) is undefined.

2. Press Configure List Sweep.

This returns you to the sweep list table.

3. Use the arrow keys to highlight the dwell time in row 1.

4. Press Edit Item.

The dwell time for point 1 becomes the active function.

5. Press 100 > msec.

This enters 100 ms as the new dwell time value for row 1. Note that the next item in the 

table (in this case, the frequency value for point 2) becomes highlighted after you press the 

terminator softkey.

6. Using the arrow keys, highlight the frequency value in row 4.

7. Press Edit Item > 545 > MHz.

This changes the frequency value in row 4 to 545 MHz.

8. Highlight any column in the point 7 row and press Insert Row. 

This adds a new point between points 7 and 8. A copy of the point 7 row is placed between 

points 7 and 8, creating a new point 8, and renumbering the successive points.
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9. Highlight the frequency item for point 8, then press Insert Item.

Pressing Insert Item shifts frequency values down one row, beginning at point 8. Note that 

the original frequency values for both points 8 and 9 shift down one row, creating an entry 

for point 10 that contains only a frequency value (the power and dwell time items do not 

shift down).

The frequency for point 8 is still active.

10.Press 590 > MHz.

11. Press Insert Item > −2.5 > dBm. 

This inserts a new power value at point 8 and shifts down the original power values for 

points 8 and 9 by one row.

12.Highlight the dwell time for point 9, then press Insert Item.

A duplicate of the highlighted dwell time is inserted for point 9, shifting the existing value 

down to complete the entry for point 10.

Activating List Sweep for a Single Sweep

1. Press Return > Sweep > Freq & Ampl

This turns the sweep on again. No errors should occur if all parameters for every point 

have been defined in the previous editing process.

2. Press Single Sweep.

The signal generator will sweep the points in your list once. The SWEEP annunciator is 

activated during the sweep.

3. Press More (1 of 2) > Sweep Trigger > Trigger Key.

This sets the sweep trigger to occur when you press the Trigger hardkey.

4. Press More (2 of 2) > Single Sweep.

This arms the sweep. The ARMED annunciator has activated.

5. Press the Trigger hardkey.

The signal generator will sweep the points in your list once and the SWEEP annunciator is 

activated during the sweep.
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Using Sweep with the Step Attenuator (Option 1E1)

The signal generator protects the step attenuator from overuse during swept operation by 

automatically switching to attenuator hold mode whenever you select an amplitude sweep 

(Ampl or Freq & Ampl softkeys). The ATTN HOLD annunciator appears on the display when this 

mode is activated. The usable life of the attenuator is preserved, as the amplitude sweep 

range is limited to 45 dB, thereby preventing mechanical switching. The available amplitude 

range is displayed in the lower right corner of the Sweep/List Status Information screen. 

Changing the attenuator setting moves this range. To disable this attenuator protection, press 

Amplitude > Atten/ALC Control > Atten Hold On Off until Off is highlighted. The protection will 

be re-enabled the next time you select an amplitude sweep.

Using the Signal Generator with a MM-Wave Source Module

The RF output frequency of the signal generator can be multiplied using an Agilent 83550 

Series millimeter-wave source module. The signal generator/mm-wave source module’s output 

is automatically leveled when the instruments are connected. The output frequency range 

depends on the specific mm-wave source module. 

An Agilent 8349B microwave amplifier is required for signal generators without Option 1EA.

Option 1EA signal generators can drive the output of millimeter-wave source modules to 

maximum specified power without a microwave amplifier.

NOTE To ensure adequate RF amplitude at the mm-wave source module RF input 

when using an Option 1EA signal generator, maximum amplitude loss through 

the adapters and cables connected between the signal generator’s RF output 

and the mm-wave source module’s RF input should be less than 1.5 dB.

Required Equipment

• Agilent 83550 Series millimeter-wave source module

• Agilent 8349B microwave amplifier (required for signal generators without Option 1EA)

• cables and adapters as required
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Connect the Equipment

CAUTION To prevent damage to the signal generator, turn off the line power to the signal 

generator before connecting the source module interface cable to the rear panel 

SOURCE MODULE interface connector.

1. Turn off the signal generator’s line power.

2. Connect the equipment as shown. Use the setup in Figure 2-1 for signal generators 

without Option 1EA. Use the setup in Figure 2-2 for Option 1EA signal generators. 

Figure 2-1 Using a Millimeter-Wave Source Module with a Signal Generator 

without Option 1EA
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Figure 2-2 Using a Millimeter-Wave Source Module with an Option 1EA 

Signal Generator

Configure the Signal Generator

1. Turn on the signal generator’s line power. 

Upon power-up, the signal generator automatically: 

• senses the mm-wave source module,

• switches the signal generator’s leveling mode to external/source module (power is 

leveled at the mm-wave source module output),

• sets the mm-wave source module frequency and amplitude to the source module’s 

preset values, and

• in the FREQUENCY and AMPLITUDE areas of the signal generator, displays the RF output 

frequency and amplitude values available at the mm-wave source module output.

The MMMOD indicator in the FREQUENCY area and the MM indicator in the AMPLITUDE area of 

the signal generator’s display indicate that the mm-wave source module is active.

NOTE Refer to the mm-wave source module specifications for the specific frequency 

and amplitude ranges.
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2. If the RF OFF annunciator is displayed, press RF On/Off.

Leveled power is now available at the output of the millimeter-wave source module.

To obtain flatness-corrected power, refer to “Creating and Applying User Flatness Correction” 

on page 59.
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Configuring Analog Modulation (PSG-A Series Only)

PSG-A signal generators can modulate the RF carrier with four types of analog modulation: 

amplitude, frequency, phase, and pulse.

AM, FM, and ΦM Sources

• AM, FM, and ΦM have two source paths each. These multiple source paths are summed 

internally for composite modulation of the RF carrier.

• Each path can be supplied by one of four sources: Internal 1, Internal 2, External 1 or 

External 2.

• Only one path can be active for each source. For example, if AM Path 1 is on, AM Path 2 is 

on, and AM Path 1 source is set to Internal 1, AM Path 2 source must be set to Internal 2, 

External 1 or External 2. Different paths cannot use the same source at the same time.

• Waveforms available from Internal 1 and Internal 2 include:

Sine  sinewave with adjustable amplitude and frequency

Dual-Sine  dual sinewaves with individually adjustable frequencies and a 

percent-of- peak-amplitude setting for the second tone (available from 

function generator 1 only)

Swept-Sine  a swept sinewave with adjustable start and stop frequencies, sweep time, 

and sweep trigger settings (available from function generator 1 only)

Triangle  triangle wave with adjustable amplitude and frequency

Ramp  ramp with adjustable amplitude and frequency

Square  square wave with adjustable amplitude and frequency

Noise  noise, in a uniform or Gaussian distribution, with adjustable amplitude 

generated as a peak-to-peak value (RMS value is approximately 80% of 

the displayed value)

DC  constant adjustable amplitude

For a detailed description of the ranges and limitations of a specific waveform’s 

parameters, see that waveform’s softkey description in Chapter 5, “Key Reference,” on 

page 91.
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Pulse Sources

The following list summarizes the different sources available for pulse modulation.

External Pulse  modulates by following an external pulse signal connected 

to the signal generator’s PULSE/TRIGGER GATE INPUT 

connector.

Internal Doublet  produces two pulses at the RF OUTPUT connector for 

each trigger event at the TRIGGER IN connector. The first 

pulse will follow the external trigger signal. The second 

pulse will have user-defined delay and width parameters.

Internal Free-Run  produces internal, free-run, pulse modulation with 

user-defined period, width, and delay.

Internal Gated  produces an internal, gated, pulse modulation. When a 

valid gate signal is applied to the TRIGGER IN connector, 

a pulse train (with user-defined width parameters) will 

occur at the RF OUTPUT connector.

Internal Trigger  produces an internal, triggered, pulse modulation. An RF 

pulse (with user-defined width and delay parameters) will 

occur at the RF OUTPUT connector whenever a valid 

trigger signal occurs at the TRIGGER IN connector. 

Internal Square  produces internal, square, pulse modulation. This is a 

form of internal free-run pulse with a 50% duty cycle. The 

period is determined by rate.

For a detailed description of the behavior, ranges, and limitations of a specific pulse source, 

see that waveform’s softkey description in Chapter 5, “Key Reference,” on page 91.
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Configuring AM

Using this procedure, you will learn how to create a multipath amplitude-modulated RF 

carrier with the following characteristics:

• RF output frequency set to 15 GHz

• RF output amplitude set to 0 dBm

• AM Path 1 depth set to 90%

• AM Path 1 rate set to 10 kHz

• AM Path 1 waveform set to sine

• AM Path 2 depth set to 40%

• AM Path 2 waveform set to triangle

Setting the RF Output Frequency

1. Press Preset.

2. Press Frequency > 15 > GHz.

The FREQUENCY area of the display now reads 15.000 000 000 00 GHz.

Setting the RF Output Amplitude

Press Amplitude > 0 > dBm.

The AMPLITUDE area of the display now reads 0.00 dBm.

Setting the AM Depth and Rate

1. Press the AM hardkey.

The first level menu of softkeys is displayed.

2. Press AM Depth > 90 > %.

90.0 % is displayed below the AM Depth softkey.

3. Press AM Rate > 10 > kHz.

10.0000 kHz is displayed below the AM Rate softkey.
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Creating a Multipath AM Configuration

Use the following steps to configure a multipath AM configuration. AM Path 1 and AM Path 2 

are summed internally for composite modulation. Either path can be switched to any one of 

the modulation sources (internal 1 or 2, external 1 or 2), but any given source can only be 

routed to one modulation type at a time.

Note that the AM Source for AM Path 1 is set to Internal 1 as a default setting. Therefore, the 

AM Source for AM Path 2 must be set to another source, as explained in the following 

procedure.

1. Press AM Path 1 2 to toggle to AM Path 2.

This opens a menu of softkeys where you can define a second unique amplitude 

modulation configuration.

2. Press AM Depth > 40 > %.

The AM Path 2 AM depth is set to 40.0 %, as displayed below the AM Depth softkey.

3. Press More (1 of 2) > AM Waveform > Triangle.

The AM Path 2 AM waveform is set to Triangle, as displayed below the AM Waveform 

softkey.

4. Press More (2 of 2) > AM Source > Internal 2.

The AM Path 2 source is set to Internal 2, as displayed below the AM Waveform softkey.

The signal generator is now configured to output a 0 dBm, multipath amplitude-modulated 

carrier at 15 GHz. AM Path 1 is a sinewave with 90% depth and a 10 kHz rate. AM Path 2 is 

a triangle wave with 40% depth and a 400 Hz (default) rate.

Activating a Multipath AM Configuration

Follow these remaining steps to output the amplitude-modulated signal.

1. Press AM Off On.

This activates the modulation on AM Path 2. The AM annunciator is activated indicating 

that you have enabled amplitude modulation on AM Path 2.

2. Press AM Path 1 2 > Amp Off On.

This toggles back to AM Path 1 and activates the modulation on AM Path 1.

3. Press RF On/Off.

The RF ON annuciator is activated, indicating that the multipath AM signal is now 

available at the RF OUTPUT connector.
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Configuring FM

Using this procedure, you will learn how to create a frequency-modulated RF carrier with the 

following characteristics:

• RF output frequency set to 12 GHz

• RF output amplitude set to 0 dBm

• FM deviation set to 75 kHz

• FM rate set to 10 kHz

Setting the RF Output Frequency

1. Press Preset.

2. Press Frequency > 12 > GHz.

The FREQUENCY area of the display now reads 12.000 000 000 00 GHz.

Setting the RF Output Amplitude

Press Amplitude > 0 > dBm.

The AMPLITUDE area of the display now reads 0.00 dBm.

Setting the FM Deviation and Rate

1. Press FM/ΦM.

The first level menu of FM softkeys is displayed.

2. Press FM Dev > 75 > kHz.

75.0000 kHz is displayed below the FM Dev softkey.

3. Press FM Rate > 10 > kHz.

10.0000 kHz is displayed below the FM Rate softkey.

The signal generator is now configured to output a 0 dBm, frequency-modulated carrier at 

12 GHz with a 75 kHz deviation and a 10 kHz rate. The shape of the waveform is a sinewave. 

(Notice that sine is the default for the FM Waveform softkey. Press More (1 of 2) to see the 

softkey.) 
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Activating FM

Follow these remaining steps to output the frequency-modulated signal.

1. Press FM Off On.

The FM annunciator is activated indicating that you have enabled frequency modulation.

2. Press RF On/Off.

The RF ON annuciator is activated, indicating that the signal is now available at the 

RF OUTPUT connector.

Configuring ΦM

Using this procedure, you will learn how to create a phase-modulated RF carrier with the 

following characteristics:

• RF output frequency set to 20.0 GHz

• RF output amplitude set to 0 dBm

• ΦM deviation set to 0.25 π radians

• ΦM rate set to 30 kHz

Setting the RF Output Frequency

1. Press Preset.

2. Press Frequency > 20 > GHz.

The FREQUENCY area of the display now reads 20.000 000 000 00 GHz.

Setting the RF Output Amplitude

Press Amplitude > 0 > dBm.

The AMPLITUDE area of the display now reads 0.00 dBm.

Setting the ΦM Deviation and Rate

1. Press the FM/ΦM hardkey.

2. Press the FM ΦM softkey.

The first level menu of ΦM softkeys is displayed.
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3. Press ΦM Dev > .25 > pi rad. 

This changes the ΦM deviation to 0.25 π radians.

4. Press ΦM Rate > 10 > kHz.

This sets the ΦM rate to 10 kHz.

The signal generator is now configured to output a 0 dBm, phase-modulated carrier at 20 GHz 

with a 0.25 π radian deviation and 10 kHz rate. The shape of the waveform is a sinewave. 

(Notice that sine is the default for the ΦM Waveform softkey. Press More (1 of 2) to see the 

softkey.) 

Activating ΦM

Follow these remaining steps to output the phase-modulated signal.

1. Press ΦM Off On.

The ΦM annunciator is activated, indicating that you have enabled phase modulation.

2. Press RF On/Off.

The RF ON annunciator is activated, indicating that the signal is now available at the 

RF OUTPUT connector.

The signal generator is now configured to output a 0 dBm, pulse-modulated carrier at 18 GHz 

with a 100-microsecond pulse period and 24-microsecond pulse width. The pulse source is set 

to internal free-run. (Notice that internal free-run is the default for the Pulse Source softkey.) 
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Configuring Pulse Modulation

Using the following procedure you will learn how to create a pulse-modulated RF carrier with 

the following characteristics:

• RF output frequency set to 18 GHz

• RF output amplitude set to 0 dBm

• pulse period set to 100.0 µsec

• pulse width set to 24.0 µsec

• pulse source set to internal free-run

Setting the RF Output Frequency

1. Press Preset.

2. Press Frequency > 18 > GHz.

The FREQUENCY area of the display now reads 18.000 000 000 00 GHz.

Setting the RF Output Amplitude

Press Amplitude > 0 > dBm.

The AMPLITUDE area of the display now reads 0.00 dBm.

Setting the Pulse Period and Width

1. Press Pulse > Pulse Period > 100 > usec.

This sets the pulse period to 100 microseconds.

2. Press Pulse > Pulse Width > 24 > usec.

This sets the pulse period to 24 microseconds.

Activating Pulse Modulation

Follow these remaining steps to output the pulse-modulated signal.

1. Press Pulse Off On.

This activates pulse modulation. The Pulse annunciator is activated indicating that you 

have enabled pulse modulation.

2. Press RF On/Off.

The RF ON annuciator is activated, the signal is now available at the RF OUTPUT.
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Configuring the LF Output (PSG-A Series Only)

The PSG-A Series signal generator has a low frequency (LF) output. The LF output’s source 

can be switched between an internal modulation source (internal monitor 1 or 2) or an 

internal function generator (function generator 1 or 2).

Using internal monitor 1 or 2 as the LF output source, the LF output provides a replica of the 

signal from either internal source (1 or 2) that is being used to modulate the RF output. The 

specific modulation parameters for this signal are configured through the AM, FM, or ΦM 

menus.

Using function generator 1 or 2 as the LF output source, the function generator section of the 

internal modulation source (1 or 2) drives the LF output directly. Frequency and waveform 

are configured from the LF output menu, not through the AM, FM, or ΦM menus. You can 

select the waveform shape from the following choices:

Sine  sinewave with adjustable amplitude and frequency

Dual-Sine  dual sinewaves with individually adjustable frequencies and a percent-of- 

peak-amplitude setting for the second tone (available from function 

generator 1 only)

Swept-Sine  a swept sinewave with adjustable start and stop frequencies, sweep time, 

and sweep trigger settings (available from function generator 1 only)

Triangle  triangle wave with adjustable amplitude and frequency

Ramp  ramp with adjustable amplitude and frequency

Square  square wave with adjustable amplitude and frequency

Noise  noise, in a uniform or Gaussian distribution, with adjustable amplitude 

generated as a peak-to-peak value (RMS value is approximately 80% of the 

displayed value)

DC  direct current with adjustable amplitude

NOTE The LF Out Off On softkey controls the operating state of the LF output when the 

LF output source is set to function generator 1 or 2. The Mod On/Off softkey 

controls the operating state of the LF OUTPUT connector when the LF output 

source is set to internal monitor 1 or 2. 

The RF On/Off softkey does not apply to the LF OUTPUT connector.
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Configuring the LF Output with an Internal Modulation Source

In this example, the internal FM modulation is the LF output source.

Configuring the Internal Modulation as the LF Output Source

1. Press Preset.

2. Press the FM/ΦM hardkey.

3. Press FM Dev > 75 > kHz.

This sets the FM deviation to 75 kHz.

4. Press FM Rate > 10 > kHz. 

This sets the FM rate to 10 kHz.

5. Press FM Off On. 

The FM annunciator is activated indicating that you have enabled frequency modulation.

Configuring the Low Frequency Output

1. Press the LF Out hardkey.

This opens the Low Frequency Output menu. The LF output source is set to internal 

modulation 1 by default.

2. Press LF Out Amplitude Into 50 Ohms > 3 > Vp. 

This sets the LF output amplitude to 3 Vp. 3.000 Vp is displayed below the 

LF Out Amplitude softkey.

3. Press LF Out Off On.

The LF output is a 3 Vp frequency modulated sinewave (the default signal shape), with a 

75 kHz FM deviation and 10 kHz rate.
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Configuring the LF Output with a Function Generator Source

In this example, function generator 1 is the LF output source.

Configuring the Function Generator as the LF Output Source

1. Press Preset.

2. Press the LF Out hardkey.

3. Press LF Out Source > Function Generator 1. 

Function generator 1 becomes the LF output source and FuncGen 1 is displayed below the 

LF Out Source softkey.

Configuring the Waveform

1. Press LF Out Waveform > Swept-Sine.

This creates a swept-sine output and opens a menu that configures the sweep parameters 

of the swept-sine signal.

2. Press LF Out Start Freq > 100 > Hz.

This sets the swept-sine start frequency to 100 Hz.

3. Press LF Out Stop Freq > 1 > kHz.

This sets the swept-sine stop frequency to 1 kHz.

4. Press LF Out Sweep Rate > 350 > Hz.

This sets the swept-sign sweeps-per-second to 350.

5. Press Return > Return.

This returns you to the LF Output menu. The start frequency for the swept-sine waveform 

is displayed below the LF Out Freq softkey.

Configuring the Low Frequency Output

1. Press LF Out Amplitude Into 50 Ohms > 3 > Vp.

This sets the LF output amplitude to 3 Vp.

2. Press LF Out Off On.

This activates the LF output. The LF output is a 3 Vp swept-sine waveform, sweeping from 

100 Hz to 1 kHz with a sweep rate of 350 Hz.
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Using Data Storage Functions

This section explains how to use the two forms of signal generator data storage: the memory 

catalog and the instrument state register.

Using the Memory Catalog

The signal generator’s interface for stored files is the memory catalog. From there, you can 

view, copy, rename and delete files, either from the signal generator’s front panel or via 

remote controller. (For information on performing these tasks remotely, see the programming 

guide.)

The memory catalog may contain the following file types and their associated data:

BIN  bitmap data

LIST  sweep data from the List Mode Values table including frequency, amplitude, 

and dwell time

STAT  instrument state data, controlling instrument operating state parameters, 

such as frequency, amplitude, and mode

UFLT  user flatness calibration correction pair data (user-defined frequency and 

corresponding amplitude correction values)

Viewing Stored Files

1. Press Utility > Memory Catalog > Catalog Type.

The default catalog type is All (all files in the memory catalog are listed in alphabetical 

order, regardless of type). When viewing all files, file name listings include their file type, 

such as <file name>@STATE or <file name>@LIST.

2. Press List.

The Catalog of List Files is displayed.

3. Press Catalog Type > State.

The Catalog of State Files is displayed.

4. Press Catalog Type > User Flatness.

The Catalog of USERFLAT Files is displayed.
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Storing Files

To store a file to the memory catalog, first create a file. For this example, use the default list 

sweep table.

1. Press Preset.

2. Press Sweep/List > Configure List Sweep > More (1 of 2) > Load/Store.

This opens the Catalog of List Files.

3. Press Store to File.

This displays a menu of alphabetical softkeys for naming the file. Store to: is displayed 

in the active function area.

4. Enter the file name LIST1 using the alphabetical softkeys and the numeric keypad.

5. Press Enter.

The file is now displayed in the Catalog of List Files, showing the file name, type, and size.

Copying Stored Files

1. Highlight the desired file.

2. Press Copy File.

This opens the file naming text editor.

3. Press Editing Keys > Clear Text.

This clears the old file name.

4. Input the new file name using the alphabetical softkeys and the numeric keypad. 

(Additional characters are available by turning the knob.)

5. Press Enter.

Renaming Stored Files

1. Highlight the desired file.

2. Press More (1 of 2) > Rename File.

3. Press Editing Keys > Clear Text.

4. Input the new file name using the alphabetical softkeys and the numeric keypad. 

(Additional characters are available by turning the knob.)

5. Press Enter.

www.valuetronics.com



Fundamental Operation

Using Data Storage Functions

Chapter 246

Deleting Stored Files

1. Highlight the desired file.

2. Press Delete File. 

The Confirm Delete softkey appears.

3. Press Confirm Delete.

Using the Instrument State Register

The instrument state register is a section of memory divided into 10 sequences (numbered 0 

through 9) each containing 100 registers (numbered 00 through 99). It is used to store and 

recall frequency, amplitude, and for PSG-A Series signal generators, modulation settings. It 

provides a quick method to reconfigure the signal generator when switching between different 

signal configurations. Once an instrument state has been saved, all of the frequency, 

amplitude, and modulation settings can be recalled with minimum effort.

NOTE List sweep data is not saved within an instrument state. For instructions on 

saving list sweep data, see “Storing Files” on page 45. 

Saving an Instrument State

Using this procedure, you will learn how to save current instrument settings to the 

instrument state register.

1. Press Preset.

2. Configure the signal generator with the following settings:

a. Press Frequency > 800 > MHz.

b. Press Amplitude > 0 > dBm.

c. Press AM > AM Off On.

This enables amplitude modulation (AM annunciator is on).

3. Press Save > Select Seq.

The sequence number becomes the active function. The signal generator displays the last 

sequence that you have used. Set the sequence to 1 using the arrow keys.
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4. Press Select Reg.

The register number in sequence 1 becomes the active function. The signal generator 

displays either the last register used, accompanied by the text: (in use), or (if no 

registers are in use) register 00, accompanied by the text: (available). Use the arrow 

keys to select register 01.

5. Press Save Seq[1] Reg[01].

This will save this instrument state in sequence 1, register 01 of the instrument state 

register.

6. Press Add Comment to Seq[1] Reg[01].

This allows you to add a descriptive comment to sequence 1 register 01. Enter your 

comment using the alphanumeric softkeys or the knob and press Enter. 

7. Press Edit Comment In Seq[1] Reg[01].

This allows you to change the descriptive comment for sequence 1 register 01, if desired. 

Change your comment using the alphanumeric softkeys and press Enter. 

After making changes to an instrument state, you may save it back to a specific register by 

highlighting that register and pressing Re-SAVE Seq[n] Reg[nn].

Recalling an Instrument State

Using this procedure, you will learn how to recall instrument settings saved to an instrument 

state register.

1. Press Preset.

2. Press the Recall hardkey.

Notice that the Select Seq softkey shows sequence 1. (This is the last sequence that you 

used.)

3. Press RECALL Reg.

The register to be recalled in sequence 1 becomes the active function. Press the up arrow 

key once to select register 1. Your stored instrument state settings have now been recalled.

Deleting Registers and Sequences

Using this procedure, you will learn how to delete registers and sequences saved to an 

instrument state register.
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To Delete a Specific Register within a Sequence  

1. Press Preset.

2. Press the Recall or Save hardkey.

Notice that the Select Seq softkey shows the last sequence that you used.

3. Press Select Seq and enter the sequence number containing the register you want to delete.

4. Press Select Reg and enter the register number you want to delete.

Notice that the Delete Seq[n] Reg[nn] is now loaded with the sequence and register you 

want to delete.

5. Press Delete Seq[n] Reg[nn].

This deletes the chosen register.

To Delete All Registers within a Sequence  

1. Press Preset.

2. Press the Recall or Save hardkey.

Notice that the Select Seq softkey shows the last sequence that you used.

3. Press Select Seq and enter the sequence number containing the registers you want to 

delete.

4. Press Delete all Regs in Seq[n].

This deletes all registers in the selected sequence.

To Delete All Sequences  

CAUTION This will delete the entire contents of all registers and all sequences contained 

in the instrument state register.

1. Press Preset.

2. Press the Recall or Save hardkey.

Notice that the Select Seq softkey shows the last sequence that you used.

3. Press Delete All Sequences.

This deletes all of the sequences saved in the instrument state register.
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Using Table Editors

The PSG signal generator uses table editors to simplify configuration tasks such as creating a 

list sweep.

Using the List Mode Values table editor, the following section familiarizes you with basic table 

editor functionality.

Press Preset > Sweep/List > Configure List Sweep.

The signal generator displays the List Mode Values table editor, as shown below.

Active Function Area  an area that displays the active table item while its value 

is edited

Cursor  an inverse video identifier used to highlight specific table 

items for selection and editing

Table Editor Softkeys  keys that select table items, preset table values and 

modify table structures

Table Items  values arranged in numbered rows and titled columns

Cursor

Table Editor Softkeys Table Editor Name Table Items

Active Function Area
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Table Editor Softkeys

The following table editor softkeys are used to load, navigate, modify, and store table item 

values. Press More (1 of 2) to view additional table editor softkeys.

Edit Item  displays the selected item in the active function area of the display where 

the item’s value can be modified

Insert Row  inserts an identical row of table items above the currently selected row

Delete Row  deletes the currently selected row

Insert Item  inserts an identical item in a new row below the currently selected item

Delete Item  deletes the item from the bottom row of the currently selected column

Goto Row  opens a menu of softkeys (Goto Top Row, Goto Middle Row, Goto Bottom Row, 

Page Up, and Page Down) used to quickly navigate through the table items

Page Up and

Page Down  display table items that occupy rows outside the limits of the ten-row table 

display area

Load/Store  opens a menu of softkeys (Load From Selected File, Store To File, Goto Row, 

Page Up, and Page Down) used to load table items from a file in the memory 

catalog, or to store the current table items as a file in the memory catalog

For more information on loading and storing files, see “Using Data Storage 

Functions” on page 44.

Modifying Items in the Table Editor

To modify existing table items:

1. Use the arrow keys or the knob to move the table cursor over the desired item.

2. Press Edit Item.

The selected item is displayed in the active function area of the display.

3. Use the knob, arrow keys, or the numeric keypad to modify the value.

4. Press Enter.

The modified item is now displayed in the table.
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Configuring for Remote Control

This section will show you how to configure the signal generator to interface with a remote 

controller. For more information refer to the programming guide.

NOTE Front panel keys are locked when using a remote controller. Only the Local key 

is active. To unlock the front panel keypad, press the Local key.

Configuring for a GPIB Interface

1. Press Utility > GPIB/RS-232 > GPIB Address.

2. Use the numeric keypad, arrow keys, or front panel knob to set the desired address.

3. Press Enter.

The signal generator’s GPIB address is set to 19 at the factory. The acceptable range of 

addresses is 0 through 30. Each device on a GPIB bus must have a unique address. However, 

it is not advisable to use address 21, as this is often reserved as a controller talk/listen 

address. The GPIB address is not affected by a signal generator preset or by a power cycle.

Configuring for a LAN (10BASE-T) Interface

1. Obtain a hostname and IP address from your system administrator or IT department.

2. Press Utility > GPIB/RS-232 LAN > LAN Setup.

3. Press Hostname.

Use the alphanumeric softkeys to enter a hostname. For lowercase letters, use the knob.

4. Press Enter.

5. Press IP Address.

Use the left and right arrow keys to move the cursor. Use the up and down arrow keys, the 

front panel knob or the numeric keypad to enter an IP address. Use the backspace key to 

delete digits in the address.

6. Press Enter.

This assigns a hostname and IP address to the signal generator. The hostname and IP 

address are not affected by an instrument preset or by a power cycle.
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Configuring for an RS-232 Interface

1. Press Utility > GPIB/RS-232 LAN > RS-232 Setup.

2. Press RS-232 Baud Rate.

Press the desired baud rate softkey to set the baud rate.

3. Press RS-232 Echo Off On.

This toggles the state of the SCPI echoing on the RS-232 connection. Set as desired.

4. Press Trans/Recv Pace None Xon.

This toggles from no handshaking (Trans/Recv Pace None) to XON/XOFF handshaking 

(Trans/Recv Pace Xon) when transmitting or receiving data via RS-232. Set as desired.

5. Press Reset RS-232.

This deletes the data from the RS-232 buffer. Pressing this key will discard any 

unprocessed SCPI input received over RS-232.

6. Press RS-232 Timeout.

This allows you to enter a value in seconds before the instrument generates an RS-232 

timeout after not receiving data on the serial bus.

These RS-232 parameters are not affected by an instrument preset or by a power cycle.
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Using External Leveling

The PSG signal generator can be externally leveled by connecting an external sensor at the 

point where leveled RF output power is desired. This sensor detects changes in RF output 

power and returns a compensating voltage to the signal generator’s ALC input. The ALC 

circuitry raises or lowers (levels) the RF output power based on the voltage received from the 

external sensor, ensuring constant power at the point of detection.

There are two types of external leveling available on the PSG. You can use external leveling 

with a detector and coupler/power splitter setup, or a millimeter-wave source module.

Leveling with Detectors and Couplers/Splitters

Figure 3-1 illustrates a typical external leveling setup. The power level feedback to the ALC 

circuitry is taken from the external negative detector, rather than the internal signal 

generator detector. This feedback voltage controls the ALC system, leveling the RF output 

power at the point of detection.

To use detectors and couplers/splitters for external leveling at an RF output frequency of 

10 GHz and an amplitude of 0 dBm, follow the instructions in this section.

Required Equipment

• Agilent 8474E negative detector

• Agilent 87301D directional coupler

• cables and adapters, as required

Connect the Equipment

Set up the equipment as shown in Figure 3-1.
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Figure 3-1 External Detector Leveling with a Directional Coupler

Configure the Signal Generator

1. Press Preset.

2. Press Frequency > 10 > GHz.

3. Press Amplitude > 0 > dBm.

4. Press RF On/Off.

5. Press Leveling Mode > External Detector.

This deactivates the internal ALC detector and switches the ALC input path to the front 

panel ALC INPUT connector. The EXT indicator is activated in the AMPLITUDE area of the 

display.

NOTE For signal generators with Option 1E1, notice that the ATTN HOLD (attenuator 

hold) annunciator is displayed. During external leveling, the signal generator 

automatically uncouples the attenuator from the ALC system for all external 

leveling points. While in this mode, RF output amplitude adjustment is limited 

to −20 to +25 dBm, the adjustment range of the ALC circuitry. For more 

information, see “External Leveling with Option 1E1 Signal Generators” on 

page 58.

6. Observe the coupling factor printed on the directional coupler at the detector port. 

Typically, this value is −10 to −20 dB.

Enter the positive dB value of this coupling factor into the signal generator.
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7. Press More (1 of 2) > Ext Detector Coupling Factor > 16 (or the positive representation of the 

value listed at the detector port of the directional coupler) > dB.

Leveled output power is now available at the output of the directional coupler.

NOTE While operating in external leveling mode, the signal generator’s displayed RF 

output amplitude is affected by the coupling factor value, resulting in a 

calculated approximation of the actual RF output amplitude. 

To determine the actual RF output amplitude at the point of detection, measure 

the voltage at the external detector output and refer to Figure 3-2 or you 

measure the power directly with a power meter.

Determining the Leveled Output Power

Figure 3-2 shows the input power versus output voltage characteristics for typical Agilent 

Technologies diode detectors. Using this chart, you can determine the leveled power at the 

diode detector input by measuring the external detector output voltage. You must then add 

the coupling factor to determine the leveled output power. The range of power adjustment is 

approximately −20 to +25 dBm.

www.valuetronics.com



Optimizing Performance

Using External Leveling

Chapter 3 57

Figure 3-2 Typical Diode Detector Response at 25° C
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External Leveling with Option 1E1 Signal Generators

Signal generators with Option 1E1 contain a step attenuator prior to the RF output connector. 

During external leveling, the signal generator automatically holds the present attenuator 

setting (to avoid power transients that may occur during attenuator switching) as the RF 

amplitude is changed. A balance must be maintained between the amount of attenuation and 

the optimum ALC level to achieve the required RF output amplitude. For optimum accuracy 

and minimum noise, the ALC level should be greater than −10 dBm.

For example, leveling the CW output of a 30 dB gain amplifier to a level of −10 dBm requires 

the output of the signal generator to be approximately −40 dBm when leveled. This is beyond 

the amplitude limits of the ALC modulator alone, resulting in an unleveled RF output. 

Inserting 45 dB of attenuation results in an ALC level of +5 dBm, well within the range of the 

ALC modulator.

NOTE In the example above, 55 dB is the preferred attenuation choice, resulting in an 

ALC level of +15 dBm. This provides adequate dynamic range for AM or other 

functions that vary the RF output amplitude.

To achieve the optimum ALC level at the signal generator RF output of −40 dBm for an 

unmodulated carrier, follow these steps:

1. Press Set Atten > 45 > dB.

2. Press Set ALC Level > 5 > dBm. 

This sets the attenuator to 45 dB and the ALC level to +5 dBm, resulting in an RF output 

amplitude of −40 dBm, as shown in the AMPLITUDE area of the display.

To obtain flatness-corrected power, refer to “Creating and Applying User Flatness Correction” 

on page 59.

Leveling with a Millimeter-Wave Source Module

Millimeter-wave source module leveling is similar to external detector leveling. The power 

level feedback signal to the ALC circuitry is taken from the millimeter-wave source module, 

rather than the internal signal generator detector. This feedback signal levels the RF output 

power at the mm-wave source module output through the signal generator’s rear panel 

SOURCE MODULE interface connector.

For instructions and setups, see “Using the Signal Generator with a MM-Wave Source 

Module” on page 29.
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Creating and Applying User Flatness Correction

User flatness correction allows the digital adjustment of RF output amplitude for up to 1601 

frequency points in any frequency or sweep mode. Using an Agilent E4416A/17A or 

E4418B/19B power meter (controlled by the signal generator through GPIB) to calibrate the 

measurement system, a table of power level corrections is created for frequencies where power 

level variations or losses occur. These frequencies may be defined in sequential linear steps or 

arbitrarily spaced. 

If you do not have an Agilent E4416A/17A or E4418B/19B power meter, or if your power 

meter does not have a GPIB interface, the correction values can be manually entered into the 

signal generator.

To allow different correction arrays for different test setups or different frequency ranges, you 

may save individual user flatness correction tables to the signal generator’s memory catalog 

and recall them on demand.

Follow the steps in the next sections to create and apply user flatness correction to the signal 

generator’s RF output.

Afterward, follow the steps in “Recalling and Applying a User Flatness Correction Array” on 

page 64 to recall a user flatness file from the memory catalog and apply it to the signal 

generator’s RF output.

Creating a User Flatness Correction Array

In this example, you will create a user flatness correction array. The flatness correction array 

contains ten frequency correction pairs (amplitude correction values for specified frequencies), 

from 1 to 10 GHz in 1 GHz intervals. 

An Agilent E4416A/17A/18B/19B power meter (controlled by the signal generator via GPIB) 

and E4413A power sensor are used to measure the RF output amplitude at the specified 

correction frequencies and transfer the results to the signal generator. The signal generator 

reads the power level data from the power meter, calculates the correction values, and stores 

the correction pairs in the user flatness correction array.

If you do not have the required Agilent power meter, or if your power meter does not have a 

GPIB interface, you can enter correction values manually. 
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Required Equipment

• Agilent E4416A/17A/18B/19B power meter

• Agilent E4413A E Series CW power sensor

• GPIB interface cable

• adapters and cables, as required

NOTE If the setup has an external leveling configuration, the equipment setup in 

Figure 3-3 assumes that the steps necessary to correctly level the RF output 

have been followed. If you have questions about external leveling, refer to 

“Using External Leveling” on page 54.

Configure the Power Meter

1. Select SCPI as the remote language for the power meter.

2. Zero and calibrate the power sensor to the power meter.

3. Enter the appropriate power sensor calibration factors into the power meter as 

appropriate.

4. Enable the power meter’s cal factor array.

NOTE For operating information on your particular power meter/sensor, refer to its 

operating guide.

Connect the Equipment

Connect the equipment as shown in Figure 3-3.

NOTE During the process of creating the user flatness correction array, the power 

meter is slaved to the signal generator via GPIB. No other controllers are 

allowed on the GPIB interface.
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Figure 3-3 User Flatness Correction Equipment Setup

Configure the Signal Generator

1. Press Preset.

2. Configure the signal generator to interface with the power meter.

a. Press Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, 

E4417A, E4418B, or E4419B.

b. Press Meter Address > enter the power meter’s GPIB address > Enter.

c. For E4417A and E4419B models, press Meter Channel A B to select the power meter’s 

active channel.

d. Press Meter Timeout to adjust the length of time before the instrument generates a 

timeout error if unsuccessfully attempting to communicate with the power meter.

3. Press More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset.

This opens the User Flatness table editor and presets the cal array frequency/correction 

list.
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4. Press Configure Step Array.

This opens a menu for entering the user flatness step array data.

5. Press Freq Start > 1 > GHz.

6. Press Freq Stop > 10 > GHz.

7. Press # of Points > 10 > Enter.

Steps 4, 5, and 6 enter the desired flatness-corrected frequencies into the step array.

8. Press Return > Load Cal Array From Step Array > Confirm Load From Step Sweep.

This populates the user flatness correction array with the frequency settings defined in the 

step array.

9. Press Amplitude > 0 > dBm.

10.Press RF On/Off.

This activates the RF output and the RF ON annunciator is displayed on the signal 

generator.

Perform the User Flatness Correction 

NOTE If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your 

power meter does not have a GPIB interface, you can perform the user flatness 

correction manually. For instructions, see “Performing the User Flatness 

Correction Manually” on page 63.

1. Press More (1 of 2) > User Flatness > Do Cal.

This creates the user flatness amplitude correction value table entries. The signal 

generator enters the user flatness correction routine and a progress bar is shown on the 

display.

www.valuetronics.com



Optimizing Performance

Creating and Applying User Flatness Correction

Chapter 3 63

2. When prompted, press Done.

This loads the amplitude correction values into the user flatness correction array.

If desired, press Configure Cal Array.

This opens the user flatness correction array, where you can view the stored amplitude 

correction values. The user flatness correction array title displays User Flatness: 
(UNSTORED) indicating that the current user flatness correction array data has not been 

saved to the memory catalog.

Performing the User Flatness Correction Manually

If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your power meter 

does not have a GPIB interface, complete the steps in this section and then continue with the 

user flatness correction tutorial.

1. Press More (1 of 2) > User Flatness > Configure Cal Array.

This opens the User Flatness table editor and places the cursor over the frequency value 

(1 GHz) for row 1. The RF output changes to the frequency value of the table row 

containing the cursor and 1.000 000 000 00 is displayed the AMPLITUDE area of the 

display. 

2. Observe and record the measured value from the power meter.

3. Subtract the measured value from 0 dBm.

4. Move the table cursor over the correction value in row 1.

5. Press Edit Item > enter the difference value from step 3 > dB.

The signal generator adjusts the RF output amplitude based on the correction value 

entered.

6. Repeat steps 2 through 5 until the power meter reads 0 dBm.

7. Use the down arrow key to place the cursor over the frequency value 

for the next row. The RF output changes to the frequency value of the table row containing 

the cursor, as shown in the AMPLITUDE area of the display. 

8. Repeat steps 2 through 7 for every entry in the User Flatness table.
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Save the User Flatness Correction Data to the Memory Catalog

This process allows you to save the user flatness correction data as in the signal generator’s 

memory catalog. With several user flatness correction files saved to the memory catalog, any 

file can be recalled, loaded into the correction array, and applied to the RF output to satisfy 

specific RF output flatness requirements.

1. Press Load/Store.

2. Press Store to File.

3. Enter the file name FLATCAL1 using the alphanumeric softkeys, numeric keypad, or the 

knob.

4. Press Enter.

The user flatness correction array file FLATCAL1 is now stored in the memory catalog as a 

UFLT file.

Applying a User Flatness Correction Array

Press Return > Return > Flatness Off On.

This applies the user flatness correction array to the RF output. The UF indicator is activated 

in the AMPLITUDE section of the signal generator’s display and the frequency correction data 

contained in the correction array is applied to the RF output amplitude.

Recalling and Applying a User Flatness Correction Array

Before performing the steps in this section, complete “Creating a User Flatness Correction 

Array” on page 59.

1. Press Preset.

2. Press Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) > 

Preset List > Confirm Preset.

3. Press More (2 of 2) > Load/Store.

4. Ensure that the file FLATCAL1 is highlighted.

5. Press Load From Selected File > Confirm Load From File.

This populates the user flatness correction array with the data contained in the file 

FLATCAL1. The user flatness correction array title displays User Flatness: FLATCAL1.

6. Press Return > Flatness Off On.

This applies the user flatness correction data contained in FLATCAL1.
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Returning the Signal Generator to GPIB Listener Mode

During the user flatness correction process, the power meter is slaved to the signal generator 

via GPIB, and no other controllers are allowed on the GPIB interface. The signal generator 

operates in GPIB talker mode, as a device controller for the power meter. In this operating 

mode, it cannot receive SCPI commands via GPIB.

NOTE If the signal generator is to be interfaced to a remote controller after 

performing the user flatness correction, its GPIB controller mode must be 

changed from GPIB talker to GPIB listener. This is accomplished by presetting 

the signal generator.

If an RF carrier has been previously configured, you must save the present 

instrument state before returning the signal generator to GPIB listener mode.

1. Save your instrument state to the instrument state register.

For instructions, see “Saving an Instrument State” on page 46.

2. Press GPIB Listener Mode.

This presets the signal generator and returns it to GPIB listener mode. The signal 

generator can now receive remote commands executed by a remote controller connected to 

the GPIB interface.

3. Recall your instrument state from the instrument state register.

For instructions, see “Recalling an Instrument State” on page 47.
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Creating a User Flatness Correction Array Using a MM-Wave Source 

Module

In this example, a user flatness correction array is created to provide flatness-corrected power 

at the output of an Agilent 83554A millimeter-wave source module driven by an E8241A 

signal generator. 

The flatness correction array contains 28 frequency correction pairs (amplitude correction 

values for specified frequencies), from 26.5 to 40 GHz in 500 MHz intervals. This will result in 

28 evenly spaced flatness corrected frequencies between 26.5 GHz and 40 GHz at the output 

of the 83554A millimeter-wave source module.

An Agilent E4416A/17A/18B/19B power meter (controlled by the signal generator via GPIB) 

and R8486A power sensor are used to measure the RF output amplitude of the 

millimeter-wave source module at the specified correction frequencies and transfer the results 

to the signal generator. The signal generator reads the power level data from the power 

meter, calculates the correction values, and stores the correction pairs in the user flatness 

correction array.

If you do not have the required Agilent power meter, or if your power meter does not have a 

GPIB interface, you can enter correction values manually. 

Required Equipment

• Agilent 83554A millimeter-wave source module

• Agilent E4416A/17A/18B/19B power meter

• Agilent R8486A power sensor

• Agilent 8349B microwave amplifier (required for signal generators without Option 1EA)

• GPIB interface cable

• adapters and cables as required

NOTE The equipment setups in Figure 3-4 and Figure 3-5 assume that the steps 

necessary to correctly level the RF output have been followed. If you have 

questions about leveling with a millimeter-wave source module, refer to 

“Leveling with a Millimeter-Wave Source Module” on page 58.
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Configure the Power Meter

1. Select SCPI as the remote language for the power meter.

2. Zero and calibrate the power sensor to the power meter.

3. Enter the appropriate power sensor calibration factors into the power meter as 

appropriate.

4. Enable the power meter’s cal factor array.

NOTE For operating information on your particular power meter/sensor, refer to their 

operating guides.

Connect the Equipment

CAUTION To prevent damage to the signal generator, turn off the line power to the signal 

generator before connecting the source module interface cable to the rear panel 

SOURCE MODULE interface connector.

1. Turn off the line power to the signal generator.

2. Connect the equipment. For standard signal generators, use the setup in Figure 3-4. For 

Option 1EA signal generators, use the setup in Figure 3-5.

NOTE During the process of creating the user flatness correction array, the power 

meter is slaved to the signal generator via GPIB. No other controllers are 

allowed on the GPIB interface.
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Figure 3-4 User Flatness with MM-Wave Source Module for a Signal 

Generator without Option 1EA

Figure 3-5 User Flatness with MM-Wave Source Module and Option 1EA 
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Signal Generator

NOTE To ensure adequate RF amplitude at the mm-wave source module RF input 

when using Option 1EA signal generators, maximum amplitude loss through 

the adapters and cables connected between the signal generator’s RF output 

and the mm-wave source module’s RF input should be less than 1.5 dB.
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Configure the Signal Generator

1. Turn on the signal generator’s line power.

Upon power-up, the signal generator automatically does the following:

• senses the mm-wave source module

• switches the signal generator’s leveling mode to external/source module

• sets the mm-wave source module frequency and amplitude to the source module’s 

preset values

• displays the RF output frequency and amplitude values available at the mm-wave 

source module output

The MMMOD indicator in the FREQUENCY area and the MM indicator in the AMPLITUDE area of 

the signal generator’s display indicate that the mm-wave source module is active

NOTE Refer to the mm-wave source module specifications for the specific frequency 

and amplitude ranges.

2. Configure the signal generator to interface with the power meter.

a. Press Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, 

E4417A, E4418B, or E4419B.

b. Press Meter Address > enter the power meter’s GPIB address > Enter.

c. For E4417A and E4419B models, press Meter Channel A B to select the power meter’s 

active channel.

d. Press Meter Timeout to adjust the length of time before the instrument generates a 

timeout error if unsuccessfully attempting to communicate with the power meter.

3. Press More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset.

This opens the User Flatness table editor and resets the cal array frequency/correction list.

4. Press Configure Step Array.

This opens a menu for entering the user flatness step array data.

5. Press Freq Start > 26.5 > GHz.

6. Press Freq Stop > 40 > GHz.
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7. Press # of Points > 28 > Enter.

This enters the desired flatness-corrected frequencies (26.5 GHz to 40 GHz in 500 MHz 

intervals) into the step array.

8. Press Return > Load Cal Array From Step Array > Confirm Load From Step Sweep.

This populates the user flatness correction array with the frequency settings defined in the 

step array.

9. Press Amplitude > 0 > dBm.

10.Press RF On/Off.

This activates the RF output and the RF ON annunciator is displayed on the signal 

generator.

Perform the User Flatness Correction 

NOTE If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your 

power meter does not have a GPIB interface, you can perform the user flatness 

correction manually. For instructions, see  “Performing the User Flatness 

Correction Manually” below.

1. Press More (1 of 2) > User Flatness > Do Cal.

This creates the user flatness amplitude correction value table entries. The signal 

generator begins the user flatness correction routine and a progress bar is shown on the 

display.

2. When prompted, press Done.

This loads the amplitude correction values into the user flatness correction array.

If desired, press Configure Cal Array.

This opens the user flatness correction array, where you can view the list of defined 

frequencies and their calculated amplitude correction values. The user flatness correction 

array title displays User Flatness: (UNSTORED) indicating that the current user flatness 

correction array data has not been saved to the memory catalog.
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Performing the User Flatness Correction Manually

If you are not using an Agilent E4416A/17A/18B/19B power meter, or if your power meter 

does not have a GPIB interface, complete the steps in this section and then continue with the 

user flatness correction tutorial.

1. Press More (1 of 2) > User Flatness > Configure Cal Array.

This opens the User Flatness table editor and places the cursor over the frequency value 

(26.5 GHz) for row 1. The RF output changes to the frequency value of the table row 

containing the cursor and 26.500 000 000 00 is displayed the AMPLITUDE area of the 

display. 

2. Observe and record the measured value from the power meter.

3. Subtract the measured value from 0 dBm.

4. Move the table cursor over the correction value in row 1.

5. Press Edit Item > enter the difference value from step 3 > dB.

The signal generator adjusts the RF output amplitude based on the correction value 

entered.

6. Repeat steps 2 through 5 until the power meter reads 0 dBm.

7. Use the down arrow key to place the cursor over the frequency value for the next row. The 

RF output changes to the frequency value highlighted by the cursor, as shown in the 

AMPLITUDE area of the display. 

8. Repeat steps 2 through 7 for every entry in the User Flatness table.

Save the User Flatness Correction Data to the Memory Catalog

This process allows you to save the user flatness correction data as a file in the signal 

generator’s memory catalog. With several user flatness correction files saved to the memory 

catalog, specific files can be recalled, loaded into the correction array, and applied to the RF 

output to satisfy various RF output flatness requirements.

1. Press Load/Store.

2. Press Store to File.

3. Enter the file name FLATCAL2 using the alphanumeric softkeys and the numeric keypad.

4. Press Enter.

The user flatness correction array file FLATCAL2 is now stored in the memory catalog as a 

UFLT file.
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Applying the User Flatness Correction Array

1. Press Return > Return > Flatness Off On.

This applies the user flatness correction array to the RF output. The UF indicator is 

activated in the AMPLITUDE section of the signal generator’s display and the frequency 

correction data contained in the correction array is applied to the RF output amplitude of 

the mm-wave source module.

Recalling and Applying a User Flatness Correction Array

Before performing the steps in this section, complete the section “Creating a User Flatness 

Correction Array Using a MM-Wave Source Module” on page 66.

1. Press Preset.

2. Press Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) > 

Preset List > Confirm Preset.

3. Press More (2 of 2) > Load/Store.

4. Ensure that the file FLATCAL2 is highlighted.

5. Press Load From Selected File > Confirm Load From File.

This populates the user flatness correction array with the data contained in the file 

FLATCAL2. The user flatness correction array title displays User Flatness: FLATCAL2.

6. Press Return > Flatness Off On.

This activates flatness correction using the data contained in the file FLATCAL2.
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ALC Bandwidth Selection

For internal leveling, the signal generator uses automatic leveling control (ALC) circuitry 

prior to the RF output. ALC bandwidth has five selections: automatic, 100 Hz, 1 kHz, 10 kHz, 

and 100 kHz.

At signal generator preset, the ALC bandwidth selection is set to Auto. In this configuration, 

the signal generator automatically adjusts the ALC bandwidth between three of the four 

possible settings, depending on which functions are currently active. Figure 3-6 shows the 

signal generator’s automatic ALC bandwidth selection decision tree.

Figure 3-6 Decision Tree for Automatic ALC Bandwidth Selection

To select an ALC bandwidth, press Amplitude > ALC BW > 100 Hz, 1 kHz, 10 kHz, or 100 kHz.

This overrides the automatic ALC bandwidth selection with your specific selection.
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If You Encounter a Problem

If the signal generator is not operating as you expect, look for help in the following list of 

symptoms and possible solutions. If you do not find a solution here, refer to the service guide.

Can’t Turn Off Help Mode

1. Press Utility > Instrument Info/Help Mode.

2. Press Help Mode Single Cont softkey until Single is highlighted.

There are two help modes (single and continuous) available on the signal generator. 

In single mode (the factory preset condition) when you press the Help key, help text is provided 

for your next key press. Now press any key and you will exit the help function and the 

function of the key you pressed is also executed.

In continuous help mode, when you press the Help key, help text is provided for your next key 

press and that key’s function is also executed (except for the Preset key). You will stay in help 

mode until you press the Help key again or you toggle back to single mode.

No RF Output

Check the RF ON/OFF annunciator on the display. If it reads RF OFF, press RF On/Off to toggle 

the RF output on.

No Modulation at the RF Output

Check the MOD ON/OFF annunciator on the display. If it reads MOD OFF, press Mod On/Off to 

toggle the modulation on. 

Although you can set up and enable various modulations, the RF carrier is modulated only 

when you have also set Mod On/Off to On.
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RF Output Power too Low

1. Look for an OFFS or REF indicator in the AMPLITUDE area of the display.

OFFS tells you that an amplitude offset has been set. An amplitude offset changes the value 

shown in the AMPLITUDE area of the display but does not affect the output power. The 

amplitude displayed is equal to the current power output by the signal generator 

hardware plus the value for the offset.

To eliminate the offset, do the following:

Press Amplitude > More (1 of 2) > Ampl Offset > 0 > dB.

REF tells you that the amplitude reference mode is activated. When this mode is on, the 

displayed amplitude value is not the output power level. Rather, it is the current power 

output by the signal generator hardware minus the reference value set by the Ampl Ref Set 
softkey.

To exit the reference mode, follow these steps:

a. Press Amplitude > More (1 of 2).

b. Press Ampl Ref Off On until Off is highlighted.

You can then reset the output power to the desired level.

2. If you are using the signal generator with an external mixer, see “Signal Loss Occurs 

While Working with Mixers” on page 78.

3. If you are using the signal generator with a spectrum analyzer, see “Signal Loss Occurs 

While Working with Spectrum Analyzers” on page 80.
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Signal Loss Occurs While Working with Mixers

If you experience signal loss at the signal generator’s RF output during low-amplitude, 

coupled operation with a mixer, you can solve the problem by adding attenuation and 

increasing the RF output amplitude of the signal generator.

Figure 4-1 shows a hypothetical configuration in which the signal generator provides a low 

amplitude signal to a mixer.

Figure 4-1 Effects of Reverse Power on ALC

The internally leveled signal generator RF output (and ALC level) is −8 dBm. The mixer is 

driven with an LO of +10 dBm and has an LO-to-RF isolation of 15 dB. The resulting LO 

feedthrough of −5 dBm enters the signal generator’s RF output connector and arrives at the 

internal detector.

Depending on frequency, it is possible for most of this LO feedthrough energy to enter the 

detector. Since the detector responds to its total input power regardless of frequency, this 

excess energy causes the ALC to reduce the RF output of the signal generator. In this 

example, the reverse power across the detector is actually greater than the ALC level, which 

may result in loss of signal at the RF output.

Figure 4-2 shows a similar configuration with the addition of a 10 dB attenuator connected 

between the RF output of the signal generator and the input of the mixer. The signal 

generator’s ALC level is increased to +2 dBm and transmitted through a 10 dB attenuator to 

achieve the required −8 dBm amplitude at the mixer input. 
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Figure 4-2 Reverse Power Solution

As compared to the original configuration, the ALC level is 10 dB higher while the attenuator 

reduces the LO feedthrough (and the RF output of the signal generator) by 10 dB. Using the 

attenuated configuration, the detector is exposed to a +2 dBm desired signal versus the 

−15 dBm undesired LO feedthrough. This 17 dB difference between desired and undesired 

energy results in a maximum 0.1 dB shift in the signal generator’s RF output level.
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Signal Loss Occurs While Working with Spectrum Analyzers

The effects of reverse power, when using the signal generator with a spectrum analyzer that 

does not have preselection capability, can cause problems with the signal generator’s RF 

output.

Some spectrum analyzers have as much as +5 dBm LO feedthrough at their RF input port at 

some frequencies. If the frequency difference between the LO feedthrough and the RF carrier 

is less than the ALC bandwidth (typically 10 kHz CW and 100 kHz for modulated signals), the 

LO’s reverse power can cause amplitude modulation of the signal generator’s RF output. The 

rate of the undesired AM equals the difference in frequency between the spectrum analyzer’s 

LO feedthrough and the RF carrier of the signal generator.

Reverse power problems can be solved by using one of two unleveled operating modes, ALC off 

mode or power search mode.

ALC Off Mode

ALC off mode deactivates the automatic leveling circuitry prior to the signal generator’s RF 

output. In this mode, a power meter is required to measure the output of the signal generator 

and assist in achieving the required output power at the point of detection.

To set the signal generator to the ALC off mode, follow these steps:

1. Press Preset.

2. Press Frequency, enter the required frequency, and terminate the entry with the 

appropriate terminator softkey.

3. Press Amplitude, enter the required amplitude, and terminate the entry with the 

appropriate terminator softkey.

4. Press RF On/Off.

5. Press Amplitude > ALC Off On.

This deactivates the signal generator’s automatic leveling control.

6. Monitor the RF output amplitude as measured by the power meter.

7. Press Amplitude and adjust the signal generator’s RF output amplitude until the desired 

power is measured by the power meter.
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Power Search Mode

Power search mode executes a power search routine that momentarily activates the ALC, 

calibrates the power of the current RF output, and then disconnects the ALC circuitry. 

To set the signal generator to manual, fixed power search mode, follow these steps:

1. Press Preset.

2. Press Frequency, enter the required frequency, and terminate the entry with the 

appropriate terminator softkey.

3. Press Amplitude, enter the required amplitude, and terminate the entry with the 

appropriate terminator softkey.

4. Press ALC Off On.

This deactivates the ALC circuitry.

5. Press RF On/Off.

6. Press Do Power Search.

This executes the manual, fixed power search routine.

There are two power search modes, manual and automatic.

In manual power search mode (Power Search Manual Auto set to Manual), pressing Do Power 
Search executes the power search calibration routine for the current RF frequency and 

amplitude. In this mode, a change in RF frequency or amplitude necessitates another 

calibration (press Do Power Search again).

In automatic power search mode (Power Search Manual Auto set to Auto), the calibration 

routine is executed whenever the frequency or amplitude of the RF output is changed.
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Sweep Appears to be Stalled

The current status of the sweep is indicated as a shaded rectangle in the progress bar. You can 

use the progress bar to determine if the sweep is proceeding or is waiting. If the sweep 

appears to have stalled, check the following:

❏ Have you turned on the sweep by pressing either Sweep > Freq, Sweep > Ampl, or Sweep > 

Freq & Ampl

❏ Is the sweep in continuous mode? If the sweep is in single mode, be sure that you have 

pressed the Single Sweep softkey at least once since completion of the prior sweep. Try 

setting the mode to continuous to determine if the missing single sweep is blocking the 

sweep.

❏ Is the signal generator receiving the appropriate sweep trigger? Try setting the Sweep 
Trigger key to Free Run to determine if a missing sweep trigger is blocking the sweep.

❏ Is the signal generator receiving the appropriate point trigger? Try setting the Point Trigger 
key to Free Run to determine if a missing point trigger is blocking the sweep.

❏ Is the dwell time reasonable? Try setting the dwell time to one second to determine if you 

had set the dwell time to a value which was too slow or too fast for you to see.

❏ Do you have at least two points in your step sweep or list sweep?

Cannot Turn Off Sweep Mode

Press Sweep/List > Sweep > Off.

In the sweep mode menu you can choose to set the sweep to various sweep types or to turn 

sweep off.
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Incorrect List Sweep Dwell Time

If the signal generator does not dwell for the correct period of time at each sweep list point, do 

the following:

1. Press Sweep/List > Configure List Sweep.

This displays the sweep list values.

2. Check the sweep list dwell values for accuracy.

3. Edit the dwell values if they are incorrect.

NOTE The effective dwell time at the RF OUTPUT connector is the sum of the value 

set for the dwell plus processing time, attenuator switching time, and settling 

time. This additional time added to the dwell is generally a few milliseconds. 

The TTL output, however, available at the TRIGGER OUT connector, is 

asserted high only during the actual dwell time.

If the list dwell values are correct, continue to the next step.

4. Observe if the Dwell Type List Step softkey is set to Step.

When Step is selected, the signal generator will sweep the list points using the dwell time 

set for step sweep rather than the sweep list dwell values.

To view the step sweep dwell time, follow these steps:

a. Press Configure Step Sweep.

b. Observe the value set for the Step Dwell softkey.

Recalled a Register and Sweep List is Missing

List sweep information is not stored as part of the instrument state in an instrument state 

register. Only the current list sweep is available to the signal generator. List sweep data can 

be stored to the instrument catalog. For instructions, see “Storing Files” on page 45.
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All of the Registers Where You Previously Stored Instrument States 

are Empty

The save/recall registers are backed-up by a battery when line power to the signal generator 

is not connected. The battery may need to be replaced. 

To verify that the battery has failed, do the following:

1. Turn off line power to the signal generator.

2. Unplug the signal generator from line power.

3. Plug in the signal generator.

4. Turn on the signal generator.

5. Observe the display for error messages.

If either error message −311 or −700 is stored in the error message queue, the signal 

generator’s battery has failed. 

6. Refer to the service guide for battery replacement instructions.

Saved an Instrument State in a Register but the Register is Empty or 

Contains the Wrong State

If you have, intentionally or unintentionally, selected a register number that is greater than 

99, the signal generator will automatically select register 99 to save your instrument state.

If the register number you intended to use is empty or contains the wrong instrument state, 

do the following:

Press Recall > 99 > Enter.

This recalls register 99. The lost instrument state may be saved there.

The Power Supply has Shut Down

If the power supply is not working, it requires repair or replacement. There is no 

user-replaceable power supply fuse. Refer to the service guide for instructions.
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Signal Generator is Locked Up

If your signal generator is locked up, try the following suggestions for resolution:

• Make sure that the signal generator is not in remote mode. (In remote mode, the R 

annunciator will be displayed.) Press Local to exit remote mode and unlock the front panel 

keypad.

• Make certain that the signal generator is not in a local lockout condition.

• Check for a progress bar on the signal generator display which indicates that an operation 

is in progress.

• Try an instrument preset.

• Try cycling power.

Fail-Safe Recovery Sequence

If none of the previous suggestions resolves the problem, you can try the fail-safe recovery 

sequence. This sequence should only be used as a last resort.

This process will reset the signal generator, but the process will destroy the following types of 

data:

• all user files (instrument state and data files) 

• DCFM/DCΦM calibration data

• the persistent state

Do not attempt to perform any other front panel or remote operations during the fail-safe 

sequence. 

To run the fail-safe sequence, follow these steps:

1. Hold down the Preset key while cycling power. 

2. Continue to hold down the Preset key until the following message is displayed:

WARNING! You are entering the diagnostics menu which can cause 
unpredictable instrument behavior. Are you sure you want to continue?

CAUTION Carefully read the entire message! It may list additional risks with the 

procedure beyond the risks documented here.

3. Release the Preset key.
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4. Press Continue to continue with the sequence (or Abort to abort with no lost files).

At the conclusion of the sequence, perform the following steps:

1. Cycle power once again. 

Cycling power restores all previously installed options. You should expect to see several 

error messages resulting from calibration files being restored from EEPROM.

2. Perform the DCFM/DCΦM calibration. 

Refer to the DCFM/DCΦM Cal softkey description in Chapter 5, “Key Reference,” in this 

manual.

3. Agilent Technologies is interested in the circumstances that caused you to have to initiate 

this procedure. Please contact us at the appropriate telephone number listed in Table 4-1. 

We would like to help you eliminate any repeat occurrences.
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Upgrading Firmware

The PSG signal generator’s firmware may be upgraded as new firmware is developed and 

released. Subsequent firmware releases may contain new signal generator features and 

functionality not available in previous firmware releases.

Periodically, Agilent Technologies will make this improved PSG signal generator firmware 

available to customers.

To make an inquiry as to the availability of new PSG signal generator firmware releases, 

contact Agilent on the Internet at www.agilent.com/find/assist or call the appropriate 

number listed in Table 4-1 on page 89.
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Returning a Signal Generator to Agilent Technologies

To return your signal generator to Agilent Technologies for servicing, follow these steps:

1. Be prepared to give your service representative as much information as possible regarding 

the signal generator’s problem. 

2. Call the phone number listed in Table 4-1 appropriate to the signal generator’s location. 

After sharing information regarding the signal generator and its condition, you will 

receive information regarding where to ship your instrument for repair.

3. Ship the signal generator in the original factory packaging materials, if they are available. 

If not, use similar packaging to properly protect the instrument. 
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Table 4-1 Contacting Agilent

Online assistance:  www.agilent.com/find/assist

United States

(tel) 1 800 452 4844

Latin America

(tel) (305) 269 7500

(fax) (305) 269 7599

Canada

(tel) 1 877 894 4414

(fax) (905) 282-6495

Europe

(tel) (+31) 20 547 2323

(fax) (+31) 20 547 2390

New Zealand

(tel) 0 800 738 378

(fax) (+64) 4 495 8950

Japan

(tel) (+81) 426 56 7832

(fax) (+81) 426 56 7840

Australia

(tel) 1 800 629 485

(fax) (+61) 3 9210 5947

Asia Call Center Numbers

Country Phone Number Fax Number

Singapore 1-800-375-8100 (65) 836-0252

Malaysia 1-800-828-848 1-800-801664

Philippines (632) 8426802

1-800-16510170 (PLDT 

Subscriber Only)

(632) 8426809

1-800-16510288 (PLDT 

Subscriber Only)

Thailand (088) 226-008 (outside Bangkok)

(662) 661-3999 (within Bangkok)

(66) 1-661-3714

Hong Kong 800-930-871 (852) 2506 9233

Taiwan 0800-047-866 (886) 2 25456723

People’s Republic 

of China

800-810-0189 (preferred)

10800-650-0021

10800-650-0121

India 1-600-11-2929 000-800-650-1101
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# Points

Supported   All

This softkey enables you to define the number of points in a step sweep. When you press 

this key, the current value is shown in the active entry area. 

Preset  2

Range  2−1601

Location  Page  233, Page  245

Remarks  None

ΦM Dev

Supported    PSG-A Series

This softkey enables you to set the deviation of the phase modulation for the currently 

selected modulation path. 

Preset  0.000 rad

Choices pi rad rad deg

Ranges Frequency Normal Bandwidth High Bandwidth

100 kHz−250 MHz 0–10 RAD 0–1 RAD

> 250−500 MHz 0–5 RAD 0–0.5 RAD 

> 500 MHz−1 GHz 0–10 RAD 0–1 RAD

> 1−2 GHz 0–20 RAD 0–2 RAD

> 2−3.2 GHz 0–40 RAD 0–4 RAD

> 3.2−10 GHz 0–80 RAD 0–8 RAD

> 10−20 GHz 0–160 RAD 0–16 RAD

> 20−40 GHz 0–320 RAD 0–32 RAD

Location Page  237, Page  238

Remarks The deviation limits are dependent upon the carrier frequency. 

This limiting occurs only when the modulation is turned on.
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ΦM Dev Couple

Supported   PSG-A Series

This softkey toggles the operating state of the coupled deviation for phase modulation.

Preset  Off

Choices  Off or On

Location  Page  237

Remarks  If the modulation values are coupled, any change made to the 

modulation value for one standard path is applied to both standard 

paths.

ΦM Off On

Supported   

PSG-A Series

This softkey toggles the phase modulation off or on for the currently selected modulation 

path.

When phase modulation is on, the Φ annunciator is displayed.

Preset  Off

Choices  Off or On

Location  Page  237

Remarks  None
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ΦM Path 1 2 

Supported   

PSG-A Series

This softkey toggles the selection between ΦM Path 1 and ΦM Path 2. ΦM Path 1 and 

ΦM Path 2 define two standard phase modulation configurations which can be used 

together. Configure the modulation characteristics (such as deviation, source, rate, and 

waveform) using the remaining keys in the ΦM menu. Then enable ΦM by setting 

ΦM Off On to On.

ΦM Path 1 and ΦM Path 2 are summed internally for composite modulation. Either path 

can be switched to any one of the modulation sources: Internal 1, Internal 2, Ext1, or 

Ext2.

Preset  1

Choices  1 or 2

Location  Page  237

Remarks  ΦM Path 2 must be set to a deviation less than ΦM Path 1.

ΦM Rate

Supported   

PSG-A Series

This softkey enables you to change the frequency of the currently selected phase 

modulation.

Preset  400.0 Hz

Range  0.5 Hz−1.0 MHz (Sine)

0.5 Hz−100 kHz (other waveforms)

Location  Page  237

Remarks  None
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ΦM Source

Supported   

PSG-A Series

Use this softkey to access a menu of choices that enables you to select either an 

internally generated or an externally applied modulation input for the phase modulation 

source. The internal modulation is always ac-coupled. For externally applied signals, you 

can choose between ac- and dc-coupled modulation.

ΦM Start Rate

Supported   

PSG-A Series

This softkey enables you to change the starting frequency of the internally generated 

modulation source for swept-sine phase modulation. 

Preset  400.0 Hz

Range   0.5 Hz−1 MHz (minimum increment allowed is 0.5 Hz)

Location  Page  238

Remarks  This softkey is coupled to the ΦM Rate softkey in the initial AM menu 

and the ΦM Tone 1 Rate softkey in the ΦM Dual-Sine menu. Any value 

set for ΦM Start Rate is reflected in the ΦM Rate and ΦM Tone 1 Rate 

softkeys.

Preset  Internal 1

Choices Internal 1 Internal 2 Ext1 Ext2

Location Page  237

Remarks A 1.0 volt peak voltage input is required for calibrated ΦM deviation 

settings. The EXT 1 LO/HI and EXT 2 LO/HI display annunciators will 

turn on if the peak input voltage differs from 1.0 by more than 3%. 

(The LO/HI annunciators function only for ac-coupled external inputs.)
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ΦM Stop Rate

Supported   

PSG-A Series

This softkey enables you to change the ending frequency of the internally generated 

modulation source for swept-sine phase modulation. 

Preset   400.0 Hz

Range   1 Hz−1 MHz (minimum increment allowed is 1 Hz)

Location  Page  238

Remarks  This softkey is coupled to the ΦM Tone 2 Rate softkey in the ΦM 

Dual-Sine menu. Any value set for ΦM Stop Rate is reflected in the ΦM 
Tone 2 Rate softkey.

ΦM Sweep Rate

Supported   

PSG-A Series

This softkey enables you to set the sweep rate for swept-sine phase modulation. 

Preset  400.0 Hz

Range  1 Hz−100.0 kHz

Location  Page  238

Remarks  N/A 
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ΦM Sweep Trigger

Supported   

PSG-A Series

Use this softkey to access a menu of choices that enables you to select the triggering 

mode for the swept-sine phase modulation. 

ΦM Tone 1 Rate

Supported   

PSG-A Series

This softkey enables you to set the internal modulation frequency for the phase 

modulation tone 1 rate of the dual-sine waveform. 

Preset  400.0 Hz

Range   0.5 Hz−1.0 MHz (minimum increment is 0.5 Hz)

Location  Page  238

Remarks  This key is coupled to the ΦM Rate softkey in the initial ΦM menu and 

the ΦM Start Rate softkey in the ΦM swept-sine menu. Any value set for 

ΦM Tone 1 Rate is reflected in the ΦM Rate and ΦM Start Rate softkeys.

Preset  Free Run

Choices Free Run Trigger Key Bus Ext

Location Page  238

Remarks You can also configure the polarity of the TTL signal output at the 

TRIGGER IN connector using the Trigger In Polarity Neg Pos softkey on 

this menu. Refer to “Trigger In Polarity Neg Pos” on page 222.
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ΦM Tone 2 Ampl Percent Of Peak

Supported  PSG-A Series

This softkey enables you to adjust the amplitude of the alternate frequency as a 

percentage of the peak LF analog modulation amplitude. For example, if the tone 2 

amplitude is set to 30.0% of the total amplitude, then the primary frequency is 70.0% of 

the total amplitude.

Default  50.0%

Range  0.1%−99.9%

Location  Page  238

Remarks  This is applicable for the dual-sine function only.

ΦM Tone 2 Rate

Supported  PSG-A Series

This softkey enables you to set the internal modulation frequency for the phase 

modulation tone 2 rate of the dual-sine waveform. 

Default  400.0 Hz

Range  0.5 Hz−1.0 MHz (minimum increment is 0.5 Hz)

Location  Page  238

Remarks  This key is coupled to the ΦM Stop Rate softkey in the ΦM swept-sine 

menu. Any value set for ΦM Tone 2 Rate is reflected in the ΦM Stop Rate 

softkey.
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ΦM Waveform

Supported  PSG-A Series

Use this softkey to access a menu of choices that enables you to select the waveform of 

the internally generated source for phase modulation.

Remarks  Dual-Sine and Swept-Sine are not available for the Internal 2 source.

Preset  Sine

Choices Sine Noise Triangle Square

Dual-Sine Ramp Swept-Sine

Location Page  237
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Numerics

1 kHz

Supported   All

This softkey enables you to select an automatic leveling control bandwidth of 1.0 kHz.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 

10 kHz

Supported   All

This softkey enables you to select an automatic leveling control bandwidth of 10.0 kHz.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 

100 Hz

Supported   All

This softkey enables you to select an automatic leveling control bandwidth of 100.0 Hz.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 
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100 kHz

Supported   All

This softkey enables you to select an automatic leveling control bandwidth of 100.0 kHz.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 

125 Hz

Supported   PSG-A Series with Option UNJ

This softkey enables you to select an internal or external reference oscillator bandwidth 

of 125 Hz.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 

25 Hz

Supported  PSG-A Series with Option UNJ

This softkey enables you to select an internal or external reference oscillator bandwidth 

of 25 Hz.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 
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55 Hz

Supported  PSG-A Series with Option UNJ

This softkey enables you to select an internal or external reference oscillator bandwidth 

of 55 Hz.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 

300

Supported   All

This softkey selects 300 as the baud rate in bits per seconds for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 

300 Hz

Supported   PSG-A Series with Option UNJ

This softkey enables you to select an internal or external reference oscillator bandwidth 

of 300 Hz.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 
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1200

Supported   All

This softkey selects 1200 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 

2400

Supported   All

This softkey selects 2400 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 

4800

Supported   All

This softkey selects 4800 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 
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650 Hz

Supported  PSG-A Series with Option UNJ

This softkey enables you to select an internal or external reference oscillator bandwidth 

of 650 Hz.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 

9600

Supported   All

This softkey selects 9600 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 

19200

Supported   All

This softkey selects 19200 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle.
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38400

Supported   All

This softkey selects 38400 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle. 

57600

Supported   All

This softkey selects 57600 as the baud rate in bits per second for the rear panel RS-232 

connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  The baud rate is not affected by a preset or by a power cycle.

www.valuetronics.com



Key Reference

A

Chapter 5106

A

Abort 

Supported   All

Use this softkey to stop the selected test.

Preset  N/A

Range  Ν/Α

Location  Page  250

Remarks  None

Abort Cal

Supported   All

Use this softkey to stop the calibration routine.

Preset  N/A

Range  Ν/Α

Location  Page  233

Remarks  None

Add Comment To Seq[n] Reg[nn]

Supported   All

This softkey enables you to add a comment that is associated with a register in use. The 

register number is listed in the text area of the display and the comment is shown 

immediately following the register. 

Preset  N/A

Range  Ν/Α

Location  Page  244

Remarks  The comment line is limited to 55 alpha-numeric and special 

characters.
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Adjust Phase

Supported   All

This softkey enables you to change the phase of the RF output signal. The change is 

relative to whatever phase the signal generator locked to the last time a frequency 

change was performed. For this reason, the phase adjustment does not survive changes 

in frequency and must be readjusted. If you first press Phase Ref Set, the current output 

phase is set as a zero reference and any subsequent phase adjustment is displayed as 

relative to the zero reference. 

Preset  0.000 radians

Range  ±3.141 radians or ±180 degrees

Location  Page  239

Remarks  Phase adjustment cannot be used with frequency or phase modulation. 

Adjustments to phase can be made in 0.1 degree increments.

ALC BW

Supported   All

Use this softkey to access a menu of choices that enables you to select the bandwidth of 

the automatic leveling control (ALC) loop.

Remarks  A wider bandwidth will give faster settling time. A narrower 

bandwidth improves residual AM noise.

Preset  Auto

Choices Auto 100 Hz 1 kHz 10 kHz

100 kHz

Location Page  232
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ALC Off On

Supported   All

This softkey toggles the operating state of the automatic leveling control (ALC) circuit.

The RF output power of the signal generator is constantly monitored and controlled by 

the ALC circuit. Its purpose is to hold output power at the desired level in spite of drift 

due to temperature and time.

Preset  On

Range  Off or On

Location  Page  232

Remarks  An alternative to setting the ALC off is to set the ALC to a narrow 

bandwidth. ALC off is used for pulse widths less than 1.0 usec.

All

Supported   All

This softkey enables you to specify that all file types in the user file system be listed.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

AM

Supported  PSG-A Series

Use this hardkey to access a menu of choices that enables you to configure the amplitude 

modulation type, path, depth and depth coupling, rate, source, mode, and waveform. 

Preset  N/A

Range  N/A

Location  Page  230

Remarks  None 
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AM Depth

Supported  PSG-A Series

This softkey enables you to set the amplitude modulation depth, in percent, for the 

currently selected modulation path. 

Preset  0.1%

Range  0.1−100.0% (minimum increment allowed is 0.1%)

Location  Page  230

Remarks  The new value of AM depth applies only to whichever AM path 

configuration you have currently selected.

AM Depth Couple Off On

Supported  PSG-A Series

This softkey toggles the operating state of the AM depth coupling. AM depth coupling 

links the AM depth values of AM Path 1 and AM Path 2. 

Preset  Off

Choices  Off or On

Location  Page  230

Remarks  When the values are coupled, any change you make to one AM depth 

value is applied to both.

This softkey is not active when EXP is the selected AM type.

AM Mode Normal Deep

Supported  PSG-A Series

This softkey toggles the amplitude modulation mode between normal and deep. Normal 

mode maintains the amplitude modulation standard behavior. Deep mode provides an 

amplitude modulation depth with greater dynamic range when the ALC enabled.

Preset  Normal

Choices  Normal or Deep

Location  Page  230

Remarks  Deep AM is used for depths > 20 dB when the modulation rate is > 1.0 

Hz. This mode is limited to repetitive AM and will not work with a dc 

modulation signal.
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AM Off On

Supported  PSG-A Series

This softkey toggles the operating state of the amplitude modulation for whichever AM 

path configuration you have selected. 

There are two paths for amplitude modulation which can be simultaneously enabled as 

long as they use different sources (Internal 1, Internal 2, Ext1, or Ext2). The modulation 

signals from both paths are summed internally for composite modulation.When 

amplitude modulation is on, the ΑΜ annunciator is turned on in the display.

Preset  Off

Choices  Off or On

Location  Page  230

Remarks  Although you can enable amplitude modulation with this key, the RF 

carrier is modulated by the enabled modulation only when you have 

also set Mod On/Off to On.

AM Path 1 2 

Supported   PSG-A Series

This softkey enables you to select an amplitude modulation path. AM Path 1 and 2 

define two standard amplitude modulation configurations which can be used together. 

AM Path 1 and AM Path 2 are summed internally for composite modulation. Either path 

can be switched to any one of the modulation sources: Internal 1, Internal 2, Ext1, or 

Ext2. All modulation types can be simultaneously enabled, except FM with ΦM. AM, 

FM, and ΦM can sum simultaneous inputs from any two sources. Any given source can 

only be routed to one activated modulation type.

Preset  AM Path 1

Choices AM Path 1 AM Path 2

Location Page  230

Remarks The RF carrier is available at the RF OUTPUT connector when you 

set RF On/Off to On. Set Mod On/Off to On to modulate the RF carrier 

with the modulations that you have enabled.
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AM Rate

Supported  PSG-A Series

This softkey enables you to change the frequency for the internally generated 

modulation source.

Preset  400.0 Hz

Range  0.5 Hz−100.0 kHz (minimum increment allowed is 0.5 Hz)

0.5 Hz−1.0 MHz if sinewave is selected as the internal waveform

Location  Page  230

Remarks  The new value of AM rate applies only to the AM configuration you 

have currently selected.

AM Source

Supported  PSG-A Series

Use this softkey to access a menu of choices that enables you to select either an 

internally generated or an externally applied source for amplitude modulation. The 

internal modulation is always ac-coupled.

Preset  Internal 1

Choices Internal 1 Internal 2 Ext1 Ext2

Location Page  230

Remarks A 1.0 volt peak voltage input is required for calibrated AM depth 

settings. The EXT 1 LO/HI and EXT 2 LO/HI display annunciators will 

turn on if the peak input voltage differs from 1.0 by more than 3%. 

(The LO/HI annunciators only function for ac-coupled external inputs.)
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AM Start Rate

Supported  PSG-A Series

This softkey enables you to change the starting frequency of the internally generated 

modulation source for swept-sine amplitude modulation. 

Preset  400.0 Hz

Range   1.0 Hz−1.0 MHz (minimum increment allowed is 1.0 Hz)

Location  Page  231

Remarks  This softkey is coupled to the AM Rate softkey in the initial AM menu 

and the AM Tone 1 Rate softkey in the AM Dual-Sine menu. Any value 

set for AM Start Rate is reflected in the AM Rate and AM Tone 1 Rate 

softkeys.

AM Stop Rate

Supported  PSG-A Series

This softkey enables you to change the ending frequency of the internally generated 

modulation source for swept-sine amplitude modulation. 

Preset   400.0 Hz

Range   1.0 Hz−1.0 MHz (minimum increment allowed is 0.1 Hz)

Location  Page  231

Remarks  This softkey is coupled to the AM Tone 2 Rate softkey in the AM 

Dual-Sine menu. Any value set for AM Stop Rate is reflected in the AM 
Tone 2 Rate softkey.

AM Sweep Rate

Supported  PSG-A Series

This softkey enables you to set the sweep rate for swept-sine amplitude modulation. 

Preset  400.0 Hz

Range  0.1 Hz−100.0 kHz

Location  Page  231

Remarks  N/A 
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AM Sweep Trigger

Supported  PSG-A Series

Use this softkey to access a menu of choices that enables you to select the triggering 

mode for the swept-sine amplitude modulation. 

AM Tone 1 Rate

Supported  PSG-A Series

This softkey enables you to set the internal modulation frequency for the AM tone 1 of 

the dual-sine AM waveform. 

Preset   400.0 Hz

Range   0.5 Hz−1.0 MHz (minimum increment allowed is 0.5 Hz)

Location  Page  231

Remarks  This softkey is coupled to the AM Rate softkey in the AM menu and the 

AM Start Rate softkey in the AM Dual-Sine menu. Any value set for 

AM Tone 1 Rate is reflected in the AM Rate and AM Start Rate softkeys.

AM Tone 2 Ampl Percent Of Peak

Supported  PSG-A Series

This softkey enables you to adjust the amplitude of the alternate frequency as a 

percentage of the total amplitude. For example, if the tone 2 amplitude is set to 30% of 

the total amplitude, then the primary frequency is 70% of the total amplitude.

Preset  50.0%

Range  0.1%−99.9%

Location  Page  231

Remarks  This is applicable for the dual-sine function only.

Preset  Free Run

Choices Free Run Trigger Key Bus Ext

Location Page  231

Remarks You can also configure the polarity of the TTL signal output at the 

TRIGGER OUT connector using the Trigger Out Polarity Neg Pos softkey 

on this menu. Refer to “Trigger Out Polarity Neg Pos” on page 222.
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AM Tone 2 Rate

Supported  PSG-A Series

This softkey enables you to set the internally generated modulation frequency for the 

amplitude modulation tone 2 of the dual-sine AM waveform. 

Preset  400.0 Hz

Range  0.5 Hz−1.0 MHz (minimum increment allowed is 0.5 Hz)

Location  Page  231

Remarks  None 

AM Type Lin Exp

Supported  PSG-A Series

This softkey enables you to set the amplitude modulation type to linear (percent/volt) or 

exponential (dB/volt).

Preset  Lin

Choices  Lin or Exp

Location  Page  230

Remarks  None

AM Waveform

Supported  PSG-A Series

Use this softkey to access a menu of choices that enables you to select an amplitude 

modulation waveform that can be produced by the internal modulation source. 

Preset  Sine

Choices Sine Noise Triangle Square

Dual-Sine Ramp Swept-Sine

Location Page  230

Remarks The waveform selection applies only to whichever AM path 

configuration you have currently selected. Dual-Sine and 

Swept-Sine are available for Internal 1 source only.
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Ampl

Supported   All

This softkey enables you to set the signal generator to sweep amplitude data only. The 

frequency is set at a constant value determined by the Frequency hardkey. 

Preset  N/A

Range  N/A

Location  Page  245

Remarks  You can define a sweep containing both amplitude and frequency 

information and still choose to sweep only amplitude.

Ampl Offset

Supported   All

This softkey enables you to change the value for amplitude offset. An amplitude offset 

changes the value shown in the amplitude area of the display but does not affect the 

output power. For example, if the current output power is 0.0 dBm and you enter an 

amplitude offset of −3.0 dBm, the output power will remain at 0.0 dBm but the display 

will show an amplitude of −3.0 dBm. This feature lets you simulate the power level at a 

test point beyond the RF OUTPUT connector.

An amplitude offset can be entered at any time during normal operation and also when 

you are operating in amplitude reference mode. 

Preset  0.00 dB

Range  −200 dB to 200 dB

Location  Page  232

Remarks  Changes to this value affect the displayed amplitude value only, the 

actual RF output power amplitude is not changed.
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Ampl Ref Off On

Supported   All

This softkey toggles the operating state of the amplitude reference mode. When 

amplitude reference mode is turned on, the amplitude value displayed is equal to the 

current hardware output power minus the reference value set by the Ampl Ref Set 
softkey. All subsequent amplitude parameters are then relative to the reference value.

Amplitude offsets can be used with amplitude reference mode. In this situation, the 

display will show the amplitude calculated as the current hardware output power minus 

the reference value plus the amplitude offset.

Preset  Off

Choices  Off or On

Location  Page  232

Remarks  Amplitude reference mode changes the display only, it does not change 

the RF output power. 

Ampl Ref Set

Supported   All

This softkey enables you to set the current output power as an amplitude reference 

value. It also causes the Ampl Ref Off On key to toggle to the On position, turning on 

amplitude reference mode. All subsequent output power settings are then relative to the 

reference value. 

Preset  0.00 dB

Range  0.00 to −135 dBm

Location  Page  232

Remarks  This key sets the reference value equal to the current output power. If 

you have not yet set the reference value, the normal preset value for 

amplitude reference is 0.0 dBm. 
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Ampl Start

Supported   All

This softkey enables you to set the amplitude of the first point in the sweep. When you 

press Ampl Start, amplitude becomes the active function for the first point in the step 

sweep. 

Preset  −135.00 dBm (for instruments with Option 1E1)

Range  You can set the value anywhere in the range of the signal generator’s 

specified output power.

Location  Page  245

Remarks  None 

Ampl Stop

Supported   All

This softkey enables you to set the amplitude of the last point in the sweep. When you 

press Ampl Stop, amplitude becomes the active function for the last point in the step 

sweep. 

Preset  −135.00 dBm (for instruments with Option 1E1)

Range  You can set the value anywhere in the range of the signal generator’s 

specified output power.

Location  Page  245

Remarks  None
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Amplitude

Supported   All

This hardkey enables you to change the RF output power. In addition, the key accesses a 

menu of choices that enables you to configure the automatic leveling control (ALC), 

power search, user flatness, external detector coupling factor, and amplitude options. 

The current RF output power level is always shown in the amplitude area of the display 

except under the following conditions:

• amplitude reference mode is turned on

• an offset is applied

• a step or list amplitude sweep is in process

The amplitude area of the display is blanked whenever an amplitude sweep is selected.

Preset  −135.00 dBm (for instruments with Option 1E1)

Range  The output power range depends on your signal generator model. For 

more information, refer to the data sheet.

Location  Page  232

Remarks  None

Atten/ALC Control

Supported   All with Option 1E1

Use this softkey to access a menu of keys that enables you to control the attenuator and 

the automatic leveling control (ALC) power level.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None
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Atten Hold Off On

Supported  All with Option 1E1

This softkey toggles the operating state of the attenuator hold function. Turn attenuator 

hold on to freeze the attenuator at its current setting. Use this function at any time you 

want to guarantee that there will be no power discontinuity normally associated with 

the attenuator switching during power adjustments. 

Preset  Off

Choices  Off or On

Location  Page  232

Remarks  There will be no attenuator switching during power adjustments. The 

maximum power adjustment range will vary. However, you will have at 

least +4 dB and at least −13 dB range.

Auto

Supported   All

This softkey sets the state of the automatic leveling control bandwidth capability.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 
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B

Binary

Supported   All

This softkey enables you to specify that only signal generator instrument binary files be 

listed in the catalog of files currently displayed.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

Black Pixels Screen Test

Supported   All

This softkey enables you to set all the pixels on the display to black. Pressing the Local 
hardkey returns the display to normal signal generator operation.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  This key is provided for factory use in testing the display.

Brightness

Supported   All

Use this softkey to adjust the display brightness (intensity). The current value shown in 

the active entry area is a relative value for brightness. Increasing the number increases 

the brightness; decreasing the number decreases the brightness. 

Preset  N/A

Range  1−50

Location  Page  247

Remarks  The brightness intensity is not affected by a preset or by a power cycle.
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Bus

Supported   All

This softkey is one of the choices in both the Sweep Trigger menu and the Point Trigger 

menu. Choosing Bus in the Sweep Trigger menu allows you to trigger a list or step sweep 

using the GPIB. Choosing Bus in the Point Trigger menu allows you to trigger a sweep 

point-by-point using the GPIB.

Preset  N/A

Range  N/A

Location  Page  231, Page  236, Page  241, Page  245

Remarks  None
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C

Catalog Type

Supported   All

Use this softkey to access a menu of choices that enables you to select the catalog type 

for displaying files. When you have made your selection, the display is updated and your 

choice appears below the Catalog Type softkey. 

Clear Error Queue(s)

Supported   All

This softkey enables you to delete all messages that are stored in the error message 

queues. When the error message queue is empty, the ERR annunciator is turned off.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  You cannot recover from this action; once the messages are deleted, 

they are permanently gone. 

Preset  N/A

Choices All

Binary

State List User Flatness

Location Page  249

Remarks Catalog type selection is not affected by a preset or by a power 

cycle.
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Clear Text

Supported   All

Use this softkey to delete all characters and digits in the active entry area. This key is 

especially useful when you want to clear the current entry so you can create a new entry.

Preset  N/A

Range  N/A

Location  Page  234, Page  246, Page  249

Remarks  None

Configure Cal Array

Supported   All

Use this softkey to access a menu of softkeys for defining a user flatness list sweep. Each 

point in this sweep will contain a frequency and amplitude correction pair.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None
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Configure List Sweep

Supported   All

Use this softkey to access a menu of softkeys for defining a list sweep. In this menu you 

can insert and delete points in a sweep. Each point can contain frequency, amplitude, 

and dwell time information. 

NOTE The dwell time does not begin until the signal generator has settled for the 

current frequency and/or amplitude change. When the signal generator 

has settled, a trigger signal is transmitted through the rear panel 

SOURCE SETTLED OUTPUT connector.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None 

Configure Step Array

Supported   All

Use this softkey to access a menu of softkeys that enables you to define a user flatness 

step sweep. In this menu you can set the start frequency, stop frequency, and the number 

of points for the sweep.

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None 
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Configure Step Sweep

Supported   All

Use this softkey to access a menu of softkeys for defining a step sweep. In this menu you 

can set the start and stop frequencies for a sweep, set the start and stop power levels, 

and you can set the number of points in the sweep with the dwell time at each point.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None

Confirm Delete

Supported   All

Use this softkey to continue to delete the selected file.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None 

Confirm Delete Of All files

Supported   All

Use this softkey to confirm that all of the files in the catalog you have selected should be 

deleted. If you do not wish to delete all of the files, press the Return hardkey instead.

Preset  N/A

Range  N/A

Location  Page  251

Remarks  None 
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Confirm Load From Step Sweep

Supported   All

Use this softkey to proceed with setting up a table that includes the start frequency, stop 

frequency, and number of points that are defined in the Configure User Flatness Step 

Array and the Sweep List menus.

Preset  N/A

Range  N/A

Location  Page  233, Page  246

Remarks  None 

Confirm Preset

Supported   All

Use this softkey to confirm that you want the delete the current list and replace it with a 

new list.

Preset  N/A

Range  N/A

Location  Page  233, Page  246

Remarks  None 

Copy File

Supported   All

This softkey enables you to copy and rename a file in the displayed catalog of files. 

When you have entered the new file name, press the Enter terminator softkey. If you 

have changed your mind, press the Return hardkey. Once you press Enter, the new file is 

stored and displayed immediately in the catalog list.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None 
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D

DC

Supported  PSG-A Series

Use this softkey to specify dc as the modulation waveform for the internally generated 

signal.

Preset  N/A

Range  N/A

Location  Page  240

Remarks  This key is only active when you have selected the internal source to 

operate as a function generator. 

DCFM/DCΦM Cal

Supported  PSG-A Series

This softkey enables you to initiate a DCFM or a DCΦΜ calibration, depending upon 

which type of modulation is currently active. This calibration eliminates the offset in 

DCFM or DCΦΜ so that the carrier frequency remains the same with no modulation 

applied. 

NOTE If the calibration is performed with a dc signal applied, any deviation 

provided by the dc signal will be removed and the new zero reference point 

will be at the applied dc level. The calibration will have to be performed 

again when the dc signal is disconnected to reset the carrier signal to the 

correct zero reference.

Preset  N/A

Range  N/A

Location  Page  235, Page  237

Remarks  Use this calibration for externally applied signals. While the 

calibration can also be performed for internally generated signals, dc 

offset is not a normal characteristic for them. 
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Delete All Binary Files

Supported   All

This softkey enables you to delete all binary files in the displayed catalog of files. The 

files will not be deleted until you press the Confirm Delete Of Binary Files. If you change 

your mind and do not want to delete the files, press the Return hardkey before confirming 

the deletion.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None 

Delete All <catalog type> Files

Supported  PSG-A Series

Use this softkey to delete all of the files in the displayed catalog of files of a selected 

catalog type. The files will not be deleted until you press the 

Confirm Delete All <catalog type> Files. If you change your mind and do not want to delete 

the files, press the Return hardkey before confirming the deletion. 

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None
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Delete All Files

Supported   All

Use this softkey to delete all of the files in the displayed catalog of files. The files will not 

be deleted until you press the Confirm Delete All Files. If you change your mind and do not 

want to delete the files, press the Return hardkey before confirming the deletion.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  This key does not affect the instrument state or calibration 

information. If power on mode is set to last, a new last state file will be 

created when the instrument idles.

Delete All List Files

Supported   All

This softkey enables you to delete all list files. The files will not be deleted until you 

press the Confirm Delete Of List Files. If you change your mind and do not want to delete 

the files, press the Return hardkey.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

Delete All Regs in Seq [n]

Supported   All

This softkey enables you to delete the data saved in all of the registers of the selected 

sequence. Do not press this key until you have selected the correct sequence using the 

Select Seq key. 

Preset  N/A

Range  N/A

Location  Page  243, Page  244

Remarks  You cannot recover data after this step. If you change your mind and do 

not wish to delete the data, press the Return hardkey 
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Delete All Sequences

Supported   All

This softkey enables you to delete all of the data in all saved registers of all sequences. 

Preset  N/A

Range  N/A

Location  Page  243, Page  244

Remarks  You cannot recover data after this step. If you change your mind and do 

not wish to delete the data, press the Return hardkey. 

Delete All State Files

Supported   All

This softkey enables you to delete all instrument state files. The files will not be deleted 

until you press the Confirm Delete Of State Files. If you change your mind and do not want 

to delete the files, press the Return hardkey.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

Delete All UFLT Files

Supported   All

This softkey enables you to delete all of the user flatness correction files.The files will 

not be deleted until you press the Confirm Delete Of UFLT Files. If you change your mind 

and do not want to delete the files, press the Return hardkey.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None
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Delete File

Supported   All

This softkey enables you to delete a file in the catalog listing. Use the up and down arrow 

keys until the file you wish to delete is highlighted. Press Delete File and then press the 

Confirm Delete softkey. If you do not want to delete the file, press Return instead of 

Confirm Delete.

Preset  N/A

Range  N/A

Location  Page  234, Page  246, Page  249

Remarks  None 

Delete Item

Supported   All

This softkey enables you to delete an item in the displayed list. Use the arrow keys until 

the desired item is highlighted. Then press Delete Item to eliminate this item from the 

list. If the last item in a list is deleted, it is replaced by the default value.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  You cannot recover the item after this step. If you change your mind 

and do not wish to delete the item, press the Return hardkey.

Delete Row

Supported   All

This softkey enables you to delete a selected row in the list. Use the up and down arrow 

keys until any item is selected in the row you wish to delete. Press Delete Row and the 

entire row is deleted. If the last row in a list is deleted, it is replaced by the default value.

Preset  N/A

Range  N/A

Location  Page  233, Page  245

Remarks  You cannot recover data after this step. If you change your mind and do 

not wish to delete the row, press the Return hardkey. 
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Delete Seq[n] Reg[nn]

Supported   All

Use this softkey to delete the contents of a specified register in a specified sequence. Do 

not press this key until you have selected the correct sequence and register using the 

Select Seq and Select Reg softkeys. 

Preset  N/A

Range  N/A

Location  Page  243, Page  244

Remarks  You cannot recover the data after this step. If you change your mind 

and do not wish to delete the data, press the Return hardkey. 

Diagnostic Info

Supported   All

Use this softkey to access a display of diagnostic information about the signal generator. 

Refer to Figure 5-1 for information about what is included in the display.

Figure 5-1 Diagnostic Instrument Information

Model  the model number of the signal generator

Options  a list of the installed hardware and software options

Serial Number  the factory assigned serial number
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Firmware Revision  the revision number for the signal generator’s 

firmware

IDN Response  the characters returned after a remote *IDN query

Total hours on  the number of hours that the signal generator has 

been powered on

Total hours display has been on  the number of hours the display has been active 

(value does not include hours using the screen saver)

Total power cycles  the number of times the line power has been 

switched on

Attenuator cycles  the number of times the attenuator has been 

switched

Preset  N/A

Range  N/A

Location  Page  250

Remarks  None

Display

Supported   All

Use this softkey to access a menu for adjusting and testing the display. In this menu you 

set up the screen saver, change the display brightness, and perform black and white 

pixel screen tests.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None 
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Do Cal

Supported   All

This softkey enables you to start a flatness calibration using the information from the 

user flatness list sweep table. 

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 

Done

Supported   All

Use this softkey to return to the Flatness menu once the calibration routine is complete.

Preset  N/A

Range  Ν/Α

Location  Page  233

Remarks  None

Do Power Search

Supported   All

Use this softkey to execute the power search calibration routine one time. Power search 

is an internal calibration routine used to achieve calibrated output power when the ALC 

is off. You can execute a power search at any time by pressing this softkey. 

Preset  N/A

Range  N/A

Location  Page  232

Remarks  The routine will execute only if RF is on and ALC is off. 
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Dual-Sine

Supported  PSG-A Series

Use this softkey to access a menu of choices that enables you to set the dual-sine 

amplitude modulation waveform for the internally generated, ac-coupled signal. You can 

set the rates for two separate tones according to modulation type. 

• In the AM menu, you can set the depth for Internal 1, and also set a ratio of the tone 

2 depth to the tone 1 depth. 

• In the FM menu, you can set the deviation for the selected modulation path and also 

set a ratio of the tone 2 FM deviation to the tone 1 FM deviation.

• In the ΦΜ menu, you can set the frequencies for two separate tones.

• In addition you can set a ratio of the tone 2 LF amplitude to the tone 1 LF amplitude.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  None

Dwell Type List Step

Supported   All

This softkey toggles the dwell time for the list sweep points between the values defined 

in the list sweep and the value set for step sweep. Choose List to sweep with dwell times 

that you have defined in the list sweep. Choose Step and you will sweep each point in the 

list with a dwell time set by the Step Dwell softkey in the Configure Step Sweep menu. 

NOTE The dwell time does not begin until the signal generator has settled for the 

current frequency and/or amplitude change. When the signal generator 

has settled, a trigger signal is transmitted through the rear panel 

SOURCE SETTLED OUTPUT connector.

Preset  List

Choices  List or Step

Location  Page  246

Remarks  When you are sweeping using the step sweep dwell time, the list sweep 

dwell time values are grayed out to indicate that they are not being 

used.
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E

E4416A

Supported   All

This softkey enables you to select an Agilent E4416A power meter to perform the 

automated user flatness correction process. 

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None

E4417A

Supported   All

This softkey enables you to select an Agilent E4417A power meter to perform the 

automated user flatness correction process. 

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None

E4418B

Supported   All

This softkey enables you to select an Agilent E4418B power meter to perform the 

automated user flatness correction process. 

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None
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E4419B

Supported   All

This softkey enables you to select an Agilent E4419B power meter to perform the 

automated user flatness correction process. 

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None

Edit Comment In Seq[n] Reg[nn]

Supported   All

This softkey enables you to edit a comment that is associated with a register in use. The 

register number is listed in the text area of the display and the comment is shown 

immediately following the register. 

Preset  N/A

Range  Ν/Α

Location  Page  244

Remarks  This softkeys appears only after a comment has been added to a 

register.

Edit Item

This softkey enables you to change an item in the displayed table or list. 

Supported   All

Preset  N/A

Range  N/A

Location  Page  233, Page  245

Remarks  None
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Editing Keys

Supported   All

Use this softkey to access a menu of choices that enables you to create and edit text. In 

this menu you can delete the existing text in the active entry area, and you can toggle 

the editing mode from inserting text to replacing text.

Preset  N/A

Range  N/A

Location  Page  234, Page  246, Page  249, Page  251

Remarks  None

Editing Mode Insert Replace

Supported   All

This softkey toggles the editing mode between inserting text or replacing text. Insertion 

mode causes text to be entered in the position directly to the right of the cursor. 

Replacement mode causes the text to be entered in the position held by the cursor, 

overwriting any existing text in that position.

Preset  Insert

Choices  Insert or Replace

Location  Page  234, Page  246, Page  249, Page  251

Remarks  None

Error Info

Supported   All

Use this softkey to access a menu of choices that enables you to view and clear error 

messages. In this menu you can view any of the error messages in the queue, and you 

can clear all of the error messages in the queue.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  The error queue will hold up to 30 error messages before deleting the 

oldest error message to make room for the 31st error message.
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Ext

Supported   All

This softkey is one of the choices in the Sweep Trigger, Point Trigger, and AM, FM and 

ΦM Sweep Trigger menus. Your available settings depend on which trigger menu you 

have selected.

• In the Sweep Trigger menu, choosing Ext enables you to trigger a full sweep on either 

the negative or positive edge of a signal applied to the TRIGGER IN rear panel 

connector. 

• In the Point Trigger menu, choosing Ext enables you to trigger a point-by-point sweep 

on either the negative or positive edge of a signal applied to the TRIGGER IN rear 

panel connector.

• In the AM, FM, and ΦM sweep trigger menus, choosing Ext enables you to trigger a 

swept-sine amplitude, frequency, or phase modulation on either the negative or 

positive edge of a signal applied to the TRIGGER IN rear panel connector.

Preset  N/A

Range  N/A

Location  Page  231, Page  236, Page  238, Page  241, Page  245

Remarks  Set the polarity of the trigger signal using the 

Trigger In Polarity Neg Pos softkey. 

Ext Coupling DC AC

Supported   All

Use this key to toggle the coupling for the externally applied modulation input signal 

between dc and ac.

Preset  DC

Choices   DC or AC

Location  Page  230, Page  235, Page  237

Remarks  The command does not change the currently active source or switch 

the current modulation on or off. The modulating signal may be the 

sum of several signals, either internal or external sources.
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Ext Detector

Supported   All

This softkey enables you to select an external diode detector leveling mode. This enables 

you to connect a detector and a coupler or splitter to the RF output and level the RF 

signal at a point external to the RF output connector.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 

Ext Detector Coupling Factor

Supported   All

This softkey enables you to set the external detector coupling factor.

Preset  16.0 dB

Range  −200.0 dB to 200.0 dB

Location  Page  232

Remarks  N/A 

Ext Impedance 50 Ohm 600 Ohm

Supported   All

This softkey toggles the external input impedance between 50 ohms and 600 ohms.

Preset  50 Ohm

Choices   50 Ohm or 600 Ohm

Location  Page  230, Page  235, Page  237

Remarks  None 
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Ext Polarity Normal Inverted

Supported  PSG-A Series

This softkey toggles the external pulse polarity between normal and inverted.

Preset  Normal 

Choices   Normal or Inverted

Location  Page  242

Remarks  N/A 

Ext Pulse

Supported  PSG-A Series

This softkey enables you to activate the pulse modulation mode with an external pulse 

source. 

Preset  N/A

Range  N/A

Location  Page  242

Remarks  N/A 

Ext1

Supported  PSG-A Series

Use this softkey to select an externally applied signal for the modulation waveform once 

you have connected the signal source to the EXT 1 INPUT connector.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237

Remarks  The externally applied, ac-coupled input signal is tested for a voltage 

level and a display annunciator will report a high or low condition if 

that voltage is > ±3% of 1 Vp.
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Ext2

Supported   PSG-A Series

This softkey enables you to select an externally applied signal for the modulation 

waveform once you have connected the signal source to the EXT 2 INPUT connector.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237

Remarks  The externally applied, ac-coupled input signal is tested for a voltage 

level and a display annunciator will report a high or low condition if 

that voltage is > ±3% of 1 Vp.

External Ref Bandwidth

Supported   PSG-A Series with Option UNJ

This softkey enables you to adjust the bandwidth of the external reference oscillator.

Preset  N/A

Choices 25.0 Hz 55.0 Hz 125.0 Hz 300.0 Hz

650.0 Hz

Location Page  248

Remarks None.
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F

Flatness Off On

Supported   All

This softkey toggles the operating state of the application of the user flatness corrections 

to the output power.

Preset  Off

Choices  Off or On

Location  Page  232

Remarks  None 

FM/ΦM

Supported   PSG-A Series

Use this hardkey to access a menu of choices that enables you to configure modulation 

type (FM, normal phase modulation, or wideband phase modulation), path, deviation 

and deviation coupling, source, rate, waveform, and DCFM/DCΦM calibration. 

Preset  N/A

Range  N/A

Location  Page  235

Remarks  None 
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FM ΦM Normal High BW

Supported  PSG-A Series

This softkey toggles between the menus for frequency modulation (FM), normal phase 

modulation (ΦM), and wideband phase modulation (ΦM High BW). 

• Normal ΦM lets you set the phase deviation as high as N x 80 radians with a 3.0 dB 

bandwidth at 100.0 kHz. Refer to Table 5-1 on page 145 for N values. 

• High BW ΦM provides increased bandwidth while restricting the maximum 

deviation to deviation settings up to N x 8 radians. Refer to Table 5-1 for N values.

Preset  FM

Choices FM ΦM Normal ΦM High BW

Location Page  237

Remarks The deviation limits are dependent upon the carrier frequency. This 

limiting occurs only when the modulation is turned on.
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FM Dev

Supported  PSG-A Series

This softkey enables you to set the frequency modulation deviation for the currently 

selected modulation path. The range of values allowed depends on the carrier frequency. 

The maximum peak deviation for a frequency is calculated by multiplying N times 

8.0 MHz. (Table 5-1 lists the values for N and the resulting maximum peak deviations.)

For example, if you choose a carrier frequency of 950 MHz, multiply 1/8 by 8 MHz 

resulting in a 1.0 MHz maximum peak deviation.

Preset  1.0 kHz

Range  N/A

Location  Page  235, Page  236

Remarks  The new value of FM deviation applies only to whichever FM path 

configuration you have currently selected. Also, whenever FM Path 1 

is used with FM Path 2, the deviation for FM Path 1 must be greater 

than or equal to the deviation for FM Path 2

Table 5-1

Carrier Frequency N
Maximum 

Peak Deviation

250 kHz to ≤ 250 MHz 1/8 1.0 MHz

> 250 MHz to ≤ 500 MHz 1/16 0.5 MHz

> 500 MHz to ≤ 1 GHz 1/8 1 MHz

> 1 GHz to ≤ 2 GHz 1/4 2 MHz

> 2 GHz to 3.2 GHz 1/2 4 MHz

> 3.2 GHz to 10 GHz 1 8 MHz

> 10 GHz to 20 GHz 2 16 MHz

> 20 GHz to 40 GHz 4 32 MHz
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FM Dev Couple Off On

Supported  PSG-A Series

This softkey toggles the operating state of the frequency modulation deviation coupling. 

Turning on FM deviation coupling links the FM deviation values of FM Path 1 and 

FM Path 2. 

Preset  Off

Choices  Off or On

Location  Page  235

Remarks  When the values are coupled, any change you make to one FM 

deviation value is applied to both.

FM Off On

Supported  PSG-A Series

This softkey toggles the operating state of the currently selected frequency modulation. 

Whenever frequency modulation is enabled, the FM annunciator is turned on in the 

display.

Preset  Off

Choices  Off or On

Location  Page  235

Remarks  Although you can turn on frequency modulation with this key, the RF 

carrier is modulated by the enabled modulation only when you have 

also set Mod On/Off to On.
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FM Path 1 2

Supported   PSG-A Series

Use this softkey to select FM Path 1 or FM Path 2. FM Path 1 and FM Path 2 define two 

standard frequency modulation configurations which can be used together. Configure the 

modulation characteristics (such as deviation, source, rate, and waveform) using the 

remaining softkeys in the FM menu. Then enable FM by setting FM Off On to On.

FM Path 1 and FM Path 2 are summed internally for composite modulation. Either path 

can be switched to any one of the modulation sources: Internal 1, Internal 2, Ext1, or 

Ext2. 

Preset  FM Path 1

Choices  FM Path 1 or FM Path 2

Location  Page  235

Remarks  FM Path 2 is limited to a maximum rate of 1 MHz. FM Path 2 must be 

set to a deviation less than FM Path 1.

FM Rate

Supported   PSG-A Series

This softkey enables you to change the internal modulation frequency for the FM Path 1 

and FM Path 2 configurations. 

Preset  Off

Range  0.5 Hz−100.0 kHz (minimum increment is 0.5 Hz)

0.5 Hz−1.0 MHz (if sinewave is selected as the internal waveform)

Location  Page  235

Remarks  The new value of FM rate applies only to whichever FM path 

configuration you have currently selected.
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FM Source

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select an internally 

generated or externally applied modulation input for the frequency modulation source. 

The internal modulation is always ac-coupled. For externally applied signals, you can 

choose between ac- and dc-coupled modulation.

FM Start Rate

Supported   PSG-A Series

This softkey enables you to change the starting frequency of the internally generated 

modulation source for swept-sine frequency modulation. 

Preset  400.0 Hz

Range   1.0 Hz−1.0 MHz (minimum increment is 1.0 Hz)

Location  Page  236

Remarks  This key is coupled to the FM Rate softkey in the initial FM menu and 

the FM Tone 1 Rate softkey in the FM dual-sine menu. Any value set for 

FM Start Rate is reflected in the FM Rate and FM Tone 1 Rate softkeys.

Preset  Internal 1

Choices Internal 1 Internal 2 Ext1 Ext2

Location Page  235

Remarks A 1.0 peak voltage input is required for calibrated FM deviation 

settings. The EXT 1 LO/HI and EXT 2 LO/HI display annunciators 

will turn on if the peak input voltage differs from 1.0 volt by more 

than 3.0%. (The LO/HI annunciators only function for ac-coupled 

external inputs.)
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FM Stop Rate

Supported   PSG-A Series

This softkey enables you to change the ending frequency of the internally generated 

modulation source for swept-sine frequency modulation. 

Preset  400.0 Hz

Range   1.0 Hz−1.0 MHz (minimum increment is 1.0 Hz)

Location  Page  236

Remarks  This key is coupled to the FM Tone 2 Rate softkey in the FM dual-sine 

menu. Any value set for FM Stop Rate is reflected in the FM Tone 2 Rate 

softkey.

FM Sweep Rate

Supported   PSG-A Series

This softkey enables you to set the sweep rate for swept-sine frequency modulation. 

Preset  400.0 Hz

Range   0.5 Hz−100.0 kHz

Location  Page  236

Remarks  N/A 

FM Sweep Trigger

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select the triggering 

mode for the swept-sine frequency modulation. 

Preset  Free Run

Choices Free Run Trigger Key Bus Ext

Location Page  236

Remarks You can also configure the polarity of the TTL signal output at 

the TRIGGER IN connector using the Trigger In Polarity Neg Pos 

softkey on this menu. Refer to “Trigger In Polarity Neg Pos” on 

page 222.
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FM Tone 1 Rate

Supported   PSG-A Series

This softkey enables you to set the internal modulation frequency for the FM tone 1 rate 

of the dual-sine FM waveform. 

Preset  400.0 Hz

Range   0.5 Hz−1.0 MHz (minimum increment is 0.5 Hz)

Location  Page  236

Remarks  This key is coupled to the FM Rate softkey in the initial FM menu and 

the FM Start Rate softkey in the FM swept-sine menu. Any value set for 

FM Tone 1 Rate is reflected in the FM Rate and FM Start Rate softkeys.

FM Tone 2 Ampl Percent Of Peak

Supported   PSG-A Series

This softkey enables you to adjust the amplitude of the alternate frequency as a 

percentage of the peak analog modulation amplitude. For example, if the tone 2 

amplitude is set to 30.0% of the total amplitude, then the primary frequency is 70.0% of 

the total amplitude.

Default  50.0%

Range  0.1%−99.9%

Location  Page  236

Remarks  This is applicable only for the dual-sine function.

FM Tone 2 Rate

Supported   PSG-A Series

This softkey enables you to set the internal modulation frequency for the FM tone 2 of 

the dual-sine FM waveform. 

Default  400.0 Hz

Range  0.5 Hz−1.0 MHz (minimum increment is 0.5 Hz)

Location  Page  236

Remarks  This key is coupled to the FM Stop Rate softkey in the FM swept-sine 

menu. Any value set for FM Tone 2 Rate is reflected in the FM Stop Rate 

softkey.
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FM Waveform

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select the frequency 

modulation waveform that can be produced by the internal modulation source. 

Free Run

Supported   All

This softkey is one of the choices in both the Sweep Trigger menu and the Point Trigger 

menu. Choosing Free Run in the Sweep Trigger menu immediately triggers the current 

sweep when you press the Single Sweep softkey. When sweep repeat is continuous and 

Free Run is chosen for the sweep trigger, then sweeps are triggered consecutively (a new 

sweep is triggered as soon as the current sweep ends). Choosing Free Run in the Point 

Trigger menu causes the sweep to pause for the dwell time at each point after the 

hardware has been set up for that point’s frequency and amplitude.

Preset  N/A

Range  N/A

Location  Page  231, Page  236, Page  238, Page  241, Page  245

Remarks  To stop the sweep, choose a different trigger such as Ext, or set the 

waveform to something other than Swept-Sine.

Preset  Sine

Choices Sine Noise Triangle Square

Dual-Sine Ramp Swept-Sine

Location Page  235

Remarks The waveform selection applies only to whichever FM path 

configuration you have currently selected. Dual-Sine and Swept-Sine 

are available with Internal 1 only.
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Freq

Supported   All

This softkey enables you to set the signal generator to sweep frequency data only. The 

amplitude is set at a constant level determined by the Amplitude hardkey. You can define 

a sweep containing both amplitude and frequency information and still choose to sweep 

frequency only.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None 

Freq Multiplier

Supported   All

This softkey enables you to multiply the frequency shown on the display without 

changing the frequency output at the RF OUTPUT connector (simulating the frequency 

at the output of a harmonic multiplier). 

For any multiplier other than 1, the MULT indicator is shown in the frequency area of the 

display.

Preset  1

Range  −100 to +1000 (excluding 0)

Location  Page  239

Remarks  The displayed frequency value is equal to the actual frequency, minus 

the reference frequency, times the multiplier, plus the offset frequency. 
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Freq Offset

Supported   All

This softkey enables you to set a value for frequency offset. For example, if the current 

output frequency is 1.0 MHz and you enter a frequency offset of 3.0 MHz, the output 

frequency will remain at 1.0 MHz but the display will show a frequency of 4.0 MHz. This 

feature enables you to simulate the frequency at the output of a frequency translating 

device. When an offset has been entered, the OFFSET indicator is turned on in the 

frequency area of the display.

Preset  0.00 Hz

Range  20 GHz Models: 0HZ–20GHZ

40 GHz Models: 0HZ–40GHZ

Location  Page  239

Remarks  A frequency offset can be entered at any time during normal operation 

and also when you are operating in frequency reference mode. When 

and offset has been entered, the OFFS indicator is turned on in the 

frequency area of the display.

A frequency offset changes the value shown in the frequency area of 

the display but does not affect the output frequency.

Freq Ref Off On

Supported   All

This softkey toggles the operating state of the frequency reference mode. When 

frequency reference mode is turned on, the frequency value displayed is equal to the 

current hardware output frequency minus the reference value set by the Freq Ref Set 
softkey. All frequency parameters will now be set as relative to the reference value.

Frequency offsets can be used with frequency reference mode. In this situation, the 

display will show the frequency calculated as the current hardware output frequency 

minus the reference value plus the frequency offset.

Preset  Off

Choices  Off or On

Location  Page  239

Remarks  Frequency reference mode only changes the display; it does not change 

the RF output frequency. 

www.valuetronics.com



Key Reference

F

Chapter 5154

Freq Ref Set

Supported   All

Use this softkey to set the current output frequency plus the offset frequency as the 

frequency reference value. It also causes the Freq Ref Off On softkey to toggle to the On 

position, turning on frequency reference mode. All frequency parameters are then set as 

relative to the reference value.

Preset  0.00 Hz

Range  100 kHz−highest frequency

Location  Page  239

Remarks  None

Freq Start

Supported   All

This softkey enables you to set the frequency of the first point in the sweep. 

Preset  Maximum frequency

Range  100 kHz−highest frequency

Location  Page  233, Page  245

Remarks  None

Freq Stop

Supported   All

This softkey enables you to set the frequency of the last point in the sweep. 

Preset  Maximum frequency

Range  100 kHz−highest frequency

Location  Page  233, Page  245

Remarks  None
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Freq & Ampl

Supported   All

Use this softkey to set the signal generator to sweep both frequency and amplitude data.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  Both the frequency and the amplitude lists must have the same 

number of points or one must have only one point. If a list has only one 

point, then that point is used for each of the other list’s points.

Frequency

Supported   All

This hardkey enables you to change the RF output frequency. In addition, the key 

accesses a menu of softkeys that enables you to configure the reference frequency and 

the phase, and specify the oscillator source. 

Preset  20.0 GHz or 40.00 GHz (depends on the signal generator)

Range  The output frequency range allowed depends on your signal generator 

model. Refer to the data sheet.

Location  Page  239

Remarks  None

Function Generator 1

Supported   PSG-A Series

This softkey enables you to select the internal source 1 as a function generator. 

Preset  N/A

Range  N/A

Location  Page  240

Remarks  When you use the internal source in this capacity, any modulation with 

the internal source selected is turned off. 
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Function Generator 2

Supported   PSG-A Series

This softkey enables you to select internal source 2 as a function generator. 

Preset  N/A

Range  N/A

Location  Page  240

Remarks  When you use the internal source in this capacity, any modulation with 

the internal source selected is turned off. 
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G

Gaussian

Supported   PSG-A Series

This softkey enables you specify noise with a Gaussian distribution as the modulation 

waveform for the internally generated, ac-coupled signal. 

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  None

Goto Bottom Row

Supported   All

This softkey enables you to move the selection bar to the last row in the table.

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 

Goto Middle Row

Supported   All

This softkey enables you to move the selection bar to the middle row of the list.

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 
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Goto Row

Supported   All

Use this softkey to access a menu of softkeys that enables you to move the selection bar 

to a specific row in the list. 

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 

Goto Top Row

Supported   All

This softkey enables you to move the selection bar to the top row in the list.

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 

GPIB Address

Supported   All

This softkey enables you to change the signal generator’s GPIB address. The GPIB 

address is set to 19 at the factory. 

Preset  N/A

Range  0−30

Location  Page  247

Remarks  The GPIB address setting is not affected by a preset or by a power 

cycle.

www.valuetronics.com



Key Reference

G

Chapter 5 159

GPIB/RS-232 LAN

Supported   All

Use this softkey to access a menu of choices for GPIB, RS-232, and LAN configuration. 

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None 

GPIB Listener Mode

Supported   All

Use this softkey to return the GPIB back to the listener mode after a user flatness 

calibration.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 
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H

Help 

Supported   All

Press this hardkey to display a help text box. Then press a hardkey, softkey, or turn the 

knob and a short description of the function which will appear in the text area. 

Preset  N/A

Range  N/A

Remarks  N/A 

Help Mode Single Cont

Supported   All

Use this hardkey to view a short description of any hardkey or softkey. There are two 

help modes available on the signal generator: single and continuous.

• In single mode, when you press the Help key, help text is provided for your next key 

press. Pressing any key afterward will enable you to exit the help function and will 

activate the function of the key.

• In continuous mode, when you press the Help key, help text is provided for each key 

press in addition to activating the function of each key (except for the Preset key). You 

will remain in continuous mode until either the Help key is pressed again or the 

signal generator help mode is toggled back to single mode.

Preset  N/A

Choices  Single or Cont

Location  Page  250

Remarks  The help mode is not affected by a preset or by a power cycle.
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Hold

Supported   All

This hardkey deactivates the current active function and blanks the softkey menu. Once 

hold has been pressed, the front panel knob, arrow keys, and the numeric keypad have 

no effect until another function becomes active.

Preset  N/A

Range  N/A

Remarks  None 

Hostname

Supported   All

This softkey enables you to enter the hostname for the local area network connection. No 

hostname is entered at the factory.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  The hostname setting is not affected by a preset or by a power cycle.
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I

Incr Set

Supported   All

This hardkey enables you to set the incremental value of the up and down arrow keys, 

and the front panel knob, for the current active function. The incremental value will 

appear in the active entry area of the display.

Preset  N/A

Range  N/A

Remarks  The increment set value is not affected by a preset or by a power cycle. 

Insert Item

Supported   All

This softkey enables you to insert a copy of the highlighted item directly below that item 

in a table or list. 

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None 

Insert Row

Supported   All

Use this softkey to insert a copy of the highlighted row directly above that row in a table 

or list.

Preset  N/A

Range  N/A

Location  Page  233, Page  245

Remarks  None 
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Installed Board Info

Supported   All

Use this softkey to display information about the installed boards in the signal 

generator. Refer to Figure 5-2.

Figure 5-2 Installed Board Information

The gray and white vertical bar on the left side of the display indicates that there is an 

additional page of information. Use the Page Down softkey to display the next page. Use 

the Page Up softkey to return to the previous page.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  A status of DETECTED means that the installed board was automatically 

detected by the internal computer.

A status of INSTALLED means that the installed board is available for 

use and is not normally automatically detected.

Additional Page Indicator
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Instrument Adjustments

Supported   All

Use this softkey to access a menu of front panel adjustments for the signal generator. 

This menu enables you to adjust the reference oscillator, and set the value of the step 

keys and the front panel knob.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None 

Instrument Info/Help Mode

Supported   All

Press this softkey to display a menu of softkeys for the following functions:

• display diagnostic information about your signal generator

• display all available options and the associated hardware

• display the self test control menu

• toggle the modulation status display on and off

• toggle the help mode between single and continuous

• display information about the installed boards 

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None 
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Int Doublet

Supported   PSG-A Series

Use this softkey to select an internal doublet pulse modulation. When doublet pulse is 

enabled, each trigger event will produce two pulses at the RF OUTPUT connector. The 

first pulse will follow the external trigger signal that is applied to the TRIGGER IN 

connector. The second pulse will have delay and width parameters as set via the front 

panel or with programming commands. Pulse delay is measured from the leading edge of 

the external trigger signal. Refer to Figure 5-3.

Figure 5-3

Preset  N/A

Range  N/A

Location  Page  242

Remarks  This modulation source requires an external trigger source.

Int Free-Run

Supported   PSG-A Series

Use this softkey to select an internal, free-run, pulse modulation. When free-run pulse is 

enabled, the internal pulse modulation runs continuously.

Preset  N/A

Range  N/A

Location  Page  242

Remarks  None 
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Int Gated

Supported   PSG-A Series

Use this softkey to select an internal, gated, pulse modulation. When the rising edge of a 

valid gate signal is applied to the TRIGGER IN connector, a pulse train will occur at the 

RF OUTPUT connector. Pulse width and pulse repetition frequency parameters are set 

by way of the front panel or with programming commands. When the falling edge of the 

gate signal is sensed at the TRIGGER IN connector, the pulse train will cease. If the 

falling edge of the gate signal occurs in the middle of a pulse at the RF OUTPUT 

connector, the last pulse will complete before the pulse train ceases. Once the falling 

edge of the gate signal is sensed, a time interval equal to the pulse repetition interval 

must elapse before another rising edge at the TRIGGER IN connector will be valid. Refer 

to Figure 5-4.

Figure 5-4

Preset  N/A

Range  N/A

Location  Page  242

Remarks  This modulation source requires an external trigger source.
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Int Triggered

Supported   PSG-A Series

Use this softkey to select an internal, triggered, pulse modulation. When internal 

triggered pulse is enabled, an RF pulse will occur at the RF OUTPUT connector 

whenever a valid trigger signal occurs at the TRIGGER IN connector. The RF pulse will 

have pulse width and delay as set by way of the front panel or with programming 

commands. Refer to Figure 5-5.

Figure 5-5

Preset  N/A

Range  N/A

Location  Page  242

Remarks  None 

Internal

Supported   All

This softkey enables you select an internal mode for the automatic leveling control.

Preset  N/A

Range  N/A

Location  Page  232

Remarks  None 
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Internal 1

Supported   PSG-A Series

This softkey enables you to internally generate an ac-coupled, frequency modulation 

signal. 

Preset  400.0 Hz sine-wave with 0.1% depth

Range  N/A

Location  Page  230, Page  235, Page  237

Remarks  The internal source has multiple uses, but can be used for only one 

modulation at a time.

Internal 2

Supported   PSG-A Series

This softkey enables you to internally generate an ac-coupled, frequency modulation 

signal. 

Preset  400.0 Hz sine-wave with 0.1% depth

Range  N/A

Location  Page  230, Page  235, Page  237

Remarks  The internal source has multiple uses, but can be used for only one 

modulation at a time.

Internal Monitor 1

Supported   PSG-A Series

This softkey enables you to output a signal at the LF OUTPUT connector. The frequency 

and shape of the signal is set by the internal source as it is being used by a modulation. 

Preset  N/A

Range  N/A

Location  Page  240

Remarks  None 
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Internal Monitor 2

Supported   PSG-A Series

This softkey enables you to output a signal at the LF OUTPUT connector. The frequency 

and shape of the signal is set by the internal source as it is being used by a modulation. 

Preset  N/A

Range  N/A

Location  Page  240

Remarks  None 

Internal Ref Bandwidth

Supported   PSG-A Series with Option UNJ

This softkey enables you to adjust the bandwidth of the internal reference oscillator.

Internal Square

Supported   PSG-A Series

This softkey enables you to internally generate squarewave pulse modulation. 

Preset  N/A

Range  0.1 Hz−10.0 MHz

Location  Page  242

Remarks  For additional specifications, refer to the data sheet.

Preset  N/A

Choices 25.0 Hz 55.0 Hz 125.0 Hz 300.0 Hz

650.0 Hz

Location Page  248

Remarks None.
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Inverse Video Off On

Supported   All

This softkey toggles the operating state of the inverse video. When inverse mode is on, 

light text on a dark background is displayed. The normal display mode for the signal 

generator, inverse off, is dark text on a light background. 

Preset  N/A

Range  Off or On

Location  Page  247

Remarks  The inverse video state is not affected by a preset or by a power cycle. 

IP Address

Supported   All

This softkey enables you to enter the IP address for your TCP/IP network connection. No 

IP address is entered at the factory.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  The IP address setting is not affected by a preset or by a power cycle. 
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K

Keep Previous Comment

Supported   All

This softkey enables you to keep the comments of the previously saved register instead 

of over-writing them.

Preset  N/A

Range  N/A

Location  Page  244

Remarks  None 
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L

LAN Setup

Supported   All

Use this softkey to access a menu that enables you to enter a local area network (LAN) 

host name and IP address for communication through the LAN cable.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None

Leveling Mode

Supported   All

Use this softkey to access a menu of choices that enables you to select a leveling mode for 

automatic leveling control.

LF Out

Supported   PSG-A Series

Use this hardkey to access a menu of softkeys that enables you to configure the internal, 

low frequency output. 

Preset  N/A

Range  N/A

Location  Page  240

Remarks  None 

Preset  Internal 

Choices Internal Ext Detector Source Module

Location Page  232

Remarks None
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LF Out Amplitude Into 50 Ohms

Supported   PSG-A Series

This softkey enables you to scale the output of the signal at the LF OUTPUT connector. 

Preset  0.0 V

Range  0.0−3.5 Vp

Location  Page  240

Remarks  None

LF Out Freq

Supported   PSG-A Series

This softkey enables you to set the modulating frequency for the LF output signal when 

you have selected the internal source as a function generator. 

Preset  400.0 Hz

Range  0.5 Hz−100.0 kHz

0.5 Hz to 1.0 MHz (if sinewave is selected as the internal waveform)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as a function generator.

LF Out Off On

Supported   PSG-A Series

This softkey toggles the operating state of the output of the selected source at the 

LF OUTPUT connector. Refer to the ”LF Out Source” softkey in this section for more 

information on choosing the source.

Preset  Off

Choices  Off or On

Location  Page  240

Remarks  Once you have toggled this state on, the signal is immediately 

available at the LF OUTPUT connector. The RF On/Off hardkey does 

not apply to this state.The Mod On/Off softkey does apply to this state.
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LF Out Source

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select an internally 

generated source for the low frequency output. You can choose to output the signal from 

one of the internal sources as it is being used by a modulation or you can use the internal 

source as a function generator and select that signal to output at the LF OUTPUT 

connector.

If you choose an internal source, the frequency and shape of the signal at the 

LF OUTPUT connector is set by the internal source as it is being used by a modulation. 

For example, if the internal source is currently assigned to an AM path configuration 

and AM is turned on, the signal output at the LF OUTPUT connector will have the 

frequency and shape of the amplitude modulating signal. You can scale the amplitude of 

the output signal using the LF Out Amplitude softkey.

If you choose to set the internal source as a function generator, you can select a 

frequency and shape in addition to selecting the amplitude for the LF output signal. 

Preset  Internal 1 Monitor

Choices Internal 1 Monitor Internal 2 Monitor

Function Generator 1 Function Generator 2

Location Page  240

Remarks When you use an internal source as a function generator, any 

modulation with the internal source selected is turned off.
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LF Out Start Freq

Supported   PSG-A Series

This softkey enables you to change the starting frequency for swept-sine low frequency 

output. This key is coupled to the LF Out Freq softkey in the initial LF Out menu and the 

LF Out Tone 1 Freq softkey in the LF Out dual-sine menu. Any value set for LF 
Out Start Freq is reflected in the LF Out Freq and LF Out Tone 1 Freq softkeys. Conversely, if 

you change the value for either the LF Out Freq softkey or the LF Out Tone 1 Freq softkey, 

the value for LF Out Start Freq is changed to match.

Preset  400.0 Hz

Range  1.0 Hz−1.0 MHz (minimum increment is 1.0 Hz)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 

LF Out Stop Freq

Supported   PSG-A Series

This softkey enables you to change the ending frequency for swept-sine low frequency 

output. 

This key is coupled to the LF Out Tone 2 Freq softkey in the LF Out Dual-Sine menu. Any 

value set for LF Out Stop Freq is reflected in the LF Out Tone 2 Freq softkey. 

Preset  400.0 Hz

Range  1.0 Hz−1.0 MHz (minimum increment is 1.0 Hz)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 
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LF Out Sweep Rate

Supported   PSG-A Series

This softkey enables you to set the sweep rate for low frequency swept-sine output. The 

signal generator will sweep from the specified start frequency to the stop frequency at 

the rate set with this key. 

Preset  400.0 Hz

Range  500.0 mHz−100 kHz (minimum increment is 1.0 Hz)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 

LF Out Sweep Trigger

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select the triggering 

mode for the swept-sine low frequency output. You can choose triggering that occurs 

immediately, triggering that is supplied by the GPIB, triggering on either a positive or 

negative level of a signal supplied to the TRIGGER IN connector, or triggering by the 

Trigger hardkey.

Preset  Free Run

Choices Free Run Trigger Key Bus Ext

Location Page  240

Remarks This softkey is active only when you have selected the internal 

source to operate as Function Generator 1.

You can also configure the polarity of the TTL signal output at the 

TRIGGER IN connector using the Trigger In Polarity Neg Pos softkey 

on this menu. Refer to “Trigger In Polarity Neg Pos” on page 222.
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LF Out Tone 1 Freq

Supported   PSG-A Series

This softkey enables you to set the frequency for the LF output tone 1.

This key is coupled to the LF Out Freq softkey in the initial LF Out menu and the 

LF Out Start Freq softkey in the LF Out Swept-Sine menu. Any value set for 

LF Out Tone 1 Freq is reflected in the LF Out Freq and LF Out Start Freq softkeys. 

Preset  400.0 Hz

Range  0.5 Hz−1.0 MHz (minimum increment allowed is 0.5 Hz)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 

LF Out Tone 2 Ampl % Of Peak

Supported   PSG-A Series

This softkey enables you to set the ratio of the peak amplitude of LF Out tone 2 to the 

peak amplitude of LF Out as a percent. The sum of the two LF Out amplitudes results in 

the total LF Out amplitude set by the LF Out Amplitude softkey in the initial LF Out 

menu.

For example, if the total LF Out amplitude is 300 mVp and you set 

LF Out Tone 2 Ampl % Of Peak to 33%, then the amplitude of LF Out tone 1 will be 

200.0 mVp and the amplitude of LF Out tone 2 will be 100.0 mVp (33% of 300.0 mVp) so 

that the amplitude of the two tones equals 300.0 mVp (200.0 mVp plus 100.0 mVp).

Preset  50.0%

Range  0.0−100% (minimum increment is 0.1%)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 
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LF Out Tone 2 Freq

Supported   PSG-A Series

This softkey enables you to change the alternate frequency of the internally generated 

modulation source. The alternate frequency is the second frequency in dual-sine or the 

stop frequency in swept-sine.This key is coupled to the LF Out Freq softkey in the initial 

LF Out menu and the LF Out Stop Freq softkey in the LF Out Swept-Sine menu. 

Preset  400.0 Hz

Range  0.5 Hz−1.0 MHz (minimum increment allowed is 0.5 Hz)

Location  Page  240

Remarks  This softkey is active only when you have selected the internal source 

to operate as Function Generator 1. 

LF Out Waveform

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select the LF output 

waveform for your LF function generator. 

Preset  Sine

Choices Sine Noise Triangle Square

Dual-Sine Ramp Swept-Sine DC

Location Page  240

Remarks This key is active only when you have selected the internal 

source to operate as a function generator. Dual-Sine and 

Swept-Sine are available only when you have selected the 

internal source to operate as Function Generator 1.
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List

Supported   PSG-A Series

This softkey enables you to specify that only list sweep files be included in the catalog of 

files currently displayed.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

Load Cal Array From Step Array

Supported   All

This softkey enables you to set up a table that includes the start frequency, stop 

frequency, and number of points that are defined in the Configure User Flatness Step 

Array menu.

Preset  N/A

Range  N/A

Location  Page  233

Remarks  None 

Load From Selected File

Supported   All

This softkey enables you to load the list sweep data from a file into the current sweep 

list. Use the arrow hardkeys to highlight the desired sweep list file. Press 

Load From Selected File and the list sweep data from the selected file is loaded into the 

current list sweep. You can only have one list sweep at a time so the existing list sweep 

data will be lost unless it is first stored to a file.

Preset  N/A

Range  N/A

Location  Page  234, Page  246

Remarks  This key is inactive unless at least one list sweep data file has been 

stored to memory.
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Load List From Step Sweep

Supported   All

This softkey enables you to copy the step sweep data points into the list sweep data 

points. 

Preset  N/A

Range  N/A

Location  Page  246

Remarks  You can have only one sweep list at a time so be certain that you wish 

to overwrite the existing list.

Load/Store

Supported   All

Use this softkey to access a menu of choices that enables you to load from and store 

tables to user files. In this menu you can also delete files.

Local

Supported   All

Use this hardkey to return the signal generator to local (front panel) control after using 

remote operation.

Preset  N/A

Range  N/A

Remarks  None 

Preset  N/A

Choices Load From Selected File Store to File Delete File

Goto Row Page Up Page Down

Location Page  233, Page  246

Remarks None
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Loop Selected Tests

Supported   All

This softkey is provided for self test diagnostics. Refer to the troubleshooting chapter of 

the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is included for use by service personnel.
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M

Manual Mode Off On

Supported   All

This softkey toggles the operating state of the manual mode selection for the current 

sweep point. When Manual Mode is on, the selected sweep point controls the frequency 

and amplitude according to the sweep type. 

Preset  Off

Choices  Off or On

Location  Page  245

Remarks  This key is disabled when Sweep Off On is set to Off. 

Manual Point

Supported   All

This softkey enables you to choose a point in the sweep list. When Manual Mode is on, 

the selected point controls the output parameters (frequency and/or amplitude) 

according to the sweep type. 

Preset  1

Range  N/A

Location  Page  245

Remarks  This key is disabled when Manual Mode Off On is set to Off.

If list or step mode is controlling frequency and/or power, then the 

indexed point in the respective list(s) will be used.

If the point selected is beyond the length of the longest enabled list, 

then the point will be set to the maximum possible point, and an error 

will be generated.
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Meter Address

Supported   All

This softkey enables you to select the external power meter GPIB address for use during 

the user flatness calibration.

Preset  N/A

Range  0−30

Location  Page  232

Remarks  The meter address is not affected by a preset or by a power cycle.

The power meter is controlled only through a GPIB cable.

Meter Channel A B

Supported   All

This softkey toggles between channels A and B when you are using an external power 

meter that has two channels.

Preset  N/A

Choices   A or B

Location  Page  232

Remarks  The meter channel selection is not affected by a preset or by a power 

cycle.

The power meter is controlled only through a GPIB cable.

Meter Timeout

Supported   All

This softkey enables you to select the remote timeout length of the external power meter 

during user flatness calibration.

Preset  N/A

Range  1.0 msec−100.0 sec

Location  Page  232

Remarks  The meter timeout setting is not affected by a preset or by a power 

cycle. The power meter is controlled only through a GPIB cable.
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Memory Catalog

Supported   All

Use this softkey to access a menu of choices that enables you to display a catalog of user 

files. In addition, the menu displays file management functions and a menu for choosing 

the file type.

Mod On/Off

Supported   PSG-A Series

This hardkey toggles the operating state of the RF carrier modulation function. 

Preset  Off

Choices  Off or On

Remarks  All modulation types can be simultaneously enabled, except for FM 

with ΦM and linear AM with exponential AM. AM, FM, and ΦM can 

sum simultaneous inputs from any two sources (Ext1, Ext2, Internal 1, 

Internal 2). A given source may be routed to only one activated 

modulation type.

An annunciator on the signal generator is always displayed to indicate 

whether modulation is switched on or off.

Preset  N/A

Range N/A

Location Page  247

Remarks None
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Mod Status Info Off On

Supported   PSG-A Series

This softkey toggles the operating state of the modulation status display. When the 

modulation status is set to on, information about the status of all of the modulations 

available is shown at any time that you have accessed one of the modulation menus. 

Refer to Figure 5-6. When the modulation status is set to off, the information about the 

status of all the modulations is not displayed.

Figure 5-6 Modulation Status Information

Preset  On

Choices  On or Off

Location  Page  250

Remarks  None 
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N

Negative

Supported   PSG-A Series

This key enables you to select a negatively sloped ramp, or sawtooth, as the modulation 

waveform for the internally generated, ac-coupled, signal.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  None

Noise

Supported   PSG-A Series

Use this softkey to access a menu that enables you to specify a noise type as the 

modulation waveform for the internally generated, ac-coupled signal. 

Preset  Uniform

Choices  Uniform or Gaussian

Location  Page  230, Page  235, Page  237, Page  240

Remarks  The selected waveform applies only to the path configuration you have 

currently selected.

Noise is generated as a peak to peak value; the RMS value is about 

80.0% of the displayed value.
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Numeric Keypad

Supported   All

The numeric keypad enables you to enter both positive and negative values. In addition, 

the backspace key,  is used to delete and change the sign of a value. These keys, 

with the exception of the period, have autorepeat capability. Hold a key down and the 

function is continuously executed until you release it.

Preset  N/A

Range  N/A

Remarks  N/A.
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O

Off

Supported   All

Use this softkey to turn off all sweep functions. The output signal is then set according to 

the current frequency and amplitude settings defined by the Frequency and Amplitude 

hardkeys.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None 
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Options Info

Supported   All

Use this softkey to display all available options and the associated hardware. Refer to 

Figure 5-7.

Figure 5-7 Installed Option Information

Option  the option number

Option Revision  an alphabetic representation of the option revision

DSP Version  version number of additional DSP code used with some hardware 

options

Preset  N/A

Range  N/A

Location  Page  250

Remarks  None 
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P

Page Down

Supported   All

This softkey enables you to move down in the display one page at a time.

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 

Page Up

Supported   All

This softkey enables you to move up in the display one page at a time.

Preset  N/A

Range  N/A

Location  Page  233, Page  234, Page  245, Page  246, Page  249

Remarks  None 

Phase Ref Set

Supported   All

This softkey enables you to set the relative phase of the RF output signal to zero. Then 

all phase parameters are set relative to this zero reference.

Preset  N/A

Range  N/A

Location  Page  239

Remarks  None
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Point Trigger

Supported   All

Use this softkey to access a menu of choices that enables you to select a triggering mode 

for point-by-point sweep. 

Positive

Supported   PSG-A Series

This key enables you to select a positively sloped ramp as the modulation waveform for 

the internally generated, ac-coupled signal.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  None

Power Meter 

Supported   All

Use this softkey to access a menu of choices that enables you to select the external power 

meter model for use during the user flatness calibration.

Preset  Free Run

Choices Free Run Trigger Key Bus Ext

Location Page  245

Remarks You can also configure the polarity of the TTL signal output at the 

TRIGGER IN connector using the Trigger In Polarity Neg Pos softkey 

on this menu. Refer to “Trigger In Polarity Neg Pos” on page 222.

Preset  N/A

Choices E4418B E4419B E4416A E4417A

Location Page  232

Remarks The power meter selection is not affected by a preset or by a power 

cycle.

The power meter is controlled only through a GPIB cable.
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Power On Last Preset

Supported   All

This softkey toggles the power-on state of the signal generator between last and preset. 

If you choose Last, each time you cycle power to the signal generator it will turn on in 

the same condition as when you turned power off. 

If you choose Preset, each time you cycle power to the signal generator it will turn on in 

either the factory-defined preset condition or in a user-defined preset condition. You 

make the choice between factory- and user-defined preset with the Preset Normal User 
softkey.

Preset  N/A

Choices  Last or Preset

Location  Page  247

Remarks  If last is active, the signal generator must not receive commands for at 

least 3 seconds before the power is turned off to guarantee that the 

most recent state is saved.

The power-on state is not affected by a preset or by a power cycle.

Power On/Preset

Supported   All

Use this softkey to access a menu of choices for power on and preset conditions. Refer to 

“Power On Last Preset” on page 192, “Preset Normal User” on page 194, and

“Save User Preset” on page 207.

Preset  N/A

Choices Power On Last Preset Preset Normal User

Save User Preset

Location Page  247
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Power Search

Supported   All

Use this softkey to access the Power Search Manual Auto softkey. Power search is an 

internal calibration routine that improves output power accuracy when the ALC is off.

Power Search Manual Auto

Supported   All

This softkey toggles the power search mode between auto and manual. Power search is 

an internal calibration routine that improves output power accuracy when the ALC is 

off. When you set Power Search to Auto, power search will execute automatically with 

each change to the RF frequency or power. When you set Power Search to Manual, the 

power search routine is executed when the Do Power Search softkey is pressed. 

Preset

Supported   All

This hardkey enables you to set the signal generator to a known state which can be 

either the factory-defined state or a user-defined state. Refer to “Preset Normal User” on 

page 194.

Preset  N/A

Range  N/A

Remarks  None 

Preset  N/A

Range N/A

Location Page  232

Remarks The ALC Off On softkey must be set to Off in order to 

engage power search mode.

Preset  Manual

Choices Manual Auto

Location Page  232

Remarks The ALC Off On softkey must be set to Off in order to 

engage either power search mode.
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Preset List

Supported   All

This softkey enables you to delete the current sweep list and replace it with a new list 

consisting of one point at a default frequency, amplitude, and dwell time. 

Preset  N/A

Range  N/A

Location  Page  233, Page  246

Remarks  Be certain that you want to delete the current sweep list; you cannot 

recover the information once you press Preset List.

Preset Normal User

Supported   All

This softkey toggles the preset state between the factory-defined and the user-defined 

states. If you choose Normal, preset conditions will be a factory-defined state. If you 

choose User, the preset conditions will be a defined and saved by the user with 

Save User Preset.

Preset  N/A

Choices  Normal or User

Location  Page  247

Remarks  None

Pulse

Supported   PSG-A Series

Use this hardkey to access a menu of choices that enables you to configure the pulse 

modulation. 

Preset  N/A

Range  N/A

Location  Page  242

Remarks  None 
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Pulse Delay

Supported   PSG-A Series

This softkey enables you to change the pulse delay of the internally generated pulse 

modulation source. 

Preset  0.0 sec

Range  The range is dependent upon the value set for the pulse period.

Internal Free Run: −(pulse period − 20 nS) to (pulse period − 20 nS)

Internal Triggered & Doublet: 70nS to (pulse period − 20 nS)

Location  Page  242

Remarks  None

Pulse Off On

Supported   PSG-A Series

This softkey toggles the operating state for the currently selected pulse source.

When pulse modulation is on, the PULSE annunciator is shown in the display

Preset  Off

Choices  Off or On

Location  Page  242

Remarks  The RF carrier is modulated by the enabled modulation only when you 

have also set Mod On/Off to On.
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Pulse Period

Supported   PSG-A Series

This softkey enables you to change the pulse period for internally generated pulse 

modulation. 

Preset  2.00 µsec

Range  70.00 nsec−42.00 sec

Location  Page  242

Remarks  If the value for pulse period is less than the value for pulse width, 

pulse width is changed to be 20 us less than pulse period. 

The pulse period applies only to Int Free Run Pulse Modulation and 

Int Gated.

Pulse Rate

Supported   PSG-A Series

This softkey enables you to change the pulse rate for the internal square pulse 

modulation. 

Preset  400.0 Hz

Range  100.0 mHz−10.0 MHz

Location  Page  242

Remarks  The new value of pulse rate applies only to internal square pulse 

modulation. When external pulse modulation or internal pulse 

modulation is selected, this key is disabled. 
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Pulse Source

Supported   PSG-A Series

Use this softkey to access a menu of choices that enables you to select the pulse source 

for internally generated and externally applied modulation inputs. 

Pulse Width

Supported   PSG-A Series

This softkey enables you to change the pulse width for internally generated pulse 

modulation source. 

Preset  1.00 µsec

Range  10.00 nsec−41.99 sec

Location  Page  242

Remarks  If the value for pulse period is less than the value for pulse width, 

pulse width is changed to be 20 ns less than pulse period. 

The pulse width applies only to internal pulse modulation; when 

external pulse modulation or internal square pulse modulation is 

selected, this key is disabled.

Preset  Int Free-Run

Choices Int Free-Run

Int Triggered

Internal Square

Int Doublet

Ext Pulse

Int Gated

Location Page  242

Remarks None
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Ramp

Supported   PSG-A Series

This softkey enables you to specify ramp, either positive or negative, as the modulation 

waveform for the internally generated, ac-coupled signal.

Preset  Positive

Choices  Positive or Negative

Location  Page  230, Page  235, Page  237, Page  240

Remarks  This key is active only when you have selected the internal source to 

operate as a function generator. 

Recall

Supported   All

Use this hardkey to access a menu of softkeys that enables you to select or delete 

registers and sequences. 

Preset  RECALL Reg

Choices RECALL Reg Select Seq Delete Seq[0] Reg[0]

Delete All Reg 

in Seq[0]

Delete All Sequences

Location Page  243

Remarks None
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Recall Ref Osc Setting

Supported   All

Use this softkey to recall the last saved reference oscillator coarse and fine adjustment 

setting. 

Preset  N/A

Range  N/A

Location  Page  248

Remarks  This adjustment is intended for use by service personnel. Refer to the 

calibration guide for more information. 

Recall Reg

Supported   All

Use this softkey to recall an instrument state from a saved register. Recalling a register 

also selects that register number for all keys which specify a register number in this 

menu. You can also use the front panel knob and the up and down arrow keys to scroll 

through all saved registers for the selected sequence. 

Preset  N/A

Range  N/A

Location  Page  243

Remarks  None

Ref Osc Coarse

Supported   All

This softkey is provided for adjusting the internal reference oscillator. Refer to the 

calibration guide for more information.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  This adjustment is intended for use by service personnel. 
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Ref Osc Fine

Supported   All

This softkey is provided for adjusting the internal reference oscillator. Refer to the 

calibration guide for more information.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  This adjustment is intended for use by service personnel. 

Ref Oscillator Source Auto Off On

Supported   All

This softkey toggles the operating state for the automatic source selecting function. 

When this function is turned on, the signal generator detects when a valid reference 

signal is present at the 10 MHz IN connector and automatically switches from internal 

to external reference operation. When this function is turned off, the signal generator 

uses the internal reference only, even if an external reference is connected.

Preset  On

Choices  Off or On

Location  Page  239

Remarks  None

Reference Oscillator Adjustment

Supported   All

Use this softkey to access a menu of keys that are provided for adjusting the internal 

reference oscillator. 

Preset  N/A

Range  N/A

Location  Page  248

Remarks  This adjustment is intended for use by service personnel. Refer to the 

calibration guide for more information. 

www.valuetronics.com



Key Reference

R

Chapter 5 201

Rename File

Supported   All

This softkey enables you to rename the highlighted file in the displayed catalog of files. 

When you have entered the new file name, press the Enter terminator softkey. If you 

have changed your mind, press the Return hardkey. Once you press Enter, the new file is 

stored and displayed immediately in the catalog list.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None 

Re-SAVE Seq[n] Reg [n]

Supported   All

This softkey enables you to save the current instrument state to the selected register 

and sequence. If data has already been stored to this location, it will be overwritten. The 

signal generator state includes all parameter selections except list sweep data and 

selections which are kept as states that are not affected by a preset or a power cycle.

Preset  N/A

Range  N/A

Location  Page  244

Remarks  None 

Reset RS-232

Supported   All

Use this softkey to perform a clean-up on the RS-232 buffer. This clean-up discards any 

unprocessed SCPI input received over RS-232 and places the RS-232 connection in a 

mode which can detect the optional remote interface.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  All other RS-232 communication parameters are unaffected. 
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Restore Factory Defaults

Supported   PSG-A Series with Option UNJ

This softkey re-sets the bandwidth of the reference oscillator to the factory-defined 

default state. The default value for the internal reference bandwidth is 125 Hz. The 

default value for the external reference bandwidth is 25 Hz

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None. 

Return

Supported   All

Use this hardkey to move from your current softkey menu to the menu that precedes it 

or to cancel an active function entry. When you are at the preset state, the Return 

hardkey has no function.

Preset  N/A

Range  N/A

Remarks  The return key has autorepeat capability. Hold it down and you are 

moved repeatedly back through the menus until you either release the 

key or you reach the preset state. 

RF On/Off

Supported   All

This hardkey toggles the operating state of the RF signal at the RF OUTPUT connector. 

Although you can configure and engage various modulations, no signal is available at 

the RF OUTPUT connector until RF On/Off is set to On. An annunciator is always turned 

on in the display to indicate whether RF is turned on or off.

Preset  Off

Range  On or Off

Remarks  None
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RS-232 Baud Rate

Supported   All

Use this softkey to access a menu of choices that enables you to set the baud rate in bits 

per second for the rear panel RS-232 connector, labeled AUXILIARY INTERFACE. 

RS-232 Echo Off On

Supported   All

This softkey toggles the operating state of the RS-232 serial port, AUXILIARY 

INTERFACE connector, echo function. When this function is set to on, every character 

sent to the signal generator is immediately sent back. No editing capability is available.

Preset  N/A

Range  Off or On

Location  Page  248

Remarks  The echo state is not affected by a preset or by a power cycle.

RS-232 Setup

Supported   All

Use this softkey to access a menu of choices that enables you to configure the rear panel 

RS-232, AUXILIARY INTERFACE, connector.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  None

Preset  N/A

Choices 57600 38400 19200 9600

4800 2400 1200 300

Location Page  247

Remarks Once set, the baud rate is not affected by a preset or by a power cycle.

www.valuetronics.com



Key Reference

R

Chapter 5204

RS-232 Timeout

Supported   All

This softkey enables you to change the value for the RS-232 serial port timeout. If 

further input is not received within the assigned timeout period while a SCPI command 

is being processed, then the command is aborted and the input buffer is cleared.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  Once set, timeout is not affected by a preset or by a power cycle.

Run Complete Self Test

Supported   All

Use this softkey to run an automated, internal diagnostic test that checks for detectable 

hardware failures. If there are probable hardware failures in the signal generator, refer 

to the troubleshooting section of the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is included for use by service personnel.

Run Highlighted Tests

Supported   All

This softkey is provided for self test diagnostics. Refer to the troubleshooting section of 

the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is included for use by service personnel.
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Run Selected Tests

Supported   All

This softkey is provided for self test diagnostics. Refer to the troubleshooting section of 

the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is included for use by service personnel.
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Save

Supported   All

Use this hardkey to access a menu of choices that enables you to select, delete, and 

re-save registers and sequences. The menu shows the registers in use and any comments 

associated with the registers for the last sequence accessed. The menu is updated 

whenever you make any changes to the registers or to the comments.

Preset  N/A

Range  N/A

Location  Page  244

Remarks  Up to 100 storage registers and 10 register sequences are available, 

depending on the number and size of files.

Save Reg

Supported   All

Use this softkey to save the current instrument state in the specified register.

Preset  N/A

Range  N/A

Location  Page  244

Remarks  None

www.valuetronics.com



Key Reference

S

Chapter 5 207

Save Seq[n] Reg[nn]

Supported   All

This softkey enables you to save the current instrument state in the specified register 

within the specified sequence. The instrument state includes all of your setup selections 

except list sweep data and functions that do not change by the preset function or by a 

power cycle. 

Preset  N/A

Range  N/A

Location  Page  244

Remarks  Do not press this key until you have specified the correct sequence and 

register using the Select Seq and Select Reg softkey.

Save User Preset

Supported   All

This softkey enables you to establish your user-defined preset state. Set up all of the 

instrument state conditions that you want for your unique preset state. When you have 

defined the instrument state to suit your needs, press Save User Preset. Only one 

user-defined preset state is allowed, so when you save the instrument state you will save 

over any previously saved state. Your instrument state will be recalled by the signal 

generator any time you press Preset as long as you have set the Preset Normal User key to 

User. 

Preset  N/A

Range  N/A

Location  Page  247

Remarks  The instrument state definition is a state file and is not affected by a 

preset or by a power cycle.
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Screen Saver Delay:

Supported   All

This softkey enables you to set the period of time before the screen saver is activated 

when there has been no input from the front panel. 

Preset  N/A

Range  1−12 hours

Location  Page  247

Remarks  The screen saver delay state is not affected by a preset or by a power 

cycle.

Screen Saver Mode

Supported   All

This softkey toggles the operating mode for the screen saver between Light Only and 

Light & Text. When you set the screen saver to Light Only, only the display light is 

turned on and off. When you set the screen saver to Light & Text, the display light and 

the text are turned on and off.

Preset  N/A

Choices  Light Only or Light & Text

Location  Page  247

Remarks  The screen saver mode is not affected by a preset or by a power cycle.

To prevent the text from burning the display, if you are leaving the 

display unchanged for long periods of time, set the mode to light and 

text. 
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Screen Saver Off On

Supported   All

This softkey toggles the operating state of the screen saver. With the screen saver on, the 

display is turned off after a period of time with no input from the front panel. The 

display turns back on when any key is pressed. 

Preset  N/A

Choices  Off or On

Location  Page  247

Remarks  The screen saver mode is not affected by a preset or by a power cycle.

Select/Deselect All

Supported   All

This softkey is provided for self test diagnostics. Refer to the troubleshooting section of 

the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is intended for use by service personnel.

Select/Deselect Test

Supported   All

This softkey is provided for self test diagnostics. Refer to the troubleshooting section of 

the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is intended for use by service personnel.
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Select Reg

Supported   All

Use this softkey to select a specific register to be highlighted in the list of saved states.

Preset  N/A

Range  N/A

Location  Page  244

Remarks  None

Select Reg:

Supported   All

This softkey enables you to select a register for all softkeys that specify a register in this 

menu. For example, if you want to select register 5, press Select Reg:. The currently 

selected register is displayed in the active entry area. Change the number to 5 and press 

the Select Reg terminator softkey. Register 5 is now displayed in all softkeys which 

specify a register in this menu.

You can also use this softkey to select a register and save the current instrument state to 

that register. For example, if you want to select and save to register 6, press Select Reg:. 
The currently selected register is displayed in the active entry area. Change the number 

to 6 and press the Save Reg terminator softkey. Register 6 is now displayed in all 

softkeys which specify a register in this menu and the current instrument state has been 

saved to register 6.

Preset  0

Range  00−99

Location  Page  244

Remarks  None
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Select Seq:

Supported   All

This softkey enables you to select a sequence for all softkeys which specify a sequence in 

this menu. For example, if you want to select sequence 4, press Select Seq:. The currently 

selected sequence is displayed in the active entry area. Change the number to 4 and 

press the Enter terminator softkey. Sequence 4 is now displayed in all softkeys that 

specify a sequence in this menu.

Preset  0

Range  0−9

Location  Page  243, Page  244

Remarks  None

Self Test

Supported   All

This softkey accesses an automatic, internal diagnostic test that checks for detectable 

hardware failures. If there are hardware failures in the signal generator, refer to the 

troubleshooting section of the service guide.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This key is intended for use by service personnel.

Set ALC Level

Supported   All with Option 1E1

This softkey enables you to change the ALC level. The output power is the ALC level 

minus the attenuator setting. 

Preset  −20.00 dBm

Range  −20.00 dBm to 25.00 dBm

Location  Page  232

Remarks  This key is active only when you have toggled the Atten Hold Off On key 

to On.
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Set Atten

Supported   All with Option 1E1

This softkey enables you to change the amount of attenuation in 5.0 dB steps. The 

output power is the ALC level minus the attenuator setting. 

Preset  105.00 dB

Range  0.00 dB−105.00 dB

Location  Page  232

Remarks  This key is active only when you have toggled the Atten Hold Off On key 

to On.

Sine

Supported   PSG-A Series

This softkey enables you to specify sine as the modulation waveform for the internally 

generated, ac-coupled, signal. 

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  The selected waveform applies only to whichever path configuration 

you have currently selected.

Single Sweep

Supported   All

Use this softkey to arm the sweep. The ARMED annunciator will turn on in the display. 

The signal generator will begin the sweep as soon as the sweep trigger is received. 

Single Sweep sets the power and the frequency to the first point of the sweep while it is 

not initiated or is waiting for the sweep trigger. If you have set the sweep trigger to 

Immediate, a sweep is initiated as soon as you arm the sweep.

Preset  N/A

Range  N/A

Location  Page  245

Remarks  This key is disabled when Sweep is set to Off.
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Source Module

Supported   All

This softkey enables you to use an external source module. When you enable the source 

module it also enables the external leveling mode. 

Preset  Off

Choices  Off or On

Location  Page  232

Remarks  None 

Source Module Off On

Supported   All

This softkey enables and disables the external source module. When you enable the 

source module it also enables the external leveling mode for the automatic leveling 

control. 

Preset  Off

Choices  Off or On

Location  Page  239

Remarks  None 

Square

Supported   PSG-A Series

This softkey enables you specify square as the modulation waveform for the internally 

generated, ac-coupled signal. 

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  The selected waveform applies only to whichever path configuration 

you have currently selected.
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State

Supported   All

This softkey enables you to specify that only signal generator instrument state files be 

listed in the catalog of files currently displayed.

Preset  N/A

Range  N/A

Location  Page  249

Remarks  None

Step Dwell

Supported   All

This softkey enables you to set the dwell time for each point of a step sweep. The dwell 

time is the amount of time the sweep is guaranteed to pause after setting the frequency 

and power for the current sweep/list point. 

NOTE The dwell time does not begin until the signal generator has settled for the 

current frequency and/or amplitude change. When the signal generator 

has settled, a trigger signal is transmitted through the rear panel 

SOURCE SETTLED OUTPUT connector.

Preset  2.0 msec

Range  1.0 msec−60.0 sec (in 1.0 msec increments)

Location  Page  245

Remarks  Dwell time is used when the point trigger is set to Immediate.
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Step/Knob Ratio

Supported   All

This softkey enables you to set the ratio between the increment value of the step keys 

and the front panel knob. For example, if you set the increment value for frequency to 

1.0 MHz and set the step/knob ratio to 10/1, when frequency is the active function the up 

and down arrow keys will change the frequency in 1.0 MHz steps and the front panel 

knob will change the frequency in 1/10th of 1.0 MHz steps. 

When you press Step/Knob Ratio the number displayed in the active entry area 

represents the arrow keys step size in the ratio. To enter a new value, rotate the front 

panel knob until the desired value is displayed, use the up and down arrow keys, or 

enter the value using the numeric keypad and press the Enter terminator key.

Preset  N/A

Range  1−10,000

Location  Page  248

Remarks  This ratio applies only when you have a function active that has an 

associated increment value. The step/knob ratio is not affected by a 

preset or by a power cycle.

Store to File

Supported   All

This softkey accesses a menu that enables you to create a file name and store the current 

data to a file in the internal non-volatile memory. 

Preset  N/A

Range  N/A

Location  Page  234, Page  246

Remarks  The file name can consist of up to 23 alpha-numeric and special 

characters.
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Store Ref Osc Setting

Supported   All

This softkey enables you to store the current coarse and fine reference oscillator 

adjustment settings. Refer to the calibration guide for more information.

Preset  N/A

Range  N/A

Location  Page  248

Remarks  This adjustment is intended for use by service personnel.

Sweep

Supported   All

Use this softkey to access a menu of choices that enables you to configure the sweep 

parameters. In this menu you can choose to sweep frequency only, amplitude only, or 

both frequency and amplitude. You can also choose to turn off all sweep functions.

Sweep Direction Down Up

Supported   All

This softkey enables you to change the direction of the sweep. Choose Up to sweep from 

the first point in the list sweep to the last point, or from the step sweep start frequency 

and amplitude to the stop frequency and amplitude. Choose Down to reverse the 

direction of the sweep.

Preset  Up

Choices  Down or Up

Location  Page  245

Remarks  None

Preset  Off

Choices Off Freq Ampl Freq & Ampl

Location Page  245

Remarks None
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Sweep Repeat Single Cont

Supported   All

This softkey toggles the sweep repetition between single sweep and continuous sweep 

types. The sweep and point triggers will then trigger the sweep. See “Point Trigger” on 

page 191 and “Sweep Trigger” on page 217.

Preset  Cont

Choices  Single or Cont

Location  Page  245

Remarks  None

Sweep Trigger

Supported   All

Use this softkey to access a menu of choices that enables you to select a triggering mode 

for a sweep. You can choose triggering that, once a sweep is armed, occurs immediately, 

is supplied by the GPIB, occurs on either the positive or negative edge of a signal 

supplied to the TRIGGER IN connector, or is initiated by the Trigger hardkey.

Preset  Free Run

Choices Free Run Trigger key Bus Ext

Location Page  245

Remarks You can also configure the polarity of the TTL signal output at the 

TRIGGER IN connector using the Trigger In Polarity Neg Pos softkey 

on this menu. Refer to “Trigger In Polarity Neg Pos” on page 222.
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Sweep Type List Step

Supported   All

This softkey toggles the sweep type between list sweep and step sweep. You create a list 

sweep by supplying the frequency, amplitude, and dwell time for each point in the sweep. 

You create a step sweep by supplying the start and stop frequency and amplitude, the 

number of points, and a dwell time. The signal generator then calculates the points 

between the first and last point in a linear manner.

Preset  List

Choices  List or step

Location  Page  245

Remarks  None

Sweep/List

Supported   All

Use this hardkey to access a menu of softkeys that enables you to define a series of 

points containing frequency, amplitude, and dwell time information for the signal 

generator to sweep. 

Preset  N/A

Range  N/A

Location  Page  245

Remarks  None
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Swept-Sine

Supported   PSG-A Series

This softkey enables you to specify a swept sinewave as the modulation waveform for the 

internally generated, ac-coupled signal, and displays a menu of choices for setting the 

parameters. In this menu you can set the start and stop rate and the sweep time. You 

can set the signal generator to a single, externally triggered sweep on either a negative 

or positive TTL level or you can choose continuous sweep, triggered immediately. In this 

menu you can also select either a positive or negative polarity for the TRIGGER OUT 

signal.

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  Internal 2 is not available for use with the swept-sine function.
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Trans/Recv Pace None Xon

Supported   All

This softkey enables you to determine whether any pacing is acknowledged by the 

RS-232 transmit channel. If Xon pacing is used, the system will suspend transmitting 

data upon receiving an Xoff character until an Xon character is received. The signal 

generator may not be responsive to other channels, or to the front panel, while 

transmission is suspended. Xon pacing is not recommended if binary data will be sent to 

the signal generator via RS-232 as errors may occur. Toggle Trans/Recv Pace None Xon to 

None to turn off Xon pacing.

Preset  N/A

Choices  None or Xon

Location  Page  247

Remarks  The pace state is not affected by a preset or by a power cycle.

Triangle

Supported   PSG-A Series

This softkey enables you to specify a triangle wave as the modulation waveform for the 

internally generated, ac-coupled signal. 

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  The selected waveform applies only to the path configuration you have 

currently selected.
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Trigger

Supported   All

Use this hardkey to initiate an immediate trigger event, if the trigger mode is set to 

Trigger Key. 

Preset  N/A

Range  N/A

Remarks  The trigger key has autorepeat capability. Hold it down and you will 

repeatedly trigger sweeps until you release the key.

Trigger Key

Supported   All

This softkey enables you to trigger an event by pressing the Trigger hardkey. The Trigger 
Key is located in the Sweep Trigger menu and in the Point Trigger menu. Choosing 

Trigger Key in the Sweep Trigger menu immediately triggers an armed sweep when you 

press the Trigger front panel key. Choosing Trigger Key in the Point Trigger menu 

immediately triggers the next point in the current sweep.

Preset  N/A

Range  N/A

Location  Page  231, Page  236, Page  238, Page  241, Page  245

Remarks  None
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Trigger In Polarity Neg Pos

Supported   All

This softkey toggles the polarity of the TTL signal at the TRIGGER IN connector that 

triggers an event. When Trigger In Polarity Neg Pos is set to Pos, the output signal is 

asserted high (+5.0 V) at the rising edge of the swept-sine modulation sweep and low 

(0.0 V) when the sweep is concluded. Setting Trigger In Polarity Neg Pos to Neg reverses 

the polarity, where the output signal is high at the falling edge (0.0 V) and low at +5.0 V.

Preset  Pos

Choices  Neg or Pos

Location  Page  231, Page  236, Page  238, Page  241, Page  245

Remarks  This key is coupled to the Trigger In Polarity Neg Pos key for swept-sine 

FM, ΦM, and LF Out, and the Sweep/List menu. When the polarity is 

toggled for this key in any one of these menus, it affects all locations of 

the key.

Trigger Out Polarity Neg Pos

Supported   All

This softkey toggles the polarity of the TTL signal output at the rear panel TRIGGER 

OUT connector. When Trigger Out Polarity Neg Pos is set to Pos, the output signal is 

asserted high (+5.0 V) at the rising edge of the swept-sine modulation sweep and low 

(0.0 V) when the sweep is concluded. Setting Trigger Out Polarity Neg Pos to Neg reverses 

the polarity, where the output signal is high at the falling edge (0.0 V) and low at +5.0 V.

Preset  Pos

Choices  Neg or Pos

Location  Page  231, Page  236, Page  238, Page  240, Page  245

Remarks  This key is coupled to the Trigger Out Polarity Neg Pos key for swept-sine 

FM, ΦM, and LF Out, and the Sweep/List menu. When the polarity is 

toggled for this key in any one of these menus, it affects all locations of 

the key.

This key is active only when you have selected the internal source to 

operate as a function generator.
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U

Uniform

Supported   PSG-A Series

This softkey enables you specify noise with a uniform distribution as the modulation 

waveform. 

Preset  N/A

Range  N/A

Location  Page  230, Page  235, Page  237, Page  240

Remarks  None

Utility

Supported   All

Use this softkey to access a menu of choices that enables you to view and erase error 

messages, access the GPIB/RS-232 LAN menu, adjust the display, access a menu of 

adjustments for the signal generator, set the help mode and power on state, and access 

the memory catalog menu. 

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None
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Update in Remote Off On

Supported   All

This softkey toggles the operating state of the display updating when the remote control 

bus is in remote mode. When toggled on, commands executed via the remote control bus 

will update the signal generator display accordingly. When toggled off, commands 

executed via the remote control bus will not update the display.

Preset  Off

Choices  Off or On

Location  Page  247

Remarks  This key is not affected by a preset. However, it resets to off when the 

power is cycled.

User Flatness

Supported   All

This softkey enables you to specify that only user flatness correction files be listed in the 

catalog of files currently displayed.

Preset  N/A

Range  N/A

Location  Page  232, Page  249

Remarks  None
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V

 View Details

Supported   All

This softkey enables you to view detailed information about the highlighted test. Refer to 

the troubleshooting section in the service guide for more information.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This is intended for use by service personnel.

View Next Error Message

Supported   All

Use this softkey to display the next error message in the queue. (The first error message 

is the oldest error.) There may be more than one error message in the queue; the number 

of error messages is displayed along with the first message. Press any key to exit the 

Error Info menu.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  None
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View Previous Error Message

Supported   All

Use this softkey to display the newest error message first. Continue pressing this key to 

view additional error messages in order of newest to oldest. Press any key to exit the 

Error Info menu.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  N/A 

View Test Info

Supported   All

Use this softkey to display more details of the self tests. Refer to the calibration guide for 

more information.

Preset  N/A

Range  N/A

Location  Page  250

Remarks  This is intended for use by service personnel.
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W

White Pixels Screen Test

Supported   All

This softkey enables you to set all of the pixels on the display to white. Press the Local 
hardkey to return the display to normal operation.

Preset  N/A

Range  N/A

Location  Page  247

Remarks  This key is provided for factory use in testing the display. 
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AM

Chapter 6230

AM
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AM

Chapter 6 231

Figure 6-1

www.valuetronics.com



Menu Maps

Amplitude

Chapter 6232

Amplitude
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Amplitude

Chapter 6 233

Figure 6-2
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Amplitude

Chapter 6234

Figure 6-3
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*FM/ΦM

Chapter 6 235

*FM/ΦM
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*FM/ΦM

Chapter 6236

Figure 6-4
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FM/ΦM*

Chapter 6 237

FM/ΦM*
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FM/ΦM*

Chapter 6238

Figure 6-5
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Frequency

Chapter 6 239

Frequency
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Chapter 6240

LF Output
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LF Output

Chapter 6 241

Figure 6-6
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Chapter 6242

Pulse Modulation
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Recall

Chapter 6 243

Recall
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Save

Chapter 6244

Save
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Sweep/List

Chapter 6 245

Sweep/List
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Sweep/List

Chapter 6246

Figure 6-7
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Utility
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Utility
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Utility

Chapter 6248

Figure 6-8
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Utility

Chapter 6 249

Figure 6-9
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Utility

Chapter 6250

Figure 6-10
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Utility

Chapter 6 251

Figure 6-11
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Symbols

ΦM
annunciator, 12

configuration example, 38

coupling, external source, 139

DCΦM calibration, 127

description, 33

deviation, 38, 92

dual-sine
amplitude, second tone, 98

rate, first tone, 97

rate, second tone, 98

hardkey, 7, 143

menu map, 237

multipath
deviation coupling, 93

selection, 94

operating state, 93

rate, 39, 94

source, 33, 95

swept-sine
start rate, 95

stop rate, 96

sweeps/second, 96

trigger, 97

type, normal/wideband, 144

waveform, 99

See also waveforms, function generator

Numerics

10 MHz
IN connector, 16

OUT connector, 16

10BASE-T. See LAN

A

AC power receptacle, 15
active entry area, 12

clearing, 123

address
GPIB, 51

hostname, 51

Internet Protocol. See IP address
World Wide Web. See hostname

Agilent
contacting, 89

returning product to, 88

ALC
annunciator, 12

attenuation and ALC level, balancing, 58

bandwidth selection, 74

BW selections, 100, 101, 107, 119

control, 118

level, 58, 211

limitations, amplitude, 55

operating state, 108

AM
annunciator, 12

configuration example, 33

coupling, external source, 139

depth, 35, 109

description, 33

dual-sine
amplitude, second tone, 113

rate, first tone, 113

rate, second tone, 114

hardkey, 108

menu map, 230

mode, normal/deep, 109

multipath, 36

depth coupling, 109

selection, 36, 110

operating state, 36, 110

rate, 35, 111

source, 33, 111

swept-sine
start rate, 112

stop rate, 112

sweeps/second, 112

trigger, 113

type, linear/exponential, 114

waveform, 36, 114

See also waveforms, function generator
amplifier, microwave

external leveling setup, 29

mm-wave source module setup, 29

user flatness calibration setup, 66
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amplitude
display area, 14

hardkey, 6, 118

LF output, 42, 43

menu map, 232

modulation. See AM
reference, 116

RF output, 22, 118

increment, 162

leveling mode, 172

offset, 23, 115

reference, 23, 116

sweep, 115

annunciators
ΦM, 12

ALC OFF, 12

AM, 12

ARMED, 12

ATTEN HOLD, 12

behavior during
AM, 111

FM, 148

ΦM, 95

ERR, 12

EXT, 12

EXT REF, 13

EXT1 LO, 95, 111, 148

EXT1 LO/HI, 12

EXT2 LO, 95, 111, 148

EXT2 LO/HI, 13

FM, 13

L (listener mode), 13

MOD ON/OFF, 13

OVEN COLD, 13

PULSE, 13

R (remote), 13

RF ON/OFF, 13

S (service request), 13

SWEEP, 13

T (talker mode), 13

UNLEVEL, 13

UNLOCK, 13

ARMED annunciator, 12
arrow keys, 10
ATTEN HOLD annunciator, 12
attenuator

configuration, 58, 118, 212

hold present setting, 119

attenuator hold mode, 29

ATTN HOLD annunciator, 29
automatic leveling control. See ALC
AUXILIARY INTERFACE connector, 16

B

backspace key, 187
baud rate, 52, 102, 103, 104, 105, 203
buffer (RS-232) reset, 52

C

connectivity. See remote control
connectors

input
10 MHz IN, 16

AC power receptacle, 15

EXT 1 INPUT, 7
EXT 2 INPUT, 8
PULSE/TRIGGER GATE INPUT, 10

TRIGGER IN, 17

interface
AUXILIARY INTERFACE, 16

GPIB, 15

LAN, 16

RS-232, 16

SOURCE MODULE, 16

output
10 MHz OUT, 16

LF OUTPUT, 8
PULSE SYNC OUT, 9
PULSE VIDEO OUT, 9
RF OUTPUT, 9
SOURCE SETTLED OUTPUT, 17

SWEEP OUT, 16

TRIGGER OUT, 17

contrast hardkeys
decrease, 10

increase, 10

correction array (user flatness)
configuration, 61

load from step array, 62

viewing, 63

See also user flatness correction
correction, flatness. See user flatness 

correction
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coupling
ΦM deviation, multipath, 93

AM depth, multipath, 109

external source, 139

factor, external detector, 55, 140

FM deviation, multipath, 146

D

data storage
description, 44

file types, 44

trouble. See problems
See also memory catalog and instrument 

state register
dead/no power, signal generator. See 

problems
detector, external

coupling factor configuration, 56

diode response, typical, 56

diagnostic information, 132
diagrams

display, 11

front panel, 5
rear panel, 15

digit keys, 187
display, 133

active entry area, 12

amplitude area, 14

annunciators, 12

brightness, 120

contrast
decrease hardkey, 10

increase hardkey, 10

diagram, 11

error message area, 14

frequency area, 12

inverse video, 170

modulation status, 185

pixel test, 120, 227

screen saver
delay, 208

mode, light/light&text, 208

operating state, 209

text area, 14

update in remote mode, 224

dwell
time, step sweep, 26, 214

type, list/step, 135

E

echo (RS-232), 52, 203
ERR annunciator, 12
error messages, 138

clear, 122

display area, 14

view next, 225

view previous, 226

examples
ΦM, configuring, 38

AM, configuring, 35

files, instrument state
deleting registers and sequences, 47

recalling, 47

saving, 46

files, memory catalog
copying, 45

deleting, 46

renaming, 45

storing, 45

viewing, 44

FM, configuring, 37

leveling, external
detectors and couplers/splitters, with, 54

mm-wave source module, with, 29, 58

LF output, configuring, 41

pulse modulation, configuring, 40

RF output
CW, configuring, 20

mm-wave source module, configuring 
with, 29

swept, configuring, 24

table editors, modifying items in, 50

user flatness correction
correction array, creating automatically, 

59

correction array, creating manually, 63

description, 59

mm-wave source module, with, 66

recalling data from memory, 64

saving data to memory, 64

EXT 1 INPUT connector, 7
EXT 2 INPUT connector, 8
EXT annunciator, 12
EXT REF annunciator, 13
EXT1 annunciators

HI, 12, 95, 111, 148

LO, 12, 95, 111, 148
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EXT2 annunciators
HI, 13, 95, 111, 148

LO, 13, 95, 111, 148

F

fail-safe recovery sequence, description, 85
failures. See problems
features

PSG-A, 3
PSG-L, 2

files
instrument state. See instrument state 

register
memory catalog. See memory catalog

firmware, upgrading, 87
flatness correction. See user flatness 

correction
FM

annunciator, 13

configuration example, 37

coupling, external source, 139

DCFM calibration, 127

description, 33

deviation, 37, 145

dual-sine
amplitude, second tone, 150

rate, first tone, 150

rate, second tone, 150

hardkey, 7, 143

menu map, 235

multipath
deviation coupling, 146

selection, 147

operating state, 146

rate, 37, 147

source, 33, 148

swept-sine
start rate, 148

stop rate, 149

sweeps/second, 149

trigger, 149

waveform, 151

See also waveforms, function generator

frequency
display area, 12

hardkey, 6, 155

LF output, 42

start and stop, swept-sine, 43

menu map, 239

modulation. See FM
multiplier, 152

RF output, 20, 155

increment, 21, 23, 162

offset, 22, 153

phase adjustment, 107

phase reference, 190

reference, 21, 153, 154

sweep, 151, 152

sweep, with amplitude sweep, 155

sweeping, 26

front panel
diagram, 5
display, 11

knob, 6
function generator

selection, 155, 156

waveforms. See waveforms, function 
generator

G

general purpose interface bus. See GPIB
GPIB

address, 51, 158

connector, 15

listener mode, 65, 159

setup, 51

H

hardkeys, 10
ΦM, 7, 143, 237

AM, 108, 230

Amplitude, 6, 118, 232

arrow, 10

contrast
decrease, 10

increase, 10

FM, 7, 143, 235

Frequency, 6, 155, 239

Help, 7, 160

Hold, 10, 161

Incr Set, 9, 162

LF Out, 172, 240
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hardkeys (continued)
Local, 10, 180

MENUS group, 7
Mod On/Off, 8, 184

numeric, 8
Preset, 10, 193

Pulse, 242

Recall, 7, 198, 243

Return, 10, 202

RF On/Off, 8, 202

Save, 6, 206, 244

Sweep/List, 218, 245

Trigger, 7, 221

Utility, 223, 247

Help hardkey, 7, 160
help system mode, 160, 163
Hold hardkey, 10, 161
hostname, 51

See also IP address

I

IEEE 488.2. See GPIB
Incr Set hardkey, 9, 162
input connectors

10 MHz IN, 16

EXT 1 INPUT, 7
EXT 2 INPUT, 8
PULSE/TRIGGER GATE INPUT, 10

TRIGGER IN, 17

instrument state register
comment

add, 47, 106

edit, 47, 137

keep, 171

description, 46

instrument states
delete register, 48, 129

delete sequence, 48, 130, 132

recall, 47, 198, 199

re-save, 201

save, 46, 206, 207

select register, 210

select sequence, 211

trouble. See problems
See also memory catalog

interface connectors
AUXILIARY INTERFACE, 16

GPIB, 15

LAN, 16

RS-232, 16

SOURCE MODULE, 16

interface, remote
GPIB

address, 51, 158

listener mode, 65, 159

setup, 51, 159

LAN
hostname, 51, 161

IP address, 51, 170

setup, 51, 172

local area network. See LAN
local operation, 180

parallel. See GPIB
RS-232

baud rate, 52, 203

buffer reset, 52, 201

echo, 52, 203

pacing, transmit/receive, 220

setup, 52

timeout, 52, 204

transmit/receive pace, 52, 220

serial. See RS-232
internal source

limitations, 33

multipath configuration, 36

ΦM, 94

AM, 36, 110

FM, 147

waveforms, available, 33

Internet Protocol address, signal generator. 
See IP address

IP address, 51
See also hostname

K

key descriptions, signal generator, 91–227
keypad, numeric, 8
knob, 6
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L

L (listener mode) annunciator, 13
label area, softkey, 14
LAN

connector, 16

hostname, 51, 161

IP address, 51, 170

setup, 51, 172

LEDs
line power (green), 9
standby (yellow), 9

leveling, external
description, 54

detector, 140

coupling factor, 140

detectors and couplers/splitters, using, 54

attenuation and ALC level, balancing, 58

connection diagram, 55

diode detector response, typical, 56

equipment required, 54

external detector coupling factor 
configuration, 56

leveling mode configuration, 55

Option 1E1 signal generators, with, 58

signal generator configuration, 55

mm-wave source modules, using, 29, 58

connection diagrams, 30, 31

equipment, required, 29

signal generator configuration, 31

mode, 172

source module, 213

leveling, internal, 167
mode, 172

See also ALC and power search
LF Out

hardkey, 172

LF output
amplitude, 42, 43, 173

configuration example, 42, 43

description, 41

dual-sine
amplitude, second tone, 177

frequency, first tone, 177

frequency, second tone, 178

frequency, 42, 173

menu map, 240

operating state, 173

LF output (continued)
source, 174

function generator, 43, 155, 156

internal modulation monitor, 42, 168, 169

swept-sine
start frequency, 43, 175

stop frequency, 43, 175

sweep rate, 43

sweeps/second, 176

trigger, 176

waveform, 41, 43, 178

See also waveforms, function generator
LF OUTPUT connector, 8
LFO. See LF output
line power LED, 9
listener mode annunciator, 13
local area network. See LAN
Local hardkey, 10, 180
locked up, signal generator. See problems
low frequency output. See LF output

M

memory catalog
catalog type, 122

description, 44

file
copy, 45, 126

delete, 46, 125, 128, 129, 130, 131

delete binary, 128

load from selected file, 179

load or store, 180

rename, 45, 201

store, 45, 215

types, 44

view, 44, 120, 179, 214, 224

trouble. See problems
type, 44

See also instrument state register
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menu
hardkey group, 7
maps

ΦM, 237

AM, 230

Amplitude, 232

FM, 235

Frequency, 239

LF output, 240

Pulse, 242

Recall, 243

Save, 244

Sweep/List, 245

Utility, 247

microwave amplifier
external leveling setup, 29

mm-wave source module setup, 29

user flatness calibration setup, 66

millimeter head. See mm-wave source 
module

millimeter-wave source module. See 
mm-wave source module

mm-wave source module
connection diagrams, 30, 31

external leveling with, 58

models, 29, 66

required equipment, 29

signal generator configuration with, 31

user flatness correction with, 66

MOD ON/OFF annunciator, 13
Mod On/Off hardkey, 8, 184
modulation

amplitude. See AM
annunciators, 13

configuring, 33

external waveform, 141, 142

frequency. See FM
internal, 168, 169

operating state, 184

phase. See ΦM
pulse, 40

status display, 185

multipath configuration
ΦM, 94

AM, 36, 110

FM, 147

multiplier, frequency, 152

N

numeric keypad, 8, 187

O

offset
amplitude, 23, 115

frequency, 21, 153

on/off switch, 9
operation, fundamental, 19–52
Option 1E1, 29
options

descriptions, hardware/software, 4
informational display, 189

output
amplitude, RF, 118

connectors
10 MHz OUT, 16

LF OUTPUT, 8
PULSE SYNC OUT, 9
PULSE VIDEO OUT, 9
RF OUTPUT, 9
SOURCE SETTLED OUTPUT, 17

SWEEP OUT, 16

TRIGGER OUT, 17

frequency, RF, 155

low frequency. See LF output
OVEN COLD annunciator, 13
overview, signal generator, 1–17

P

pacing, transmit/receive (RS-232), 220
performance, optimizing signal generator, 

53–74
phase modulation. See ΦM
point trigger, 121, 139, 151, 221
power

meter
address, GPIB, 183

channel selection, 183

models, 59

selection, 191

timeout, 183

receptacle, AC, 15

search, 193

execute search, 134

mode, manual/auto, 193

sensor, models, 60, 66

switch, 9
Preset hardkey, 10, 193
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problems
data storage

empty registers, 84

register contains wrong state, 84

fail-safe recovery sequence, 85

help mode, cannot turn off, 76

RF output
low, 77

low, while working with mixer, 78

low, while working with spectrum 
analyzer, 80

modulation, no, 76

none, 76

service contacts, 88

signal generator
locked up, 85

returning to factory for repair, 88

will not power up, 84

sweep
cannot turn off, 82

dwell time incorrect, 83

stalled, 82

sweep list missing, 83

PSG-A features, 3
PSG-L features, 2
PULSE annunciator, 13
pulse modulation

delay, 195

description, 34

menu map, 242

operating state, 195

period, 40, 196

rate, 196

source, external, 34, 141, 197

polarity, 141

source, internal, 34, 197

doublet, 165

free-run, 165

gated, 166

squarewave, 169

triggered, 167

width, 40, 197

R

R (remote) annunciator, 13
rear panel

description, 15

diagram, 15

Recall
hardkey, 7, 198

menu map, 243

recovery sequence. See fail-safe recovery 
sequence

reference
amplitude, 23, 116

frequency, 21, 153

oscillator adjustment, internal, 199, 200

oscillator adjustment, return to factory 
defaults, 202

oscillator adjustment, store, 216

oscillator bw adjustment, 101, 102, 104

oscillator, external, bw adjustment, 142

oscillator, internal, bw adjustment, 169

registers. See instrument state register
remote control

GPIB
address, 51, 158

listener mode, 65, 159

setup, 51, 159

LAN
hostname, 51, 161

IP address, 51, 170

setup, 51, 172

local operation, 180

RS-232
baud rate, 52, 203

buffer reset, 52, 201

echo, 52, 203

pacing, transmit/receive, 220

setup, 52

timeout, 52, 204

transmit/receive pace, 52, 220

remote operation annunciator, 13
repair return instructions, 88
Return hardkey, 10, 202
RF ON/OFF annunciator, 13
RF On/Off hardkey, 8, 202
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RF output
amplitude, 22

increment, 162

offset, 23, 115

reference, 23, 116

attenuator hold mode, 29

ATTN HOLD annunciator, 29

connector, 9
frequency, 20

increment, 21, 23, 162

multiplier, 152

offset, 22, 153

reference, 21, 153, 154

leveling, external
description, 54

detectors and couplers/splitters, using, 54

mm-wave source modules, using, 58

mm-wave source module, using, 29

multiplier, frequency, 152

operating state, 20, 202

phase
adjustment, 107

reference, 190

step attenuator, 29

swept, list
data, load from step sweep, 27, 126, 180

description, 25

points, 27, 92

single sweep, 28, 212

sweep trigger, 28, 217

sweep type, 26, 218

swept, step
amplitude, 25, 117

description, 24

frequency, 25, 154

step dwell, 26, 214

trouble. See problems
user flatness correction

creating and applying, 59

description, 59

mm-wave source module, using, 66

RF OUTPUT connector, 9

RS-232
baud rate, 52, 203

buffer reset, 52, 201

connector, 16

echo, 52, 203

pacing, transmit/receive, 220

setup, 52, 203

timeout, 52, 204

transmit/receive pace, 52, 220

S

S (service request) annunciator, 13
Save

hardkey, 6, 206

menu map, 244

self tests, 211
abort, 106

details, viewing, 225, 226

loop selected, 181

run
complete, 204

highlighted, 204

selected, 205

select/deselect
all, 209

test, 209

sequences. See instrument state register
service request annunciator, 13
signal generator

adjustments, 164

reference oscillator, 199, 200, 202

reference oscillator BW, 101, 102, 104

reference oscillator BW, external, 142

reference oscillator BW, internal, 169

step/knob ratio, 215

features, 2
firmware, upgrading, 87

information, 164

diagnostic, 132

help system mode, 160, 163

modulation status, 185

options, 189

self tests, 181, 204, 205, 211

self tests, aborting, 106

key descriptions, 91–227

menu maps, 229–251

operation, fundamental, 19–52

options, 4
overview, 1–17
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signal generator (continued)
performance, optimizing, 53–74

power-on configuration, 192

preset configuration, 194, 207

problems, solving, 75–89

repair return instructions, 88

signs, changing, 187
softkeys

individual. See Table of Contents
label area, 14

location
on front panel, 6
within menus. See Menu Maps

SOURCE MODULE connector, 16
SOURCE SETTLED OUTPUT connector, 17
standby LED, 9
step array (user flatness)

number of points configuration, 62

start and stop frequency configuration, 62

See also user flatness correction
step attenuator, 29
storage, data or file. See data storage

See also memory catalog and instrument 
state register

sweep
amplitude

start, 25, 117

stop, 25, 117

annunciator, 13

ATTN HOLD annunciator, 29

configuration examples
list, 26

step, 25

data
load list from step sweep, 27, 126, 180

save list, 45

description
list, 25, 124

step, 24, 125

direction, 216

dwell
time, step, 26, 214

type, list/step, 135

frequency
start, 25, 154

stop, 25, 154

manual mode
operating state, 182

point selection, 182

mode, amplitude/frequency, 216

sweep (continued)
operating state, 188

points, 26, 27, 92

preset, list sweep table values, 126, 194

repetition, 25, 217

single, 26, 28

single sweep, 212

trigger, 28

arming, 28

bus, 121

external, 139

free run, 151

point-by-point, 191

polarity, input, 222

polarity, output, 222

source, 28, 217

trigger key, 221

trouble. See problems
type, list/step, 26, 218

using step attenuator, 29

with Option 1E1, 29

SWEEP annunciator, 13
SWEEP OUT connector, 16
Sweep/List

hardkey, 218

menu map, 245

switch, power, 9

T

T (talker mode) annunciator, 13
table editor

description, 49

functional overview, 50

navigation, 157, 158, 190

table items, deleting, 131

table items, modifying, 50, 162

text
editing mode, insert/replace, 138

erase, 123

text editing, 138

talker mode annunciator, 13
text area, 14
timeout (RS-232), 52, 204
transmit/receive pace (RS-232), 52, 220
TRIGGER

IN connector, 17

OUT connector, 17
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trigger
arming, 28

bus, 121

connectors, 17

external, 139

free run, 151

hardkey, 7
point-by-point, 191

single sweep, 212

source, 217

trigger key, 221

Trigger hardkey, 221
troubleshooting. See problems

U

UNLEVEL annunciator, 13
UNLOCK annunciator, 13
user flatness correction

abort cal routine, 106

applying to the RF output, 64

array
cal, 123

step, 124

connection diagram, 61

correction arrays
automatic creation, 62

description, 59

manual creation, 63

correction data
recall from memory catalog, 64

save to memory catalog, 64

data
cal array, load from step array, 179

description, 59

equipment required, 60

execute cal routine, 134

GPIB listener mode, 65, 159

mm-wave source module, using
applying correction data, 73

calibration process, performing the, 71

connection diagrams, 68, 69

description, 66

equipment required, 66

power meter configuration, 67

recall correction data, 73

save correction data, 72

signal generator configuration, 70

operating state, 143

user flatness correction (continued)
power meter

address, GPIB, 183

channel selection, 183

configuration, 60

models, 59, 136, 137

selection, 191

timeout, 183

preset, list table values, 126, 194

return to flatness menu, 134

signal generator configuration, 61

Utility
hardkey, 223

menu map, 247

W

waveforms, external, 141, 142
waveforms, function generator

DC, 127

dual-sine, 135

amplitude, second tone, 98, 113, 150, 177

rate, first tone, 97, 113, 150, 177

rate, second tone, 98, 114, 150, 178

noise, 186

gaussian, 157

uniform, 223

ramp, 198

negative, 186

positive, 191

sine, 212

square, 213

swept-sine, 219

start rate/frequency, 95, 112, 148, 175

stop rate/frequency, 96, 112, 149, 175

sweeps/second, 96, 97, 112, 113, 149, 176

triangle, 220

World Wide Web address, signal generator. 
See hostname
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